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1 Welcome to PSoC Creator 

PSoC Creator helps you configure and program analog- and digital-peripheral functionality into a Cypress PSoC 
device. Using PSoC Creator, you can select and place Components, write C and/or Assembly source, and debug 
and program the project/part. When used with associated hardware, this dynamic hardware-software combination 
allows you to test the project in a hardware environment while viewing and debugging device activity in a software 
environment. 

Note This document refers to PSoC 4 devices throughout (in addition to other devices). References to PSoC 4 
should be interpreted to include PSoC 4, PSoC Analog Coprocessor, PRoCÈ BLE (Bluetooth Low Energy), and 
CCGx. 

This PSoC Creator help contains the following sections: 

Getting Started Tutorials to get you started using PSoC Creator. 

Understanding PSoC Creator Information and tasks to better understand PSoC Creator. 

Using Design Entry Tools Tasks and interface descriptions for the graphical design entry tools. 

Building a PSoC Creator Project Topics for configuring and building PSoC Creator projects. 

Integrating into 3rd Party IDEs 

Information and tasks for generating PSoC Creator design files for use with a 3rd 
Party IDE 

Programming and Debugging a 
PSoC Creator Project 

Topics for programming the device and using the debugger. 

Completing the Project Topics for finalizing a PSoC Creator design. 

Reference Material 3rd party tool chain docs and other reference material. 

 

Revision History 
Document Title:   PSoC® CreatorÊ User Guide 

Document Number: 001-93417 
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*C 5/14/15 Updates for PSoC Creator 3.2 and PSoC 4100M and PSoC 4200M. 
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2 Getting Started 

This section contains tutorials to help get you started using PSoC Creator.  There are two sets of tutorials: 

Â Design Tutorials - Walkthroughs to get you creating designs quickly. 

Â How To - Miscellaneous tutorials to help increase your efficiency using PSoC Creator. 

  

Design Tutorials 

This section contains the following design tutorials to help you get started creating designs with PSoC Creator. 
Code examples for these tutorials are contained in the Find Code Example dialog, available from the Start page. 
These tutorials are intended to provide quick introductions to begin using PSoC Creator. For more information, refer 
to the following 

Â PSoC 3: AN54181: www.cypress.com/go/PSoC3GettingStarted 

Â PSoC 4: AN79953: www.cypress.com/go/PSoC4GettingStarted 

Â PSoC 4 BLE: AN91267: www.cypress.com/go/AN91267 

Â PSoC 5LP: AN77759: www.cypress.com/go/PSoC5GettingStarted 

Â PRoC BLE: AN94020: www.cypress.com/go/AN94020 

Â PSoC Creator Training: www.cypress.com/go/creatorstart/creatortraining 

You may also obtain various kits to use with PSoC Creator and associated devices. When installed, these kits 
provide additional documentation and tutorials, available on the PSoC Creator Start Page. 

Beginner: 

Â My First Design "Hello World Blinky" 

Â Starter Projects 

Intermediate: 

Â Basic Design 

Â Debugging a Design 

http://www.cypress.com/go/PSoC3GettingStarted
http://www.cypress.com/go/PSoC4GettingStarted
http://www.cypress.com/go/AN91267
http://www.cypress.com/go/PSoC5GettingStarted
http://www.cypress.com/go/AN94020
http://www.cypress.com/go/creatorstart/creatortraining
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Advanced: 

Â Library Component Project 

Â Basic Hierarchical Design 

See Also: 

Â Find Code Example 

Â How To 

Beginner 

My First Design "Hello World Blinky" 

This tutorial provides an introduction to PSoC Creator and the process of developing a design. The design process 
includes: 

Â Create a New Project 

Â Add/Configure Components 

Â Write C Code 

Â Program the Device 

This is the first of a few design tutorials included in this PSoC Creator Help file. This design will show you how to 
blink an LED. Then you will add another Component to display "Hello World" on an LCD. 

Note If you prefer not to create a new empty project, you can open a completed code example for this tutorial, 
named "HelloWorld_Blinky," using the Find Code Example dialog. A link to the dialog is located on the PSoC 
Creator Start page. There are also several Starter Designs you can create from the New Project dialog. 

Create a New Project: 

The first step of creating a design is to create the basic design project. 

1. From the File menu, select New > Project or click  to open the New Project wizard. 

2. For Target device, select the default PSoC 3 device, or select the specific device you want to use. For this 
project, we are using the default PSoC 3 device CY8C3866AXI-040. If you select a different device, then you 
will need to adjust your pin settings accordingly. 

3. On the "Select project template" page, select Empty schematic. 

4. In Name, type the name of your project, for example: "MyHelloWorld." 

Note The project name cannot exceed 80 characters. 

5. In Location, type the path where you want the project to be saved, or click [...] and navigate to the appropriate 
directory. 

6. Click Finish. 
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By default, PSoC Creator creates a new workspace containing the new project. Files and folders are added to the 
Workspace Explorer shown in the Source tab. 

 
 

The Schematic Editor displays the top-level schematic file (TopDesign.cysch) as a document window, and the 
Component Catalog opens to display a list of Components to use in your design. 

Note If you created this project in the same workspace as another project, make this the active project by selecting 
Set as Active Project from the Project menu. 
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Add/Configure Components: 

After the new project has been created, add Components to the schematic canvas and configure them as 
appropriate. 

1. In the Component Catalog, expand the "Digital > Functions" folder and drag a PWM Component onto your 
design. 

 
 

The Notice List window indicates that there are connection errors. 
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2. Double-click the PWM Component to open the Configure dialog, change the Implementation setting to "Fixed 
Function," and click OK. 

 
 

Notice the Component instance's appearance changes: kill input added, one pwm output available, and the 
label is updated. 

 
 

3. In the Component Catalog, expand the "Digital > Logic" folder, drag a Logic Low Component onto your design, 
and connect it to the kill terminal on the PWM. Connect another Logic Low to the reset terminal. 

4. In the Component Catalog, expand the "System" folder, drag a Clock Component onto your design, and 
connect it to the clock terminal on the PWM. 
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The Notice List window clears. 

 
 

5. Double-click the Clock to open the Configure dialog, change the Desired Frequency value to 0.25 kHz, and 
click OK. 

 
 

6. In the Component Catalog, expand the "Ports and Pins" folder, drag a Digital Output Pin Component onto your 
design, and connect it to the pwm terminal on the PWM. 
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Your design should now look like the following image. 

 

Assign Pin: 

PSoC Creator will automatically assign the pin to a physical port/pin on the device. To specify a specific pin, use the 
Pin Editor. 

1. In the Workspace Explorer, double-click the HelloWorld.cydwr file to open the Design-Wide Resources Pin 
Editor. 

 

2. Pull down the menu in the Port or Pin column and assign Pin_1 to the following pin, depending on the kit you 
have: 

Ǐ For the PSoC 3 FirstTouch Starter Kit (CY8CKIT-003), use P4[1] (or pin 70). 

Ǐ For the PSoC Development Kit (CY8CKIT-001), use P0[0] (or pin 71). 

Write C Code: 

1. In the Workspace Explorer, double-click the main.c file to open it. 

2. Add the following function to main(): 

PWM_1_Start();  
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Program the Device: 

1. Connect the MiniProg3 to your kit and plug it into your PC with a USB cable. 

2. If you are using the PSoC Development Kit (CY8CKIT-001), use a wire to connect the P0[0] pin to one of the 
four LEDs. Refer to the appropriate documentation for the kit for more information. 

3. Click Program . 

4. If the Select Debug Target dialog displays, select your device, then click Connect and OK. 

PSoC Creator will build your design, generate code, and program the device. When programming is complete, the 
selected LED on the board will blink; press the Reset button if needed. 

Expand the Design: 

If you are using the PSoC Development Kit (CY8CKIT-001), you can expand the design to display "Hello World" on 
the LCD. 

1. On the Component Catalog, expand the "Display" folder and drag a Character LCD onto your schematic. 

2. Open the Pin Editor, and assign LCD_Char_1:LCDPort to P2[6:0]. 

3. Open the main.c file, and edit it to add the following to main(): 

LCD_Char_1_Start();  

LCD_Char_1_PrintString("Hello World");  

  

4. Click Program . 

PSoC Creator will build your design, generate code, and program the device. When programming is complete, the 
LCD will display the words "Hello World." 

From this point, you can modify the design to do different things as desired. 

See Also: 

Â Code Examples 

Â Find Code Example 

Â Workspace Explorer 

Â Schematic Editor 

Â Component Catalog 

Â Pin Editor 

Code Examples 

PSoC Creator provides several Code Example projects. These projects highlight features that are unique to PSoC 
devices. They allow you to create a design with various Components and code already provided, instead of 
creating a new empty design. 
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To Use Code Example Projects: 

1. From the File menu, select New > Project or click  to open the New Project wizard. 

2. Select the appropriate Design project option and click Next >. 

 
 

3. On the "Select project template" page, select the Code example option and click Next >. 
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4. On the "Select a code example" page, select a project from the list. This page is very similar to the Find Code 
Example dialog. If needed, use the Filter by field to narrow the number of examples listed.  

 
 

Note If an example shows an icon next to the name, it means you need to install or update the example from 
the web. Click on the icon to do that. 

Click Next >. 

5. On the "Create Project" page, select the appropriate options. 

 
 

6. Click Finish. 
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The selected project is created and files are displayed in the Workspace Explorer. The project is ready to build and 
program the device. For more information, refer to the documentation included with the design. If the 
documentation is not available, select the Include Starter Design documentation... option in the Options Dialog, 
and re-create the project. 

See Also: 

Â Creating a New Project 

Â Workspace Explorer 

Â My First Design "Hello World Blinky" 

Â Options Dialog 

My Templates 

My Template projects are similar to code examples and pre-populated schematic projects in that these projects 
contain various levels of information already, including device configuration, Components, Design-Wide Resources, 
etc. The main difference with My Template projects is that they are created and copied to a specific directory by you 
for later use when creating a new project. 

To Specify the My Templates Location: 

The default location for storing My Templates projects is <user>\Documents\PSoC Creator\My Templates. 

To change this, open the Options dialog. Under Project Management, use the Browse... button to navigate to the 
desired location. 

To Copy a Project to My Templates: 

In the Workspace Explorer, under the Source tab, right-click on a design project and select Copy to My Templates 
(<project_name>). You can also use the Project menu to select the same option. 

Note When copying a project to the My Templates location, any relative project dependencies will need to be 
updated when a new project is created from it. Any referenced files outside of the project's cydsn directory will not 
be included in the new My Template project. 

To Create a Project from My Templates: 

Note When creating a project from My Templates, if the created project is of a different device family than the My 
Templates project, then the Design-Wide Resource files will no longer an applicable and a new <project>.cydwr file 
will be generated. 
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After copying one or more projects to the My Templates location, follow the usual instructions to create a new 
project, except, as follows: 

1. On the Select project template step, select the My Template project option and click Next >. 

 
 

2. Then on the Select a My Template project step, select the desired project from the list, and click Next >. 

 
 

3. On the final step, specify the name and location of the project/workspace as usual. 
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Intermediate 

Basic Design 

This tutorial provides more details about configuring Components and working with Design-Wide Resources 
(DWR). It is intended to be a design focusing on a set of basic Components to show various ways of configuring 
them. This tutorial does not cover every step in the design process in great detail. Instead, it describes concepts 
relevant to parts of the design. You can then use the same principles in any design. For introductory instructions for 
creating a design, refer to the "Hello World Blinky" tutorial. 

Note If you prefer not to create a new project, you can open the completed code example for this tutorial, named 
"BasicDesign," using the Find Code Example dialog. A link to the dialog is located on the PSoC Creator Start page. 

Create a New Project: 

As shown in the "Hello World" tutorial, the first step for a design is to create a new project. As needed, follow the 
instructions in that tutorial. You can also refer to Creating a New Project. 

Select and Configure Digital Components: 

For this tutorial, the main digital Component will be the Timer. Then, you will add support Components to your 
design, configure them, and connect them to the Timer. 

1. Expand the Digital > Functions folder in the Component Catalog, click on the Timer Component, and drag it 
onto your design canvas. 

 
 

Notice that the Timer is already connected to a Clock Component and a Logic Low Component. This is 
because the Timer is an example of a Schematic Macro. 

2. Remove the Clock and the Logic Low Components because this example will use different Components. 

3. Double-click the Timer Component to open the Configure dialog. 
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By default, the Timer is configured as 8-bit, Fixed Function, and Software Only enable. For more information 
about the Timer Component, refer to its datasheet. 

Change the following parameters: 

Ǐ Implementation to UDB 

Ǐ Enable Mode to "Software and Hardware" 

Ǐ select the Interrupt on TC check box 

 
 

4. Click OK. 

Notice that the "enable" terminal displays on the Timer. 

 

5. From the Component Catalog, add the following Components to your design: 

Ǐ Control Register (from the Digital > Registers folder) -- Used to enable the Timer under software 
control, as well as provide a reset signal for the Timer. 

Ǐ Digital Output Pin (from the Ports and Pins folder) -- Used to provide a divided clock for another 
Component in the design. The divided clock is 3.1 KHz. 

Ǐ Clock (from the System folder) -- Used to provide the input clock. In this case at 800 KHz. 

Ǐ Interrupt (from the System folder) -- Used to act as a heartbeat for the design. The heartbeat can be 
used for timing of software functions. 
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6. Configure the following Component instances as follows: 

Instance Parameter(s) 

Control_Reg_1 NumOutputs: 2 

Clock_1 Desired Frequency: 800 Khz 

7. Arrange the Components on your design, and use the Wire tool  (from the Design Elements Palette, to 
connect them, similar to the following. See Working with Wires for more information. 

 

When complete, all DRC warnings and errors should be cleared. 

Select and Configure Analog Components: 

The next part of the design will contain a Delta Sigma ADC as the main analog Component, along with support 
Components. 

1. From the Component Catalog, drag a Delta Sigma ADC Component (from the Analog > ADC folder) onto your 
design. 
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2. Double-click the Component to open the Configure dialog. 

 
 

By default, the Delta Sigma ADC is configured as 16-bit, with an input range of +/- 1.024 V. For more 
information about the Delta Sigma ADC Component, refer to its datasheet. 

3. Change parameters as follows: 

Ǐ Under the Common tab, set Input Mode to "Single ended." 

Ǐ Under the Config1 tab, change the Resolution parameter to "12" and Input Range parameter to 
"Vssa to Vdda". 

Ǐ Click OK. 

Notice that the label below the Component reads 12 Bit Resolution. 

 
 

4. From the Component Catalog, add the following Components to your design: 

Ǐ Analog Pin (from the Ports and Pins folder) -- Used to connect the input signal to the ADC. 

Ǐ Interrupt (from the System folder) -- Used to trigger reading the result of a conversion from the ADC. 
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5. Arrange the Components on your design, and use the Wire tool  (from the Design Elements Palette, to 
connect them, similar to the following: 

 

Notes 

Ǐ First, notice that the wire from the Analog Pin to the ADC is red by default, and the wire from the ADC 
to the Interrupt is green by default. PSoC Creator uses these colors to indicate analog and digital 
signals. These colors can be changed using the Options dialog. 

Ǐ Second, note that a wire is not needed to connect the Components. You can connect them directly by 
their terminals . This tutorial uses wires to show the different signal colors. 

When complete, all DRC warnings and errors should be cleared. 

Edit Source Code: 

1. Build the project to generate source files for the Components. 

When complete, the Workspace Explorer expands the Generated_Source folder to show all the c files and 
header files for the various Components in your design. 

2. Open the header files to view (and copy) the function prototypes you will enter in the main.c file. 

3. Copy and paste the following code and replace any code in your main.c file. 

Note The comments in the following code are for your information. 

  

/*******************************************************************************  

* File: main.c  

*  

* Version: 2.0  

*  

* Description:  

*   This is a basic design source code.  

*  

********************************************************************************/  

#define ADC_NUMBER_SAMPLES (15)  

     

/* Initialize array elements to zero. */  

uint16 ADC_Samples[15] = {0,0,0,0,0,0, 0,0,0,0,0,0,0,0,0};  

     

/* Defining and initializing the index */  

int8 ADC_Sample_Index = 0;  

     

/* Initiialize the average result */  

uint32 ADC_Sample_Average = 0;  

     

/* Sample read from ADC */  

int16 ADC_Current_Sample = 0;   

     

/* Indicator for whe n sample is available */  

int8 ADC_Sample_Available = 0;  
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/*******************************************************************************  

* Function Name: InterruptHandler  

********************************************************************************  

* Su mmary:  

*   The Interrupt Service Routine for isr_1.  

*  

* Parameters:   

*   None.  

*  

* Return:  

*   void.  

*  

*******************************************************************************/  

CY_ISR(InterruptHandler)  

{  

    Timer_1_ReadStatusRegister(); /* Read the Status Register */  

}  

       

/*******************************************************************************  

* Function Name: main  

********************************************************************************  

* Summary:  

* Main function performs foll owing functions:  

* 1: Start the clock  

* 2: Start the Timer  

* 3: Start the interrupts  

* 4: Start ADC DelSig and its interrupts  

* 5: Testing for sample available from ADC  

* 6: Storing the sample into the array  

* 7: Comparing the samples  

*  

* Parameters:  

*  None.  

*  

* Return:  

*  None.  

*  

*******************************************************************************/       

  

void main()  

{  

    int8 i;  

         

    CyGlobalIntEnable;  

    /* Start the Interrupt */  

    isr_1_Start();              

    isr_1_Disable();  

    isr_1_SetVector(InterruptHandler);  

    isr_1_Enable();  

     

    /* Enable the Timer; reset disabled */  

    Control_Reg_1_Write(0x01);  

         

    /* Start the LCD */  

    LCD_Start();  

    /* Start the Timer */  

    Timer_1_Start();  

         

    /* Star t the ADC */  

    ADC_DelSig_1_Start();    

         

    /* Start the ADC conversion */  

    ADC_DelSig_1_StartConvert();  
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    LCD_Position(0, 0);  

    LCD_PrintString("ADC OUTPUT:");  

    for(;;)  

    {  

        /* Check whether ADC conversion complete or not */  

        if (ADC_DelSig_1_IsEndConversion(ADC_DelSig_1_WAIT_FOR_RESULT))  

        {  

            /* Get the result */  

            ADC_Current_Sample = ADC_DelSig_1_GetResult16();  

            ADC_Sample_Available = 1;  

            /* Print the ADC result  on LCD */  

            LCD_Position(0, 11);  

            LCD_PrintInt16(ADC_Current_Sample);  

        }  

        /* Testing for sample available from the ADC */  

        if (ADC_Sample_Available)  

        {  

            ADC_Sample_Available = 0;  

                 

            /* storing the sample into the array, based on the index */  

            ADC_Samples[ADC_Sample_Index++] = ADC_Current_Sample;  

                 

            /* comparison */  

            if (ADC_Sample_Index == ADC_NUMBER_SAMPLES)  

            {  

                ADC_Sample_Average = 0;  

                for (i = 0; i < ADC_NUMBER_SAMPLES; i++) ADC_Sample_Average += 

ADC_Samples[i];  

                ADC_Sample_Average /= ADC_NUMBER_SAMPLES;  

                ADC_Sample_Index = 0;  

            }  

        }  

    }  

}  

/* [] END OF FILE */  

  

Build the Project: 

Click Build . PSoC Creator will build the project and display messages accordingly. Address any errors or 
warnings as needed. 

If you have a PSoC development kit with an LCD, you can click Program  to program the device and observe 
the output on the LCD. 

Next Steps: 

This tutorial contains the basic process of configuring Components in a design. To continue this design you will 
need to obtain hardware to program the device, as well as to use the debugger features. In the mean time, you can 
refer to the following related topics: 

Â Debugging a Design 
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Debugging a Design 

This tutorial will use the design created with the Basic Design tutorial and go through several debugging concepts, 
such as setting a breakpoint, adding a watch, and stepping. This design will show the values of an array at different 
points while executing the code. It will also show the total and average of the specified variable. 

Open Example Design: 

If you created a design with the Basic Design tutorial, you can use that one. Refer to Opening an Existing Project 
for instructions to open the design, as needed. 

You can also open the completed code example for this tutorial, named "BasicDesign," using the Find Code 
Example dialog. A link to the dialog is located on the PSoC Creator Start page. 

Set Breakpoints and Step: 

In this section, you will set a couple breakpoints and run the debugger to verify that the code is being executed as 
desired. You will also use the Step function to show where in the stack you are currently viewing. For more 
information about breakpoints, see Breakpoints Window. For more information about stepping, see Debugger 
Toolbar Commands. 

1. In the Workspace Explorer, double-click the main.c file to open it. 

2. Scroll to the for loop section and click in the margin of line 105 to insert a breakpoint at the line of code. 

A breakpoint indicator appears in the margin next to the desired line of code. 

 
 

3. Click Debug  to start the debugger. 

Depending on the Debugger Option settings, the Debugger will run to Main. 



Getting Started 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 29 

4. Open the Call Stack window from the Debug > Windows menu. Notice the current line indicator is in main(). 

 
 

5. Click Continue . 

The Debugger will run to the breakpoint you set. Notice the current line indicator over the breakpoint icon, as 
well as in the Call Stack window. 

 
 

6. Click Step Into . 
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The debugger opens the ADC_DelSig_1_INT.c file and stops at line 73. Again notice the current line indicator in 
the Call Stack window. 

 
 

7. Stop the debugger by clicking . 

Now that you have confirmed the debugger stopped at the desired breakpoint, you can disable the breakpoint by 
right-clicking on the icon in the margin and selecting Disable. 

Set Hit Count and Variable Watchpoint: 

In this section, you will set a hit count breakpoint as well as a variable watchpoint to monitor the values of an array. 

1. Open the main.c file and scroll to line 50. 

2. Click in the margin to set a breakpoint and then right-click on the breakpoint icon and select Hit Count... 

 
 

The Breakpoint Hit Count window opens. 

3. Enter the hit counter number of "5" and click OK. 

4. Click Debug  to start the debugger. 
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Depending on the Debugger Option settings, the Debugger will run to Main. 

5. Right-click on the ADC_Samples array in line 51 and select Add Watch. 

The Watch 1 window opens showing the ADC_Samples array. Expand the list to see all the array values. 

 
 

6. Click Continue . 

The debugger stops on line 50 and the Watch Window shows the ADC_Samples array with two values 
assigned. 

 
 

Note Breakpoints are hit twice when interrupts are enabled. This happens because the breakpoint gets hit, but 
before the line of code is actually executed an interrupt takes over and gets processed. When the interrupt has 
completed, the processor returns to the original line of code. This causes the breakpoint to be hit again. 

7. Disable the breakpoint in line 50. 

8. Add another watch to the ADC_Sample_Average in line 54 of the main.c file. 

9. Right-click in line 56, and select Run to Cursor. 

10. In the Watch Window, notice that all the values in the ADC_Samples array now have a value and that the 
ADC_Sample_Average is the total of those values. 

 

11. Right-click in line 57, and select Run to Cursor. 
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12. In the Watch Window, notice that the ADC_Sample_Average is now the average. 

 
 

For more information about the PSoC Creator Debugger, refer to various topics under the Using the Debugger 
section of this Help. 

Advanced 

Library Component Project 

By default, PSoC Creator provides a library of Components that are available for you to use in your designs. There 
may be cases where you wish to create your own libraries. This tutorial covers the basic process for creating a 
library by showing you how to create a 4-bit shifter. This is only an example intended to show you how to create 
basic Components. For more detailed instructions about creating Components, refer to the Component Author 
Guide. 

Note If you prefer not to create a new project, you can open the completed code example for this tutorial, named 
"LibraryComponent," using the Find Code Example dialog. A link to the dialog is located on the PSoC Creator Start 
page. Once open, select the Components tab in the Workspace Explorer to view the Component files. 

Create a New Project: 

The first step is to create the basic library project: 

1. If there is currently an open project or workspace, select Close Workspace  from the File menu. 

2. From the File menu, select New > Project or click  to open the New Project wizard. Select the Library 
option and click Next >. 

3. In Name, type the name of your project, for example: "My1stLib." 

4. In Location, type the path where you want the project to be saved, or click [...] and navigate to the appropriate 
directory. 

5. Click Finish. 
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PSoC Creator creates your project and adds files and folders to the Workspace Explorer with the Source tab 
displayed by default. For more information, see Workspace Explorer. 

 
 

Add a Shifter Component: 

The basic library item is a Component. In order to add a Component, you must first add a Symbol, since every 
Component must have one and only one symbol: 

1. Click on the Components tab of the Workspace Explorer. 
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2. Right-click on the project in the Workspace Explorer and select Add Component Item... 

 
 

The Add Component Item dialog displays. 

 
 

3. Under Symbol, click the Symbol Wizard template file.  

4. In Component name, type the name to be displayed for your Component, for example: "shifter." 

Note The symbol will inherit the Component name, and the name cannot contain spaces. 

5. Click Create New. 
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The Symbol Creation Wizard displays. 

 
 

6. Using the Terminal name and Type fields in the table, create two input terminals named Data_In and Clock, 
respectively, and four digital output terminals named D0 through D3. 

 
 

See Symbol Wizard for more information. 

7. Click OK. 
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Your project shows the Component and symbol added to your project. The new Component displays in the 
Workspace Explorer tree, with a symbol file (.cysym) shown as the only Component item. 

 
 

The Symbol Editor also opens the .cysym file and displays the created symbol. 

 
 

Notice that the symbol has a text box above it with shifter_N. This is an instance text label that allows you to 
name a Component when it is instantiated in a design. For more information, see Working with Text. You can 
change the default instance name using the symbol document property Doc.DefaultInstanceName in the 
Properties dialog. 

Specify Placement in Component Catalog: 

When complete, Components will display in the Component Catalog. If you wish, you can control how they are 
displayed. 

1. Right-click on the symbol canvas and select Properties to open the Properties dialog. 
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2. Click in the Doc.CatalogPlacement field to show the ellipsis [...] button. 

 
 

3. Click the ellipsis [...] button to open the Catalog Placement dialog. 

 
 

4. Click in the right column of the first row next to , and enter: 

Example/LogicCircuits/  

 

5. Click OK to close the Catalog Placement dialog. 

6. Click OK to close the Properties dialog. 

7. Click Save  to save your symbol file. 

See Defining Catalog Placement for more information about this dialog. 
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Add a Shifter Implementation: 

In order for your symbol to display in the Component Catalog, you must have an implementation. For this tutorial, 
we will add a schematic. 

1. Right-click on the Component in the Workspace Explorer and select Add Component Item... 

 
 

The Add Component Item dialog displays. 

 
 

2. Under Implementation, click the Schematic icon. 

3. Under Target, leave the selection on Generic Device. 

Note The schematic will inherit the Component name, and it cannot be changed. 

4. Click Create New. 

Note The Select Sheet Template dialog may display for you to choose a canvas template. If so, click on the 
desired template, and click OK. 
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Your project shows the schematic added to your project. The Component displays in the Workspace Explorer 
tree, with a schematic file (.cysch) shown in addition to the symbol file. 

 
 

The Schematic Editor opens the .cysch file and displays an empty canvas, along with the Component Catalog. 
For more information see Schematic Editor. 
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Complete the Shifter Schematic: 

Now that you have an empty canvas, you need to draw the schematic to implement your symbol. 

1. In the Component Catalog, expand the Digital > Logic tree. 

 
 

Ǐ Click and drag a D Flip Flop onto your canvas. 

Ǐ Add a total of four D Flip Flop Components. 

2. From the Design Elements Palette, select the Digital Input terminal , and click the canvas to place the 
terminal. 

The Terminal Name dialog opens. See also Working with Schematic Terminals. 
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3. In Specify Name, type "Data_In" and then click OK. 

4. Repeat the process to add one additional Digital Input and four Digital Output terminals; name the additional 
terminals Clock, D0, D1, D2, and D3, respectively. 

5. Click the Draw Wire tool . 

6. Connect the terminals to the logic gates similar to the following image: 

 
 

See also Working with Wires. 

7. Click Save to save your schematic file. 

When you have completed the process, the Component will be listed the Component Catalog under the tab 
named Example. 

 
 

Using the Library: 

Once you have created a library with one or more Components, you can use those Components as library 
elements in your design projects. Go to the Basic Hierarchical Design tutorial to see how to use your Library in a 
design. 
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Basic Hierarchical Design 

PSoC Creator allows you to create Components and reuse them. That is the basic definition of a hierarchical 
design; Components and designs become building blocks for additional Components and designs. 

This tutorial will show you how to create an 8-bit shifter using the LogicCircuit Library you created in a previous 
tutorial. This is only an example intended to show you how to use Components you created in a hierarchical 
design. For more detailed instructions about creating Components, refer to the Component Author Guide. 

Note If you prefer not to create a new project, you can open the completed code example for this tutorial, named 
"Shifter" using the Find Code Example dialog. A link to the dialog is located on the PSoC Creator Start page. 

Create a New Project: 

The first step is to create the basic design project: 

1. If there is currently an open workspace, select Close Workspace  from the File menu. 

2. From the File menu, select New > Project or click  to open the New Project wizard. 

3. For Target device, select the default PSoC 3 device, or select the specific device you want to use. For this 
project, we are using the default PSoC 3 device CY8C3866AXI-040. If you select a different device, then you 
will need to adjust your pin settings accordingly. 

4. In Name, type the name of your project, for example: "Shifter." 

5. In Location, type the path where you want the project to be saved, or click [...] and navigate to the appropriate 
directory. 

6. Click Finish. 

PSoC Creator creates your project and adds files and folders to the Workspace Explorer shown in the Source tab. 
The Schematic Editor displays the top-level schematic file as a document window, and the Component Catalog 
opens to display a list of Components to use in your design.  
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Add the Logic Circuit Library: 

By default, all new designs come with a pre-defined library of Components for you to use. These Components are 
shown in the Component Catalog. 

To add the Logic Circuit library, you need to add the library project to your library search path. 

1. From the Project menu, select Dependencies... to open the Dependencies dialog. 
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2. Under User Dependencies, click New Entry  to open a file browser dialog, navigate to find the 
My1stLib.cyprj file containing the library, and click Open. 

 
 

3. Notice that the library project is listed under User Dependencies > Project and click OK to close the 
Dependencies dialog. 
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The Component Catalog now has a new tab named Example containing the shifter Component. 

 
 

Complete the Design: 

Now that you have added the library Components, you can use them to create the carry-ripple adder design. 

1. In the Component Catalog, click the Example tab, expand the "LocicCircuits" folder, then click and drag the 
shifter Component onto your schematic canvas; add a second shifter Component. 

Notice that as you place Components, the Notice List window displays a list of connection errors.  This is part of 
the dynamic rule checking (DRC) system. It's a cue that your design has errors, which you will resolve as you 
complete the design. For more information about this window, see Notice List Window. 
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Notice also that the Components are named "shifter_1" and "shifter_2." 

 
 

2. In the Component Catalog, click the Cypress tab, expand the "Ports and Pins" folder and drag a Digital Input 
Pin onto your schematic canvas; also add eight Digital Output Pins. 

3. Double-click the Digital Input Pin to open the Configure dialog, and change the Name to Data_In. 

 
 

4. Click OK to close the dialog. 

5. Rename the Digital Output Pins to D0 through D7. 

6. In the Component Catalog, expand the "System" folder and drag a Clock onto your schematic canvas. 
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7. Arrange the Components and terminals on your canvas as appropriate. 

8. Click the Draw Wire tool . 

9. Connect the pins and the clock to the shifters. 

See Working with Wires, Drawing Buses, and Wire Labels and Names, as needed for instructions about 
different techniques, 

When you're finished making all the connections, your schematic should look similar to the following image: 

 
 

Notice that all the errors have cleared in the Notice List window. 

Tip You can copy and paste similar wires to different locations; therefore, if you equally space items in your 
design, you can replicate them more easily. 

10. From the Build menu, select Build Shifter. 

The Output window shows messages indicating a successful build.  



Getting Started 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 48 

The Workspace Explorer shows a Generated Files folder with generated design files. 

 
 

Close the Design: 

From a basic perspective, this 8-bit shifter is an example of a hierarchical design. The design was built with two 4-
bit shifters, which were built on D Flip Flops. You could use this shifter to create a Component for use in another 
design, and that design could be used in another, and so on. You will use the same basic principles and tools for 
every design you create with PSoC Creator. 

To close this design (and its project and workspace), select Close Workspace   from the File menu. 
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How To 

This section contains various "how to" topics to help you learn how to get the most from PSoC Creator.  This 
section is broken down into various categories, as follows: 

General PSoC Creator Tasks: 

Â Creating a New Project 

Â Finding Code Examples 

Â Opening an Existing Project 

Â Adding a New Workspace/Project Item 

Â Adding an Existing Project Item 

Â Assigning a Core to File in a Multi-Core Design 

Â Archiving a Workspace/Project (Bundling) 

Â Copying a Project 

Â Generating a Project Datasheet 

Â Creating a New File 

Â Opening an Existing File 

Â Creating Folders 

Â Copying a Project 
 

General Design Entry Tasks: 

Â Design Entry Options 

Â Working with Text 

Â Using Text Substitution 

Â Working with Lines 

Â Working with Shapes 

Â Zooming 

Â Scrolling 

Â Selecting a Device 

Â Using the Notice List Window 

Schematic Editor Tasks: 

Â Creating a New Schematic 

Â Using the Component Catalog 

Â Configuring Components 

Â Working with Wires 

Â Drawing Buses 

Â Working with Schematic Terminals 

Â Adding a Schematic Page 

Â Updating Components 

Â Importing a Component 
 

Text Editor Tasks: 

Â Writing Code 

Â Using the Text Editor 

Â Using Find Replace 

Â Using Wildcards 

Â Using Regular Expressions 

Â Using Go To 
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Framework: 

Â To Float Tool Windows 

Â To Dock Tool Windows 

Â To Use Tabbed Documents 

Â To Move Tool Windows 

Â To Auto-Hide Tool Windows 

Debugger Tasks: 

Â Using the Debugger 

Â Using Program/Debug Options 

Â Using the Breakpoints Window 

Â Using Debugger Menu Commands 

Â Selecting a Default Compiler 

Symbol Editor Tasks: 

Â Creating a Symbol 

Â Using the Symbol Wizard 

Â Adding a Component Item 

Â Working with Component Terminals 

Â Creating Symbol Parameters 

Â Defining Catalog Placement 

Â Exporting a Component 
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3 Understanding PSoC Creator 

PSoC Creator provides a PSoC hardware/software co-design environment, with software development tools, a 
graphical design editor, a device selector, and various features for project management. There are many concepts 
referenced within this PSoC Creator help with which you may not be familiar. This section helps you have a deeper 
understanding of PSoC Creator. It contains the following sub-sections: 

Â Concepts 

Â General Tasks 

Â Framework 

Concepts 

To help you better understand PSoC Creator, you should become familiar with the following terms and concepts: 

Â Workspace/Project 

Â Project Types 

Â Component/Instance 

Workspace/Project 

The PSoC Creator integrated development environment (IDE) provides two containers to help you manage items in 
your designs: workspaces and projects. 

Â Workspace ï A workspace is the top-level container within PSoC Creator; it contains one or more projects that 
you can open, close, and save together. You can only have one workspace for any given PSoC Creator 
workspace file (.cywrk). 

Â Project ï A project contains multiple items that represent your design, such as schematics, design-wide 
resources, source code, and hex files. The types of items contained within a project vary according to the 
project type. A project is always part of a workspace. You can create projects in an existing workspace or you 
can create a new workspace as part of creating a new project. 

PSoC Creator provides workspace folders to organize related projects into groups and then perform actions on 
those groups of projects. You can view and manage your workspace, projects, and their associated items using the 
Workspace Explorer. A workspace and projects allow you to use the IDE in the following ways: 

Â Manage settings for your workspace as a whole or for individual projects. 

Â Use Workspace Explorer to handle the details of file management while you focus on items that make up your 
design. 
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Â Add items that are useful to multiple projects in the workspace or to the workspace without referencing the item 
in each project. 

Â Work on miscellaneous files that are independent from the workspace or projects. 

When you create a multi-project workspace, the first design project created becomes the active project, by default. 
The active project appears in bold font in Workspace Explorer and is the project that runs when you click Start on 
the Debug menu. You can build either a single project within the workspace or multiple projects in the workspace. 
You can also specify which workspace projects you wish to exclude from builds. For more information, see Building 
a PSoC Creator Project. 

See Also: 

Â Project Types 

Â Workspace Explorer 

Â Building a PSoC Creator Project 

Project Types 

A PSoC Creator project contains multiple items, such as schematics, Components, design-wide resources, source 
code, and hex files. PSoC Creator provides two types of projects: design and library. 

Â Design Project ï A design project is used to create and modify designs. With a design project, select and 
configure the Components for your device in a schematic. Next, set up design-wide resources, such as clocks 
and interrupts. Then, write the C code for your application. Finally, you build (and debug) the project to 
generate the hex file and program the device. When you first create a design project, PSoC Creator creates the 
project/workspace files and directory structure, as well as the top-level schematic, main.c shell file, and a 
design-wide resources file (.cydwr). 

Â Library Project ï A library project is a collection of one or more Components and the associated source code. 
With a library project, you can develop Components that will be elaborated in a design, as well as reused in 
many designs. Library Projects can also be used to create static libraries that can be linked in to a design. Each 
library can serve either purpose (or both at the same time). Component development includes creating the 
graphic symbol, defining parameters, and specifying validation requirements. When you first create a library 
project, PSoC Creator creates the project/workspace files and directory structure. Library project(s) are 
included in PSoC Creator as Dependencies to determine which Components are available for your designs in 
the Component Catalog.  

Project names have a .cyprj extension, such as ProjectName.cyprj. In addition, project files must always be located 
in a directory named either ProjectName.cydsn (design) or ProjectName.cylib (library). 

See Also: 

Â Component 

Â Component Catalog 

Â Dependencies 
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Component/Instance 

A Component is a collection of files, such as a symbol, schematics, APIs, and documentation that defines 
functionality within the PSoC Device. Examples of Components include a timer, counter, and a mux. An instance is 
a Component that has been selected from the Component Catalog and used in a design. You can have multiple 
copies ï or instances ï of a Component in a design, as long as the selected device can support it. You can also 
create and reuse your own Components/instances. 

Files that make up a Component/instance include the following: 

Â Symbol ï A symbol contains the basic definition of a Component. It contains the top-level picture shown in the 
Component Catalog, as well as the parameter definitions. There can be only one symbol in a Component. 

Â Schematic ï A schematic defines how a Component has been implemented visually. A schematic can be 
generic for any PSoC device, or it can be architecture, family and/or device specific. 

Â API ï Application Programming Interface. APIs define how to interact with a Component using C code. They 
can be generic for any PSoC device, or they can be architecture, family and/or device specific. 

Â Verilog ï Verilog can be used to define the functionality of a Component implemented in Verilog. There will only 
be one Verilog file in any given level of a Component. Verilog files found at different levels of the Component, 
such as at an architecture, family and device level, may not refer to each other. 

Â Control File ï The control file contains directives to the code generation module. For more information, see 
Control File and Directives. 

Â Documentation ï The documentation of the Component is generally its datasheet. 

Â CyPrimitive ï A CyPrimitive is a basic Component item, such as a logic gate, interrupt, or DMA. 

Note A symbol need not be primitive -- it could be a primitive for some device, but implemented out of logic and 
software for another device. 

See Also: 

Â Component Catalog 

Â Control File 

Â Directives 

General Tasks 

The following are some of the general tasks you will perform with PSoC Creator: 

Â Creating a New Project 

Â Opening an Existing Project 

Â Adding a New Workspace/Project Item 

Â Adding an Existing Project Item 

Â Assigning a Core to File in a Multi-Core Design 

Â Writing Code 

Â Archiving a Workspace/Project 
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Â Saving a Project As 

Â Generating a Project Datasheet 

Â Generating Description Files 

Â Copying a Project 

Â Selecting a Default Compiler 

Â Creating a New File 

Â Opening an Existing File 

Â Creating Folders 

 

Creating a New Project 

The Create New Project wizard is used to create new PSoC Creator projects. 

 
 

Use this wizard to: 

Â select the kit, module, or device  

Â select the type of project to create; see Project Types 

Â specify the project name and location 

Â choose whether to create a new workspace or add to an existing workspace; see Workspace/Project 

To Open this Wizard: 

From the File menu, select New > Projecté   or click Create New Project on the PSoC Creator Start page. 
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To Create a New Project: 

Select project type 

 
 

Choose one of the following: 

Â Target kit: Use this option to select a specific kit, or the last used kit. 

 
 

Â Target module: Use this option to select a specific module, or the last used module. 
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Â Target device: Use this option to select a device family and series, the last used device, or to launch the 
Device Selector. 

 
 

Â Library project: Selection this option to create a library project. 

Â Workspace: Select this option to create an empty workspace. 

Click Next >. 

Select project template (Design Projects Only) 

 
 

Choose one of the following: 

Â Code example: Choose this option to select a starter project from a list of available examples. See Code 
Examples. 

Â Pre-populated schematic: If available, select this option to create a design with Components already placed 
on the design schematic. 

Â My Template project: If you have previously copied a project to My Templates, select this option to create a 
new project based on a selected My Template project. See My Templates. 
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Â Empty schematic: Choose this option to create a blank schematic canvas (not available for PRoC BLE 
designs). 

Click Next >. 

Select Library Project Processors (Library Projects Only) 

 
 

Choose one or more processors for which this library will be built. You can also select more and different 
processors on the Build Settings dialog for library projects. 

Note If you select DP8051 (for PSoC 3) you cannot select any Cortex processor, and vice-versa. You will need to 
create separate library projects. 

Click Next >. 
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PSoC 6 Only Select Target IDEs 

 
 

For PSoC 6 devices only, the Select Target IDEs step allows you to select one or more IDEs for which to generate 
files. If you select to generate files for CMSIS Pack (for Eclipse or ARM MDK) a note will display indicating where 
the files will be located, as well as information to change the name and version of the pack. See Build Settings > 
Target IDEs and Generating PSoC 6 Files for 3rd Party IDEs for more information.  

Click Next >. 

Create Project (All Projects) 
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Â Workspace ï Select the appropriate option: 

Ǐ Create new workspace: Use this option to create a new workspace, and specify a location to save the 
workspace. 

Ǐ Add to current workspace: If creating a new project in a workspace that is already open, select this 
option to add the new project to the existing workspace. 

Â Workspace name ï For a new workspace, type a name for the workspace. 

Â Location ï Specify a location for the project/workspace. 

Â Project name ï Type a name for the project.  

Note The project name cannot exceed 80 characters. 

Note If creating a blank workspace, this page will not have a Project name option. 

Click Finish. 

Â If you create a design project, PSoC Creator will create files and open the Schematic Editor by default.  

Â If you create a library project or empty workspace, PSoC Creator will create the library or empty workspace 
infrastructure in the Workspace Explorer. 

See Also: 

Â Project Types 

Â Workspace/Project 

Â Device Selector 

Â Schematic Editor 

Â Workspace Explorer 

Â Opening an Existing Project 
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Opening an Existing Project 

The Open Project dialog is used to open an existing PSoC Creator workspace/project. 

 
 

Use this dialog to browse and select the workspace file (.cywrk) or project file (.cyprj) to open. You can open an 
existing project that you created or one of the many examples provided with PSoC Creator. 

To Open this Dialog: 

From the File menu, select Open > Project/Workspaceé  or click Open Existing Project on the PSoC 
Creator Start page. 

To Open a Project: 

1. Navigate to the appropriate directory where the project to open is located. 

2. Select the desired project and click Open. 

The project opens in PSoC Creator, and it is shown in the Workspace Explorer. 

Note You can also open recent projects without this dialog using Recent Projects on the Start page or on the File 
menu. 

See Also: 

Â Workspace/Project 

Â Workspace Explorer 

Â Creating a New Project 
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Adding a New Workspace/Project Item 

The New Item dialog allows you to add new items to your workspace/project. 

 
 

The dialog provides templates of the different types of items you can add. Source files will be compiled as part of a 
build; non-source files will be ignored. 

Note You cannot use this dialog to create new items for Components. Instead you must use the Add Component 
Item dialog. 

To Open the Dialog: 

1. In the Workspace Explorer, under the Source tab, select the level at which you want to add the item: 
workspace, project, or folder. 

2. From the Project menu, select New Item... . 

You can also right-click on a workspace, project, or folder and select Add > New Item from the context menu. 

To Add an Item: 

1. In the Templates area, select the icon for the type of item to add to your workspace/project. Currently the 
available templates include: 

Ǐ 8051 Keil Assembly File ï Used to create an assembly file that will be compiled when you select the 
Keil tool-chain. 

Ǐ C File ï Used to create a standard C source file. 

Ǐ C# File ï Used to create a standard C sharp source file. 

Ǐ Design Wide Resource File ï Used to create a file for editing design level resources, such as 
interrupts, clocks, etc. 

Ǐ GNU ARM Assembly File ï Used to create an assembly file that will be compiled when you select the 
GNU ARM tool-chain. 
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Ǐ Header File ï Used to create a standard C Header file. 

Ǐ HTML File ï Used to create an HTML file for documentation purposes. 

Ǐ Keil Reentrancy File ï Used to mark APIs as reentrant. See Reentrant Code in PSoC 3. 

Ǐ RealView ARM Assemly File ï Used to create an assembly file that will be compiled when you select 
the RealView ARM tool-chain. 

Ǐ Resx File ï Used to create a resource file. 

Ǐ Text File ï Used to create an empty text file. 

Ǐ XML File ï Used to create an empty XML file for whatever you want it for. 

There are two buttons on the top right side of the dialog to change the size of the icons. Below the Templates 
area is a text box that displays a brief description for each Component item. 

2. Specify a file name for the item in the Name field. 

3. Click OK. 

The item is added at the location you selected in the Workspace Explorer, and an empty file of the type you added 
opens in the Text Editor as a tabbed document. 

See Also: 

Â Adding an Existing Project Item 

Â Workspace/Project 

Â Adding a New Component Item 

Â Workspace Explorer 

Â Text Editor 
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Adding an Existing Project Item 

PSoC Creator provides the ability to add an existing project item, such as an assembly or header file to a current 
project. This could be a file used in other projects, or a file that another person created as part of a design team. 

To Add an Existing Item: 

Right-click on a project in the Workspace Explorer and select Add > Existing Item. You can also select Existing 
Item from the Project menu. 

Either method opens the Open dialog. 

 
 

Use this dialog to browse and select item to add to the current project, and then click Open. 

Notes 

Some file types, such as *.cyre, are copied from their existing location to the current project's cydsn folder; other file 
types, such as header files are not. Be aware of which files are not copied for portability issues. 
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If you add an existing assembly file, you may need to select the correct file type from the drop-down menu in the 
Properties dialog. 

 
 

See Also:  

Â Adding a New Workspace/Project Item 

Â Workspace/Project 

Â Adding a New Component Item 

Â Workspace Explorer 

Assigning a Core in a Multi-Core Design 

When you create a new multi-core PSoC 6 project, the initial project structure in the Workspace Explorer includes a 
folder for each core (CM0p and CM4), as well as a folder for source files that are to be built for all cores on the 
device (Shared Files). By default, these folders and any files in them will be built for the specific cores: CM0p for 
CortexM0p, CM4 for CortexM4, and Shared for both. 
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Cores Property 

All files and folders for multi-core designs have a category of properties named Build filters. Among these 
properties is one named Cores, and it controls which source files are built for each core. If you open a folder's 
Properties dialog, you can modify the Cores property value. Setting the property value to "All" will cause all source 
in that folder to be built for all available device cores. 

 
 

Notes: 

Â When adding a new file to a folder, that file's Cores property value will default to its parent folder's value. 

Â When adding a new folder at the project level, that new folder's Cores property value will default to a value of 
"All." 

Â When adding a new folder at another level, that new folder's Cores property value will default to its parent 
container's value. 

Â When moving a file from one folder to another, that file's Cores property will take on the value of its new parent 
folder. 

Processor Property 

Another Build filters property is named Processors, and it is used to differentiate between multiple cores of the 
same type (for example, a device with multiple CM4 cores, when you want a file to be built for only one of those 
multiple CM4 cores). 

See Also: 

Â Workspace Explorer 

Â Properties 

Â Building a PSoC Creator Project 
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Writing Code 

PSoC Creator provides a Code Editor to write C code for your designs. You can use this tool or any other preferred 
code editor you prefer. If you use the PSoC Creator Code Editor, files you create, edit, and save as part of your 
design will be integrated into the Save and Build processes automatically. Files you edit externally can still be 
included in the Build process, but if you make changes external to PSoC Creator, make sure you save those 
changes using your preferred tool. 

Embedded Programming with C - Beginners Resources: 

See the following link for information and links to resources for writing C code:  

Â http://www.cypress.com/blog/psoc-creator-news-and-information/matts-tips-embedded-programming-c-
beginners-resources 

Including Code in Generated Source 

As described in the Building a PSoC Creator Project section, PSoC Creator generates code when you build your 
project/workspace. Sometimes, you may want to run or include your own code with that generated code. PSoC 
Creator provides two methods to do this: 

Â Macro Callbacks (preferred) 

Â Merge Regions (legacy) 

Macro Callbacks 

Macro Callbacks is a term defined in PSoC Creator to call user code from macros specified in a Component's 
generated code. These macros can be used by defining them in the user-defined header file named 
cyapicallbacks.h. This file will be included in all generated source files that offer callbacks. 

A callback requires you to complete the following: 

Â Define a macro to signal the presence of a callback (in cyapicallbacks.h). 

Â Write the function declaration (in cyapicallbacks.h). 

Â Write the function implementation (in any user file). 

To complete the example, the cyapicallbacks.h file would include this code: 

#define SimpleComp_1_START_CALLBACK  

void SimpleComp_1_Start_Callback( void );  

  

In any other user file, you could include cyapicallbacks.h and write the SimpleComp_1_Start_Callback() function. 

Merge Regions 

Merge Regions provide another method to insert user code, through the use of specially marked sections in 
generated code, such as: 

/* `#START isr_Interrupt` */  

/* `#END` */  

  

Anything you place in this region will be preserved in subsequent updates of the file. If a subsequent version of the 
file does not contain the same named region, the entire region from the previous file will be copied to the end of the 
file and placed in comments. 

http://www.cypress.com/blog/psoc-creator-news-and-information/matts-tips-embedded-programming-c-beginners-resources
http://www.cypress.com/blog/psoc-creator-news-and-information/matts-tips-embedded-programming-c-beginners-resources
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See Also: 

Â Code Editor 

Â Building a PSoC Creator Project 

Archiving a Workspace/Project 

The Workspace/Project Archiver dialog allows you to archive an entire workspace or a project from the current 
workspace. You can also use it to bundle an entire workspace, including dependent projects. The archive can either 
be zipped or not. Only the files registered with the workspace/project and any file that PSoC Creator generates can 
be archived. 

 
 

To Open the Dialog: 

1. Open the PSoC Creator workspace/project you want to archive. 

2. Use one of the following methods, as applicable: 

Ǐ Select Archive Workspace/Project... from the Project menu 

Ǐ Right-click on a project or workspace in the Source tab of the Workspace Explorer and select Archive 
Workspace/Project... 

Ǐ Select Create Workspace Bundleé from the File menu. 

Note If there are any modified files in the workspace, you will be prompted to save them before the dialog will open. 

To Archive a Project/Workspace: 

1. Select the Source workspace or project to archive. 

2. Specify the Destination where to create the archive. Either type the path, or click [...] and browse to the 
appropriate directory. 
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3. Select the Compress Archive check box to create a zip file that contains the archive; de-select to choose not 
to zip the archive. 

4. Select one of the following levels as desired: 

Ǐ Minimal ï This level includes project source files and generated source files. Only non-external files 
are archived. Non-external files are those files located under the archiving sourceôs parent directory on 
disk. 

Ǐ Complete ï This level includes project source files, generated source files, all derived files (build 
output files), and user data files. Only non-external files are archived. Non-external files are those files 
that are located under the archiving sourceôs parent directory on disk. 

Ǐ Bundle ï This level includes project source files, generated source files, all derived files (build output 
files), user data files, and dependant projects. External files are included in this level. Also, 
project/workspace files have their dependencies/links updated to reference the archived copies of the 
projects/files. This is to achieve the goal of being able to open a bundle from anywhere and it will 
always behave the exact same (that is, have all its references with it). 

Ǐ If you choose the bundle option, a workspace will always be archived. If a workspace is selected as a 
source, it will be archived. If, however a project is selected, a new workspace will be created that 
contains only the project to archive and it will be archived. This is done because there are project 
dependencies that are stored on the workspace which need to be included. 

- Name ï Enter a name to rename the archived workspace. If zipped, it will also be used as the 
zipped file name. 

- Include standard Cypress libraries ï Select this check box to include a copy of all Cypress 
libraries (CyPrimitives and CyComponentLibrary) in the archive. This will add dependencies to 
the archived copies, and they will be used prior to the standard Cypress libraries installed on 
the machine. 

5. Click Archive. The dialog shows the progress and reports success or failure. 

Ǐ If successful, an Open archive in Windows Explorer check box displays to open the archive location 
upon clicking OK. 

Ǐ If not, an error message will be displayed explaining the cause of the failure. 

6. Click OK to close the dialog. 

See Also: 

Â Workspace/Project 

Â Saving a Project As 

Â Copying a Project 
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Saving a Project As 

PSoC Creator allows you to save a project with another name in the same location or with any name in a different 
location. This is useful when you want to have a back-up project and you do not wish to use the Archiving tool. 

To Save a Project As: 

Select the project and select Save <project> As... from the File menu.  

You can also right-click on a project in the Workspace Explorer and select Save <project> As... 

The standard Windows Save As dialog opens to select a location and enter a name for the project to save. 

 
 

See Also: 

Â Archiving a Project 

Â Copying a Project 

Generating a Project Datasheet 

A project datasheet is a PDF document generated from your PSoC Creator project. It includes: 

Â Overview of your selected PSoC chip architecture 

Â List of chip resources used 

Â Pins 

Â Design-wide resource settings (clocks, interrupts, DMA, flash security, etc.) 

Â Schematic sheets 
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Â Components and parameter settings 

The project datasheet acts as a snapshot summary of your completed design. It is useful as a hand-off document 
from the engineering team, who configure the hardware portion of a PSoC design, to the firmware team who are 
programming it. This is helpful if the firmware team is using an IDE other than PSoC Creator, without direct access 
to PSoC design configuration data.  

To Generate a Project Datasheet: 

1. The project for the datasheet to be generated must be the active project. If necessary, right-click on the project 
under the Source tab in the Workspace Explorer, and select Set as Active Project. 

2. If the project has not been built, or if there were changes made since it was last built, build the project at this 
time.  

3. Click the Build menu and select Generate Project Datasheet. 

If you attempt to generate a project datasheet without updating the build first, PSoC Creator will display a 
message and allow you to rebuild the project first. 

When the datasheet has been generated, it will be listed under the Documentation tab in the Workspace Explorer. 
Double-click the file to open in the same manner as any other document. 

See Also: 

Â Workspace Explorer 

Â Building a PSoC Creator Project 

Generating Description Files 

PSoC Creator provides a feature to generate two XML-based files that describe the contents of various design 
entry files (schematic, schematic macro, symbol, UDB, and sheet template). One file (.cysem) contains all the 
semantically meaningful data from the source. The other file (.cyvis) includes the cosmetic information from the 
source. There can be several sets of these .cysem and .cyvis files in a project, depending on the types of design 
entry files you create in a project. 

The generated files can be used as documentation for the design. You may also compare these XML-based files 
from different projects to determine the differences between them, using any text diff utility program. You may 
include these files in revision control repositories because they enable a reader to determine what changed in a 
particular PSoC Creator file. However, this is not a revision control feature per se. 

Note This feature is turned off by default for every project you create. 
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To Enable the Feature (Per Project): 

In the Workspace Explorer, right-click on a project and select Properties. to open the Properties dialog. 

Select True for the Generate Description Files property, and click OK to close the dialog. 

 
 

To Generate Description Files: 

The description files are not automatically generated when the option is enabled. They will not be created for a file 
until you save a change to that file. After making a save, the files are saved next to the particular design entry file 
on disk from which it was generated. 

Notes: 

Â If either file is a set as read-only file, a dialog will display requesting to make it writable. 

Â If you disable the feature, any previously generated files will remain on disk. 

Â The generated files will be included in all levels of project archiving, as long as the feature is enabled. 

Command Line 

Command line options have been added to help facilitate this feature, including: 

Â -generateDescFiles: For all specified projects that have 'Generate description files' enabled, generates the 
description files. 

Â -verifyDescFileEnabled: Verifies that all specified projects have 'Generate description files' enabled. 

Â -verifyDescFileContents: Verifies that all specified projects (that have 'Generate description files' enabled) have 
generated files that are in-sync with the current version of their source files. 

See CyPrjMgr Command Line Tool for more information. 

See Also: 

Â Workspace Explorer 
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Â Properties 

Â Source Code Control 

Â Archiving a Workspace/Project 

Copying a Project 

PSoC Creator allows you to copy a project within a workspace, as well as from workspace to another. 

To Copy a Project: 

Right-click on the project in the Workspace Explorer and select Copy. 

To Paste a Project: 

Right-click on a project or workspace in the Workspace Explorer and select Paste. 

The copied project is added to the workspace with "_Copy_01" appended to the project name. 

See Also: 

Â Archiving a Project 

Â Saving a Project As 

Selecting a Default Compiler 

For all target devices, PSoC Creator supports multiple toolchains. While there is a preferred default for each family, 
you may change the tools used on a per-project basis using the option under Build Settings. However, if you have 
installed an external compiler, you can specify the default to use for every new project under Project Management 
Options. To select a default compiler: 

1. Select Options from the Tools menu. 

2. Expand Project Management, and select either DP8051 Toolchains or ARM Toolchains. 

3. Select the Default Toolchain pull-down menu and select the appropriate option. 

For the selected toolchain, a warning indicator will display. 

4. Click the Browse [...] button, navigate to the location where the binary file is stored, select it, and click OK. 

5. Click OK to close the Options dialog. 

See Also: 

Â Options Dialog 

Â Build Settings 
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Creating a New File 

The New File dialog is used to create new files with PSoC Creator. The dialog provides templates of the different 
types of files you can create. You may want to create a file for many reasons, such as having a file to copy and 
paste code. 

 

Creating a new file is not the same as adding a file to a project or adding a Component item. This process merely 
creates an empty file of the type you specify. To add a new file to your project, see Adding a New 
Workspace/Project Item. To add a Component item to your project see Adding a Component Item. 

To Open this Dialog: 

From the File menu, select New > File... . 

To Create a New File: 

Select the icon for the type of file to create and click OK. 

An empty file of the type you created opens in the Text Editor as a tabbed document with a default name. 

Note The file is not saved to disk until you specify a name and location to save it. 

See Also: 

Â Text Editor 

Â Workspace/Project 
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Opening an Existing File 

The Open File dialog is used to open an existing file within PSoC Creator. You may want to open a file for many 
reasons, such as having a file to copy and paste code. 

 
 

Use this dialog to browse and select files you wish to open, such as source code and text files. Opening a file using 
this dialog merely opens the file in PSoC Creator. That file is not part of any project you may have open. To add a 
file to an existing project, see Adding a New Workspace/Project Item. 

To Open this Dialog: 

From the File menu, select Open > File... . 

To Open a File: 

1. Navigate to the appropriate directory where the file to open is located. 

2. Select the desired file and click Open. 

The file opens in the Text Editor as a tabbed document. 

See Also: 

Â Text Editor 

Â Workspace/Project 

Â Creating a New File 

Â Opening an Existing Project 
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Creating Folders 

In PSoC Creator, there are two different types of folders: physical and virtual. Physical folders are created on disk 
by PSoC Creator as part of creating projects, Components, and devices/families/architectures. Virtual folders do not 
exist on disk. You can create virtual folders in your workspaces and projects to organize things as you need them, 
but you will not see those folders using Windows Explorer. 

Filters: 

Each folder has a set of associated filters. When a new file is added to a project containing one or more folders, 
that file will be added to the first folder with a filter matching the extension of the new file. This only occurs when 
you add the file to the project directly. 

To Create Physical Folders: 

Use the PSoC Creator interface to create a new project, add Components, or generate files from a build. These 
folders are created for you by PSoC Creator. 

To Create Virtual Folders: 

1. In the Workspace Explorer under the Source tab, right-click on a workspace, project, or folder and select Add 
> New Folder or Add > New Workspace Folder. 

A new folder is added to the selected item and given a default name. 

2. Type a name for the folder and press [Enter]. 

See Also: 

Â Workspace Explorer 

Â Creating a New Project 

Â Creating a Symbol 

Â Building a PSoC Creator Project 

PSoC Creator Framework 

This section contains the following topics: 

Â Framework Description 

Â Window Types 

Â Framework Interface Components 

Â Customizing the Framework 
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Framework Description 

The PSoC Creator framework provides numerous features to help organize your designs and complete projects 
faster. 

 
 

When you first open PSoC Creator, the framework displays with a Workspace Explorer, document work area, and 
Output window. The framework also contains a menu and a status bar, as well as various toolbars that will change 
depending on the type of file you are working with. 

Workspace Explorer: 

The Workspace Explorer is a docked tool window, which displays your project files in a similar manner to Windows 
Explorer. If you double-click a file in the Workspace Explorer, that file will display in the work area. For more 
information, see Workspace Explorer. 

Document Work Area: 

The document work area contains various files you have opened for your project. Depending on the type of file 
displayed, different tools and commands become available. For example, if you open a source code file, you will 
see toolbar commands for source code editing; if you open a schematic file, you will see commands for editing 
schematics, such as the Component Catalog used for adding items to your schematic. 

All files open in the work area display as tabbed documents, with the active document on top and the other 
documents behind. For more information, see Document Windows. 
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Start Page 

The Start page is a general tabbed document window that is not part of any project. It provides links to create new 
projects, open existing projects, as well as links to information and news about PSoC devices. It displays in the 
same work area where other document windows will be opened as you work with your design. 

You can configure whether or not to show the Start page on startup; see Environment Options.   

Output Window: 

The Output window is another docked tool window that shows various system messages. For more information, 
see Output Window. 

Status Bar 

The status bar displays informational messages regarding the status of your design. If there are Components that 
need to be updated, there will be an indication (see Component Update). The status bar also shows the number of 
errors, warnings, and notes that are contained in the Notice List window. 

See Also: 

Â Window Types 

Â Document Windows 

Â Tool Windows 

Â Framework Interface Components 

Window Types 

PSoC Creator has two types of windows: tool windows and document windows. These two window types behave in 
slightly different ways. 

Tool windows: 

Tool windows are listed on the View menu and are defined by the current application and its add-ins. They include 
the Workspace Explorer, Output Window, and Component Catalog. You can configure tool windows to: 

Â Show or hide automatically 



Understanding PSoC Creator 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 78 

Â Tab link with other tool windows 

Â Dock against the edges of the framework 

Â Float over 

See Tool Windows for more information. 

Document windows: 

Document windows are dynamically created when you open or create files or other items. The list of open 
document windows appears on the Window menu, with the top-most window listed first. These can include source 
code files, schematic files, symbol files, and design-wide resources files. See Document Windows for more 
information. 

Arranging Windows: 

You can increase the viewing and editing space for code, depending on how you arrange the windows. You have 
several options for arranging windows, including the following: 

Â Tab-dock document windows 

Â Dock tool windows to the edge of a frame 

Â Minimize tool windows along the edge of the frame 

Â Tile document windows 

See Customizing the Framework for more information. 

See Also: 

Â Tool Windows 

Â Document Windows 

Tool Windows 

Tool windows are listed on the View menu and they include some of the following: 

Â Workspace Explorer 

Â Output Window 

Â Component Catalog 

These windows provide different types of functionality within PSoC Creator; however, they all can be arranged 
within the framework using the same techniques. 

Tool Window Toolbar: 

 
 

Every tool window contains the following toolbar commands: 

Â Window Mode ï This pull down menu allows you to toggle the window to different modes, including: 
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Â Floating ï Sets the tool window as a floating window not attached to the PSoC Creator framework. 

Â Dockable ï Sets the tool window as dockable to the PSoC Creator framework. 

Â Tabbed Document ï Sets the tool window as a tabbed document window. 

Â Auto-Hide ï Sets the tool window to slide to the edge of the framework when not in use. 

Â Hide ï Closes the tool window. 

These are the same commands available from the tool window right-click context menu. 

Â Auto-Hide Pushpin ï This command toggles the auto-hide feature on and off. 

Â Close ï This command closes the tool window. 

See Also: 

Â To Auto-Hide Tool Windows 

Â To Move Tool Windows 

Â To Dock Tool Windows 

Â To Float Tool Windows 

Document Windows 

Document windows are dynamically created when you open or create files or other items. They display in the 
document work area as tabbed documents, with the active document on top and the other documents behind. 

 
 

The following sections describe various aspects of displaying and working with document windows. 

Document Work Area Toolbar: 

 
 

The toolbar at the top right of the document work area contains the following commands: 

Â Select Document ï This pull down menu displays a list of open document windows in the work area according 
to the tab order. You can use this menu to select another open document to display. 
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Â Scroll Left/Right ï The left/right scroll arrows are available if there are more open documents to display to the 
left or right of the visible work area. 

Â Close ï This command closes the active document 

Document Tab Context Menus: 

You can right-click on a tab to display a context menu. There are two different types of context menus: one for 
project files and another for non-project files. 

Project File Context Menu 

Project files, such as a source code file or a schematic file, can only be displayed as a tabbed document in the 
document work area. When you right click on a project file tab, the following commands will be available depending 
on the context of the selected project file: 

 

Â Save ï Saves selected file. 

Â Close ï Closes selected file. 

Â Close All But This ï Closes all open tabbed documents except the 
selected file. 

Â Copy Full Path ï Copies the full path of the file to the clipboard for 
pasting into a text file. 

Â Open Containing Folder ï Opens the folder in which the file is 
located. 

Â New Horizontal Tab Group ï Creates a new horizontal tab group 
and moves the selected file to that group. 

Â New Vertical Tab Group ï Creates a new vertical tab group and 
moves the selected file to that group. 

Â Move to Next Tab Group ï Moves the selected file to the next tab 
group. 

Â Move to Previous Tab Group ï Moves the selected file to the 
previous tab group. 
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Non-Project File Context Menu 

Non-project files, such as the Start page, can be displayed as a tabbed document or as a floating or docked tool 
window. The context menu for these types of files contains the following commands: 

 

Â Close ï Closes selected file. 

Â Close All But This ï Closes all open tabbed documents except the 
selected file. 

Â Floating/Dockable/Tabbed Document ï Toggles the display of the 
file between a floating window, dockable window, or tabbed 
document. 

Â Auto-Hide ï Only active for a dockable window; allows the window 
to collapse to the edge of the framework. 

Â Hide ï Closes selected file/window. 

Â New Horizontal Tab Group ï Creates a new horizontal tab group 
and moves the selected file to that group. 

Â New Vertical Tab Group ï Creates a new vertical tab group and 
moves the selected file to that group. 

Â Move to Next Tab Group ï Moves the selected file to the next tab 
group. 

Â Move to Previous Tab Group ï Moves the selected file to the 
previous tab group. 

To Select Document Windows: 

When you have Tabbed Documents, document windows are placed side-by-side on tabbed panes as they are 
opened. This makes it simple to cycle through the documents you are editing. 

To move through open documents in order of use: 

Â Press [Ctrl] + [Tab] to activate open documents in the order that they were most recently touched. 

Â Press [Ctrl] + [Shift] + [Tab] to activate open documents in the reverse order. 
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Tab Groups: 

Tab Groups allow you to manage limited workspace while working with two or more open documents. You can 
organize multiple document windows into either vertical or horizontal Tab Groups and easily shuffle documents from 
one Tab Group to another. 

 
 

Split Windows: 

Some types of files, such as source code, allow you to view or edit two locations of the same file at once. 

Â To divide your document into two independently scrolling sections, select the Split icon located above the scroll 
bar and drag to the desired location. 

 
 

Â To remove the split, drag from the split back above the scroll bar. 

See Also: 

Â Tool Windows 
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Customizing the Framework 

This section contains several "how to" topics that allow you to customize the PSoC Creator framework: 

Â To Float Tool Windows 

Â To Dock Tool Windows 

Â To Use Tabbed Documents 

Â To Move Tool Windows 

Â To Auto-Hide Tool Windows 

To Float Tool Windows 

You can float various PSoC Creator windows outside the framework. Floating means a window is not attached to 
the framework. 

1. Select the window you wish to float and select Floating from the Window mode menu. 

 
 

Notice the window moves outside the PSoC Creator framework. 
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2. Move the window from its current location to anywhere on your screen. 

See Also: 

Â Tool Windows 

Â Framework Description 

Â To Move Tool Windows 

Â To Dock Tool Windows 

To Dock Tool Windows 

You can dock various windows in different locations within the PSoC Creator framework. Docking means attaching 
a window to the framework. 

1. Select the window you wish to move and select Dockable from the Window mode menu. 

 
 

2. Drag the window from its current location toward another location within the framework. 

Notice as you drag the window that docking guides appear at different locations. 
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3. When the window you are dragging reaches the position where you want to dock it, place the mouse over the 
corresponding portion of the guide. 

An outline of the window appears in the designated area. 

4. To dock the window in the position indicated, release the mouse. 

Tool windows can be docked to the framework edge or other existing edges, as well as within other windows as 
tabs. The following table shows the different docking guides and their meanings: 

 

Dock to the left edge. 

 

Dock to the right edge. 

 

Dock to the top edge. 

 

Dock to the bottom edge. 

 

Dock to the left, right, top, or bottom edge or dock within the window as a tab. 

See Also: 

Â Tool Windows 

Â Framework Description 

Â To Move Tool Windows 

Â To Float Tool Windows 

To Use Tabbed Documents 

As described under Window Types, certain windows can be docked to the framework or used as tabbed 
documents. Tabbed documents appear side-by-side in an area of the tool: 
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To change a window to a tabbed document (for example the Workspace Explorer), right-click on the window header 
and select Tabbed Document. 

 
 

Note If a window cannot be changed to a tabbed document (such as the Component Catalog), the menu item will 
be disabled (grayed out). 

After the menu item is selected, the window will be shown as a tabbed document along with other open documents. 

 
 

See Also: 

Â Window Types 

Â Tool Windows 

Â Document Windows 

To Move Tool Windows 

You can move various windows to different locations within the PSoC Creator framework, or even outside the 
framework altogether. 

1. Click the title bar of the window you wish to move. 

2. Drag the window from its current location toward another location. 
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Notice as you drag the window that docking guides appear at different locations. 

 
 

3. Move the window to the desired location and release the mouse. 

See Also: 

Â To Dock Tool Windows 

Â To Float Tool Windows 

Â Framework Description 

Â Tool Windows 

To Auto-Hide Tool Windows: 

The auto-hide feature allows you to see more of the PSoC Creator framework by minimizing tool windows along the 
edges of the framework when not in use. 

To Turn On Auto-Hide: 

Turn on auto-hide using one of these methods: 

Â Select Auto-Hide from the Tool Window toolbar or right-click context menu. 
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Â Click the Auto-Hide Pushpin icon. 

 
 

The window automatically slides to the edge of the framework. Its name is visible on a tab at the edge of the 
framework. 

 
 

To Show the Hidden Window: 

Place your cursor on the tab to slide the tool window back into place. 

 
 

To Turn Off Auto Hide: 

Turn off auto-hide using one of these methods: 

Â Select Dockable from to Tool Window toolbar or right-click context menu, or 

Â Click to the Auto-Hide Pushpin again. 

See Also: 

Â Framework Description 

Â Tool Windows 

Â To Move Tool Windows 

Â To Dock Tool Windows 

Â To Float Tool Windows 
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Framework Interface Components 

The major PSoC Creator framework Components include: 

Â Workspace Explorer 

Â Output Window 

Â Notice List Window 

Â Resource Meter 

Â File Menu 

Â Edit Menu 

Â View Menu 

Â Project Menu 

Â Build Menu 

Â Debugger Menus 

Â Tools Menu 

Â Window Menu 

Â Help Menu 

Â Standard Toolbar 

Â Keyboard Shortcuts 

Workspace Explorer 

The Workspace Explorer is PSoC Creatorôs method for displaying the contents of a workspace. 
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The contents are displayed in a tree format, similar to Windows Explorer. There are also different tabs along the 
side of the tool window that allow you to view different types of files by category. 

Toolbar Commands: 

The Workspace Explorer has two commands: 

Â Collapse to Project ï Collapses the selected project tree to the top-level project. 

Â Collapse to Parent ï Collapse the selected tree to the top-level node. 

Note When you right-click on most items in the Workspace Explorer tree, you can access context-menu commands 
relevant to the item selected. Most of these commands are described under Project Menu or Build Menu. 

To Open a File: 

Double-click any file in the Workspace Explorer to open it in the document work area as a tabbed document. 

Source Tab: 

The Source tab displays by default if no other tab was selected. PSoC Creator only shows files you added or that 
were generated from the Code Generation step of a PSoC Creator build. The view is updated whenever a build 
completes or PSoC Creator is given focus. 

When in the Source tab, you will only be able to add new folders and files to projects, or create new projects. You 
will not be able to manipulate Components. If you wish to add new items to Components, or new Components 
entirely, you must use the Components tab. 

Generated Source 

In a design project, the Generated Source directory contains the source from the Code Generation step. Under the 
Generated Source directory is a sub-directory for each architecture that has been built in the past. Each 
architecture directory is further subdivided with virtual folders for each Component instance that provided an API. In 
addition to the instance directories, the architecture directory contains other generated files, such as a project.h, 
boot file, etc., with each project being a node in the tree. Each project in the workspace also displays all of its 
contents. See Generated Files. 

Components Tab: 

The Components tab filters the contents of the workspace, showing only the Components belonging to each 
project in the workspace, as well as the file and folder contents of all Components. You may add new Components 
and items to Components, and you may add new projects while in this tab. You may add files and folders outside of 
the Components, but only using the Source tab for those operations. For more information about Components, 
refer to the Component Author Guide. 

Documentation Tab: 

The Documentation tab displays and provides quick access to documentation, including Technical Reference 
Manuals (TRMs), as well as device and Component datasheets currently used in your design. As you add and 
remove Components, or change devices, the list of available documents will update accordingly. 

If you double-click a file, it will open in your default PDF reader tool. 
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Results Tab: 

The Results tab displays a dynamic listing of interesting files from the most recent build of each platform. A 
platform will select a subset of build files to display, and there may be differences between what is displayed from 
one platform to another. 

If a platform or configuration has not been built, or if the folders created by that build have been deleted, the folder 
for that platform will not be displayed. In addition, if platform and configuration directories are found, but an 
expected file is missing, that file will appear grayed out, indicating it was not found on disk when expected. 

The minimum set of files to be displayed for a Design build is as follows: 

Â Programming file 

Â Debugging file (if different from Programming file) 

Â Code Generation Report file (if Code Generation was run) 

Â Device File (when implemented) 

Additional files that may be included are list files and map files. 

For a Library build, the resulting library file will be displayed. 

Files in the Results tab can be double-clicked to open an appropriate editor for the file, such as the Text Editor for a 
report file. Other actions that may be available include programming a device or debugging, as appropriate. The 
projects displayed in the Results tab cannot be modified in any way. The tab is simply a display of the results of 
builds. 

See Also: 

Â Workspace/Project 

Â Framework Description 

Â Building a PSoC Creator Project 

Â Generated Files 

Output Window 

The Output window displays status messages for various features in PSoC Creator, including the builder and 
debugger. This window is usually located at the bottom of the PSoC Creator framework. It is often in the same 
window group as the Notice List Window. 
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Note When building a bootloader project, the flash size represents the number of bytes to store in flash (the same 
way it works for normal projects). When building a bootloadable project, the bootloader size represents the size of 
the flash rows consumed by the bootloader (the bootloader is padded to a multiple of the row size). 

To Display the Output Window: 

The Output window usually displays by default when you launch PSoC Creator. If the window was closed, you can 
open it again by selecting Output Window from the View menu. 

Toolbar: 

Depending on which tool you are using, the Output window will have various toolbar commands for you to use. The 
following are the most common commands: 

Show output from 

Displays one or more output panes to view. Several panes of information might be available, depending upon which 
tools have used the Output window to deliver messages. 

Clear all 

Clears all text from the Output pane. 

See Also: 

Â Framework Description 

Â Notice List Window 

Notice List Window 

The Notice List window combines notices (errors, warnings, and notes) from many places in your design into one 
centralized list. If a file and/or error location is shown, you can double-click the entry to show the error or warning. 
There are also buttons to Go To Error or View Details. This window is usually located at the bottom of the PSoC 
Creator framework. It is often in the same window group as the Output window. 

 
 

If your design's Notice List window contains notices, they are displayed in numbered rows. Above the rows are a 
set of filters to show or hide notices, as follows: 
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Â Workspace/Active Project ï Use this combo box to show notices from all the projects (and their 
dependencies) in the workspace or to show notices only from the active project (and its dependencies). This 
filter only applies to notices associated with a project. 

Â Errors  ï These indicate there is at least one problem that must be addressed before you can build your 
application. Typical errors could include: compiler build errors, dynamic connectivity errors in schematics, and 
Design Rule Checker (DRC) errors. Errors from the build process remain in the list until the next build. 

Â Warnings  ï These report unusual conditions that might indicate a problem, although you can usually build 
the application regardless. 

Â Notes  ï These are informational messages from the system to indicate something occurred. 

Note Gray rows are notices not associated with the active project or one of its dependencies. They will not be 
shown if the Active Project filter is selected from the combo box. 

The Notice List contains the following columns: 

Â Icon ï Displays the icons for the error, warning, or note.  A specific row may also contain a tree control 
containing individual parts of the overall message. 

Â Number ï Displays the number of the notice. 

Â Description ï Displays a brief description of the notice. 

Â File ï Displays the file name where the notice originated, 

Â Error Location ï Displays the specific line number or other location of the message, when applicable. 

Â Project ï Displays the name of the project that contains the notice. White rows are for the Active project; grey 
rows are for inactive projects. 

Design Rule Checker (DRC): 

The DRC evaluates your design based on a collection of pre-determined rules in the project database. The DRC 
points out potential errors or "rule" violations in your project that might pose problems. It displays various messages 
in the Notice List window. 

Some connectivity and dynamic errors update as soon as you make changes to your design, while other errors 
update on load and save operations.   

To Open the Notice List Window: 

The Notice List window is displayed by default. If you close the window, you can open it again by selecting View > 
Other Windows > Notice List. 

You can also re-open the window by selecting Windows > Reset Layout. However, this option will reset all 
windows to the default positions. 

To Display Errors in Tools: 

Click on a notice in the list. If there is a link to the error, click the Go To Error button. You may also double-click any 
warning or error in the Notice List window to show that error or warning in the appropriate tool. There is also a 
command available to go to the error if you right-click on a notice. 

Â In a schematic, a translucent red highlight shows the source(s) of the error. You can turn highlighting on or off 
using the right-click menu on a notice. 
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Â In a code file, the specific line of code with the error or warning will be highlighted. 

To View the Message Description: 

Click the  button next to the message or click the View Details button to open the Notice Details dialog. There 
is also a command available to view details if you right-click on a notice. The Notice Details dialog will display the 
entire message, as well as additional information if available. 

 
 

Context Menu: 

As described previously, there is also a context menu if you right-click on a notice. The menu items available 
include: 

Â Show/Hide Error Highlighting: Turns on/off highlight of the error. 

Â Go to the Error Location: Moves the display to the error, if applicable. 

Â More Information: Displays the Notice Details dialog for more information. 

See Also: 

Â Framework Description 

Â Output Window 

Â Notice Details 
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Resource Meter 

The Resource Meter is a graphical display of the resources used in the currently active project of your workspace. It 
updates after every build. This keeps you notified of possible resource overuse and helps identify which resource is 
the cause of the problem.  

 
 

Description 

Each resource contains a color-coded bar graph that shows the number or percentage of resources used. The 
following table shows the colors used and indicate their meaning: 

Color Description 

Green Resource fits in the current design. 

Red Resource is overused in the current design; build failed. 

White Resource is not used. 

If the build fails or only a partial build is performed (that is, Generate Application), any resources that did not have 
their usage recalculated will be displayed as washed out, as it is potentially stale.  

Note Any previous usage calculations will still be displayed; they just might not be accurate due to the fact that they 
weren't recalculated. 
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To Open the Resource Meter: 

The Resource Meter is available after you open a project or create a new project. By default, this tool window is set 
to auto-hide on the right side of the PSoC Creator framework. To display it, click the Resource Meter tab: 

 
 

If the window is closed, you can open it again by selecting Resource Meter from the View menu. 

File Menu 

The File menu contains the following commands: 

Menu Item Icon Shortcut Description See Also 

New >  Project 
 

  Displays a dialog to create a new project. Creating a New 
Project 

File 
 

  Displays a dialog to create a new file. Creating Files 

Open > Project/Workspace 
 

  Displays a dialog to open an existing 
project/workspace. 

Opening an Existing 
Project 

File 
 

[Ctrl] + [O] Displays a dialog to open an existing file. Opening an Existing 
File 

Code Example     Displays a dialog to open a code example. Find Code Example 

Add >  New Project     Adds a new project to the workspace.   

  Existing Project     Adds and existing project to the workspace.   

Close   [Ctrl] + 
[F4] 

Closes the active document window. Window Types  

Close Workspace 
 

  Closes the workspace.   

Save 
 

[Ctrl] + [S] Saves the active document.   

Save <Project / File> As     Displays a dialog to save the selected project or file 
as another project or file. 

Saving a Project As 

Save All 
 

[Ctrl]+ 
[shift] + [S] 

Saves all the files in the workspace.   

Create Workspace Bundle     Opens the Workspace/Project Archiver wizard to 
create workspace bundle. 

Archiving a 
Workspace/Project 

Page Setup     Opens the Page Setup dialog to select printing 
layout options. 
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Menu Item Icon Shortcut Description See Also 

Print 
 

[Ctrl] + [P] Prints the active document.   

Print Preview     Opens the Print Preview dialog for the selected file. Print Preview 

Recent Files 
    

Provides access to previously opened files.   

Recent Projects     Provides access to previously opened projects.   

Exit     Exits PSoC Creator.   

  

Edit Menu 

The Edit menu contains the following commands: 

Menu Item Icon Shortcut Description See Also 

Undo 
 

[Ctrl] + [Z] Undoes the last action; can be used repeatedly to 
undo multiple actions. 

  

Redo 
 

[Ctrl] + [Y] Redoes the last action.   

Cut 
 

[Ctrl] + [X] Cuts the selected element(s).   

Copy 
 

[Ctrl] + [C] Copies the selected element(s).   

Paste 
 

[Ctrl] + [V] Pastes the cut or copied elements from the clipboard.   

Delete 
 

[Delete] Deletes the selected element(s).   

Select All   [Ctrl] + [A] Selects all elements in active window.   

Find and Replace > 

     Find 
 

[Ctrl] + [F] Opens a dialog to find text. Find Replace 

     Replace 
 

[Crtl] + [H] Opens a dialog to find and replace text. Find Replace 

     Find in Files 
 

[Ctrl] + [Shift] + 
[F] 

Opens a dialog to find text in multiple files. Find in Files 

     Replace in Files 
 

[Ctrl] + [Shift] + 
[H] 

Opens a dialog to find and replace text in multiple 
files. 

Replace in Files 

Go To 
  

[Ctrl] + [G] Opens the Go To dialog. Go To Line 

Advanced > Text Editor  

     Tabify Selected 
Text 

    Converts spaces to tabs for the selected text. The 
number of spaces per tab is defined in the Text Editor 
Options Dialog. 

  

     UnTabify Selected 
Text 

    Converts tabs to spaces for the selected text.   

     Make Uppercase   [Ctrl] + [Shift] + 
[U] 

Changes selected text to uppercase letters.   

     Make Lowercase   [Ctrl] + [U] Changes selected text to lowercase letters.   
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Menu Item Icon Shortcut Description See Also 

     View White Space   [Ctrl] + [E], [S] Toggles on or off to show hidden characters, such as 
spaces or tabs. Press and hold [Ctrl] and [E] keys, 
release, and then press [S] key. 

  

     Incremental 
Search  

[Ctrl] + [I] Find first instance of matching pattern after pressing 
shortcut keys. Press [Ctrl] + [I] keys and the icon 
displays. Then type letters to find. 

  

     Comment 
Selection  

[Ctrl] + [E], [C] Comments selected line(s) of text. Inserts // at the 
beginning of the line. Press and hold [Ctrl] and [E] 
keys, release, and then press [C] key. 

  

     Uncomment 
Selection  

[Ctrl] + [E], [U] Uncomments selected line(s) of text. Removes // at 
the beginning of the line. Press and hold [Ctrl] and [E] 
keys, release, and then press [U] key. 

  

     Increase Line 
Indent  

  Indents the selected line(s) of text.   

     Decrease Line 
Indent  

  Outdents the selected line(s) of text.   

     Toggle Bookmark 
 

[Ctrl] + [K], [Ctrl] 
+ [K] 

Inserts or removes a bookmark from the Indicator 
Margin next to the line where the cursor is located. 
Press and hold [Ctrl] and [K] keys, release, and then 

press [Ctrl] and [K] keys again. 

  

Outlining > Text Editor  

     Toggle Outlining 
Expansion 

  [Ctrl] + [M], [M] If Start Automatic Outlining has been selected, this 
command expands or contracts the outlining for 
selected section of code. Press and hold [Ctrl] and [M] 
keys, release, and then press [M] key again. 

  

     Toggle All 
Outlining 

  [Ctrl] + [M], [L] f Start Automatic Outlining has been selected, this 
command expands or contracts all outlining in the file. 
Press and hold [Ctrl] and [M] keys, release, and then 
press [L] key. 

  

     Stop Automatic 
Outlining 

  [Ctrl] + [M], [P] Disables automatic outlining. Press and hold [Ctrl] 
and [M] keys, release, and then press [P] key. 

  

     Start Automatic 
Outlining 

  [Ctrl] + [M], [P] Enables automatic outlining.   

Snippets > 

     Insert Snippet...   [Ctrl] + [K], [X] Opens a menu to select code snippets, if available.   

     Surround with...   [Ctrl] + [K], [S] Opens a menu to insert surround with snippets, if 
available. 

  

  

View Menu 

The View menu contains the following commands: 

Menu Item Icon Shortcut Description See Also 

Output Window 
 

  Open or display the Output window. Output Window 

Workspace Explorer 
 

  Open or display the Workspace 
Explorer. 

Workspace Explorer 

Code Explorer 
 

  Open the Code Explorer window for 
the Code Editor. 

Code Explorer Window 
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Menu Item Icon Shortcut Description See Also 

Component Catalog 
 

  Open the Component Catalog for the 
Schematic Editor. 

Component Catalog 

Resource Meter 
 

  Open the Resource Meter for the 
currently active project. 

Resource Meter  

Other Windows >         

     Notice List     Open or display the Notice List 
window. 

Notice List Window 

     Start Page 
 

  Open or display the Start Page. Framework Description 

Find Results     Open or display Find Results 
windows. 

Find and Replace 

Zoom In/Out/To   [Ctrl] + [+] or Ctrl + [ï] Adjusts size of the page according to 
option 

  

  

Project Menu 

The Project menu contains the following commands: 

Menu Item Icon Description See Also 

New Item 
 

Open New Item dialog to select a new item to add to 
your project/workspace. 

New Item  

Add Component Item 
 

Open Add Component Item dialog to add a new item to 
your Component. 

Add Component Item  

Existing Item 
 

Open the Open dialog to add an existing item to your 
project/workspace. 

Opening an Existing File  

Import Component 
 

Opens the Import Component dialog. Import Component 

Update Components   Opens the Update Component Tool dialog to update 
selected Components. 

  

Remove from 
<Project/Workspace> 

  Remove selected file/project from project/workspace.   

Unload/Reload Project   Alternately unloads and reloads the selected project in 
the Workspace. 

  

New Folder 
 

Create a new virtual folder in the Workspace Explorer 
but not on disk. 

  

Show All Files 
 

Open all files in a directory.   

Set As Active Project   Set the selected project as the active project.   

Set As Top Component   Set the selected Component as the top Component.   

Dependencies   Open the Dependencies dialog. Dependencies 
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Menu Item Icon Description See Also 

Build Order   Opens the Dependencies dialog to the Build Order tab. Dependencies 

Device Selector   Open the Device Selector. Device Selector 

Archive Workspace/Project   Opens the Archive Project dialog to archive the 
workspace/project. 

Archiving a 
Workspace/Project 

Export to IDE 
  

Opens a dialog to export the PSoC Creator design to an 
external IDE. 

Note This option is disabled for PSoC 6 projects. Refer 
to Build Settings > Target IDEs. 

Exporting a Design to 3rd 
Party IDE 

<Project> Resources   Opens the Design-Wide Resources file for the project. Design-Wide Resources 

Build Settings 
 

Open the Build Settings dialog. Build Settings 

Properties   Opens the Properties dialog. Properties 

  

Build Menu 

The Build menu contains the following commands: 

Menu Item Icon Shortcut Description See Also 

Build All Projects 
 

[F6] Build all projects in the workspace. Building a PSoC 
Creator Project 

Clean All Projects 
 

  Clean all projects in the workspace. 

  

Note During the clean process, PSoC Creator 
cleans the build output of only those files that 
are still part of the project. Any output files 
generated using source files that are no longer 
part of the project (deleted or simply removed 
from project), will be left untouched. 

  

  

Clean and Build All Projects 
 

  Clean and build all projects in the workspace.   

Build (Named) Project 
 

[Shift] + [F6] Build the selected project.   

Clean (Named) Project 
 

  Clean the selected project.   

Clean and Build (Named) 
Project  

  Rebuild the selected project.   

Cancel Build 
 

[Ctrl] + [Break] Cancel the build process.   

Compile File 
 

[Ctrl] + [F6] Compile the selected file.   
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Menu Item Icon Shortcut Description See Also 

Generate Application 
 

  Generate API source code files. Generated Files 

Generate Project Datasheet 
 

  Generate a project datasheet. Generating a Project 
Datasheet 

See Also: 

Â Build Toolbar Commands 

Debugger Menu Commands 

The Debug menus provide access to all of the functionality and information available to the current debugger. There 
are two modes for the menu: inactive and active. 

Inactive Mode Debug Menu: 

When the debugger is not running, the Debug menu will be in the inactive state. In this state, only the functions that 
make sense are available on the menu. For instance, the Halt function is unnecessary in the inactive state. In the 
inactive mode, the Debug Windows submenu provides access to a limited subset of the available debug windows. 

Command Icon Shortcut Description 

Windows > Provides access to the various debugger windows. See 
Debugger Windows. 

     Breakpoints 
 

[Ctrl] + [D], [B] Opens the Breakpoints window to display all of the breakpoints 
that have been set in the workspace. 

     Output 
 

[Ctrl] + [D], [O] Opens the Output window. 

Program 
 

[Ctrl] + [F5] Provides a one click means of programming the selected debug 
target with the code generated from the selected project. 

¶ Automatically starts a build if the project is out-of-date 

¶ Updates the status barôs message to indicate that 
programming is taking place. 

¶ Launches PSoC Programmer behind the scenes to 
perform the programming. 

Select Debug Target 
 

  Opens the Select Debug Target dialog to manually select the 
debug target to use. 

Debug 
 

[F5] Starts the debugger. 

Debug without Programming 
 

[Alt] + [F5] Starts the debugger without programming the device. 

Attach to Running Target 
 

  Opens the Attach to Target dialog to connect to an already 
programmed target device. Applicable to PSoC 3 and PSoC 5LP 
only. 

Toggle Breakpoint 
 

[F9] Alternately inserts and removes a breakpoint in the current line 
of code. This is the same as clicking in the Indicator Margin of 
the Code Editor. You can use the [F9] key as a shortcut for this 

command. 

New Breakpoint > Provides access to the following breakpoint windows. See 
Breakpoints Window. 

     Address Breakpoint 
 

[Ctrl] + [D], [A] Opens the Address Breakpoint window. 
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Command Icon Shortcut Description 

     File Line Breakpoint 
 

[Ctrl] + [D], [F] Opens the File/Line Breakpoint window. 

     Function Breakpoint 
 

[Ctrl] + [D], [U] Opens the Function Breakpoint window. 

     Variable Watchpoint 
 

[Ctrl] + [D], [V] Opens the Variable Watchpoints window. 

     Memory Watchpoint 
 

[Ctrl] + [D], [E] Opens the Memory_Watchpoint window. 

Delete All Breakpoints 
 

[Ctrl] + [Shift] + [F9] Deletes all breakpoints in the workspace instead of having to 
remove each one individually. This is useful if there are multiple 
breakpoints set but you just want the processor to run. 

Enable All Breakpoints 
 

  Enables all breakpoints 

 

Active Debug Windows Menu: 

The active debug mode indicates that you have started a debug session; that the active PSoC Creator subsystem 
is the debugger. In the active mode, the debugger is running and you have the full range of available functions; the 
Debug Windows submenu provides access to all of the available debug windows. 

Command Icon Shortcut Description 

Windows > Provides access to the various debugger windows. See Debugger 
Windows. 

     Breakpoints 
 

[Ctrl] + [D], [B] Opens the Breakpoints window to display all of the breakpoints that 
have been set in the workspace. 

     Output 
 

[Ctrl] + [D], [O] Opens the Output window. 

     Watch > 

          1 
 

[Ctrl] + [D], [W] Opens one of four Watch windows to evaluate and display 
variables, registers, or expressions. 

          2 
 

[Ctrl] + [Alt] + [W], [2] 

          3 
 

[Ctrl] + [Alt] + [W], [3] 

          4 
 

[Ctrl] + [Alt] + [W], [4] 

     Locals 
 

[Ctrl] + [D], [L] Opens the Locals window to view and modify all of the local 
variables in the current debug frame. 

     Components 
 

[Ctrl] + [D], [P] Opens the Component Debug Window to view debug information 
about Components in your design. 

     Call Stack 
 

[Ctrl] + [D], [C] Opens the Call Stack window to track the order that different 
functions are called by the target program. 

     Memory > 

          1 
 

[Ctrl] + [D], [M] Opens one of four Memory windows to display the values stored in 
the memory of the processor. 

          2 
 

[Ctrl] + [Alt] + [M], [2] 

          3 
 

[Ctrl] + [Alt] + [M], [3] 

          4 
 

[Ctrl] + [Alt] + [M], [4] 

     Disassembly 
 

[Ctrl] + [Alt] + [D] Opens the Disassembly window to display the basic instructions 
created for your source code. 
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Command Icon Shortcut Description 

     Registers 
 

[Ctrl] + [R], [R] Opens the Registers window to display the core CPU registers and 
their values 

Program 
 

[Ctrl] + [F5] Provides a one click means of programming the selected debug 
target with the code generated from the selected project. 

¶ Automatically starts a build if the project is out-of-date 

¶ Updates the status barôs message to indicate that 
programming is taking place. 

¶ Launches PSoC Programmer behind the scenes to perform 
the programming. 

Select Debug Target 
 

  Opens the Select Debug Target dialog to manually select the debug 
target to use. 

Show Current Line 
 

  Displays the line of code that is or will be executed. 

Resume Execution 
 

[F5] Continues the debugger. Starts the debug target running again after 
a Halt or a breakpoint. Use this function to have the program 
continue running to the next breakpoint. 

Halt Execution 
 

[Ctrl] + [Alt] + [Break] Pauses the debugger. 

Stop Debugging 
 

[Shift] + [F5] Stops the debugging session. 

Rebuild and Run 
 

[Ctrl] + [Shift] + [F5] Rebuilds the program and restarts the debugger. 

Reset 
 

[Ctrl] + [Alt] + [F5] Resets the debugger. 

Step Into 
 

[F11] Executes a single line of code. If the line is a function call, the 
debugger will break at the first instruction in the function. If the line 
is not a function call, the debugger will break at the following line of 
code. Use this to verify that a line of code is doing what is expected. 
This function temporarily allows the processor to run until it finishes 

processing the instructions that make up the current line of code. 

Step Over 
 

[F10] Executes a single line of code. The debugger will break at the 
following line of code. If the current line of code is a function call, 
the function will be executed without stopping. The debugger will 
then stop on the next line after the function call. Use this to verify 
that a line of code is doing what is expected. This function 
temporarily allows the processor to run until it finishes processing 

the instructions that make up the current line of code. 

Step Out 
 

[Shift] + [F11] Finishes executing the current function. The processor is allowed to 
run until the current function has finished. It will halt again at the first 
instruction after the function call. Use this to exit the current function 
and return to the calling method. This function temporarily allows 
the processor to run until it finishes processing the instructions that 
make up the current function. 

Toggle Breakpoint 
 

[F9] Alternately inserts and removes a breakpoint in the current line of 
code. This is the same as clicking in the Indicator Margin of the 
Code Editor. You can use the [F9] key as a shortcut for this 
command. 

New Breakpoint > Provides access to the following breakpoint windows. See 
Breakpoints Window. 

     Address Breakpoint 
 

[Ctrl] + [D], [A] Opens the Address Breakpoint window. 

     File Line Breakpoint 
 

[Ctrl] + [D], [F] Opens the File/Line Breakpoint window. 

     Function Breakpoint 
 

[Ctrl] + [D], [U] Opens the Function Breakpoint window. 
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Command Icon Shortcut Description 

     Variable Watchpoint 
 

[Ctrl] + [D], [V] Opens the Variable Watchpoints window. 

     Memory Watchpoint 
 

[Ctrl] + [D], [E] Opens the Memory_Watchpoint window. 

Delete All Breakpoints 

   

[Ctrl] + [Shift] + [F9] Deletes all breakpoints in the workspace instead of having to 
remove each one individually. This is useful if there are multiple 
breakpoints set but you just want the processor to run. 

Enable All Breakpoints 
 

  Enables all breakpoints. 

Refresh     Refreshes the debugger. 

Enable/Disable Global 
Interrupt 

    Enable/Disable (depending on current state) Global Interrupt 

 

See Also: 

Â Using the Debugger 

Â Debugger Toolbar Commands 

Â Text Editor Context Menu Commands 

Tools Menu 

The Tools menu contains the following commands: 

Menu Item Description See Also 

Find new Components Opens the Component Installer dialog to find and install new and 
updated Components from the Cypress web site. 

Component Installer 

Find new devices Opens the Device Update Installer dialog to find and install new 
devices from the Cypress web site. 

Device Update Installer 

Install drivers for µVision Opens the Installation Wizard to install MiniProg3 drivers for the 
µVision IDE. 

Installing MiniProg3 Drivers  

Datapath Config Tool Launches the Datapath Configuration Tool for use when creating 
Components implemented with Verilog. 

Component Author Guide  

DMA Wizard Opens the DMA Wizard. DMA Wizard 

Component Tuners Allows direct access to tuner dialogs if included in your design. Tuner Communication 
Setup 

Bootloader Host... Launches the stand-alone Bootloader Host application. Bootloader Host Help file 
(Press [F1] within the 
application.) 

Options... Opens the Options dialog. Options Dialog 

 

Window Menu 

The Window menu contains the following commands: 
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Menu Item Description 

New Horizontal Tab Group Creates a new horizontal Tab Group. 

New Vertical Tab Group Creates a new vertical Tab Group. 

Move to Previous Tab Group Move to Previous Tab Group. 

Move to Next Tab Group Move to Next Tab Group. 

Auto Hide All Sets all Tool Windows to the Auto Hide setting. 

Close All Documents Closes all open Document Windows. 

 

Help Menu 

The Help menu contains the following commands: 

Menu Item Description 

PSoC Creator Help 
Topics 

Opens this Help to the Welcome topic. 

Document Manager Opens the Document Manager to access various Cypress documents. If Cypress Document Manager 
is not installed, this opens a link on the Cypress web site to learn more about it and download it. 

System Reference 
Guides 

Opens an HTML page containing information and links to various system-wide and design-wide 
Components. 

Update Manager Launches the Cypress Update Manager to check for and install program updates. 

PSoC Creator 
Training 

Opens the Cypress PSoC Creator Training web page. 

Cypress Dev 
Community 

Open the Cypress Development Community web page. 

Documentation > ¶ Quick Start Guide - Opens the PSoC Creator Quick Start document. 

¶ PSoC Creator User Guide 

¶ Opens the Keyboard Shortcuts Help topic. 

¶ Release Notes - Opens the Release Notes document. 

¶ Known Problems & Solutions - Opens a Cypress web page to access the Known Problems and 
Solutions document. 

¶ Device Datasheets - Opens a Cypress web page to access PSoC device datasheets. 

¶ PSoC Technical Reference Manuals - Opens a Cypress web page to access PSoC TRM 
documents. 

¶ Japanese 
Documentation > 

¶ Component Datasheets - Opens a web page to translated copies of 
various Component datasheets. 

¶ Chinese 
Documentation > 

¶ Component Datasheets - Opens a web page to translated copies of 
various Component datasheets. 

¶ PSoC Creator User Guide (Chinese) 

¶ Component Author Guide 

¶ Peripheral Driver Library - Opens the documentation for the appropriate PDL version for your 
project, based on the path set in the Options Dialog. 

¶ Datapath Configure Tool User Guide 

¶ UDB Editor Guide 

¶ Customizer API Reference Guide 

http://www.cypress.com/documentation/other-resources/psoc-creator-user-guide
http://www.cypress.com/documentation/other-resources/psoc-creator-user-guide
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Menu Item Description 

¶ Warp Verilog Reference Guide 

¶ Tuner API Reference Guide 

¶ GCC Documentation 

¶ Keil  

Register > ¶ PSoC Creator 

¶ Keil 

Support > ¶ Knowledge Base - Opens the Cypress Knowledge Base web page. 

¶ Create a Support Case - Opens the Cypress support web page to create a new support case. 

¶ View Your Support Cases - Opens the Cypress support web page to your home page. 

Order Samples Opens the Cypress Store web page to order samples, kits, cables, etc. 

Contact Us Opens Help topic to provide ways to contact Cypress. 

About Opens the About PSoC Creator dialog, which provides build and plug-in information. 

 

Standard Toolbar 

 

The PSoC Creator standard toolbar contains the following commands: 

Â New Project/Workspace 

Â New File 

Â Open Project/Workspace 

Â Open File 

Â Save 

Â Save All 

Â Print 

Â Print Preview 

Â Cut 

Â Copy 

Â Paste 

Â Delete 

Â Undo 

Â Redo 
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Keyboard Shortcuts 

The following table lists many of the various keyboard shortcuts available in PSoC Creator. 

Location Command Shortcut 

File Menu Open [Ctrl] + [O] 

Close active file [Ctrl] + [F4] 

Save [Ctrl] + [S] 

Save All [Ctrl] + [Shift] + [s] 

Print [Ctrl] + [P] 

Edit Menu Undo [Ctrl] + [Z] 

Redo [Ctrl] + [Y] 

Cut [Ctrl] + [X] 

Copy [Ctrl] + [C] 

Paste [Ctrl] + [V] 

Delete [Del] 

Select All [Ctrl] + [A] 

Find [Ctrl] + [F] 

Replace [Ctrl] + [H] 

Find in Files [Ctrl] + [Shift] + [F] 

Replace in Files [Ctrl] + [Shift] + [H] 

Go To [Ctrl] + [G] 

Make Uppercase [Ctrl] + [Shift] + [U] 

Make Lowercase [Ctrl] + [U] 

View White Space [Ctrl] + [E], [S] 

Incremental Search [Ctrl] + [I] 

Comment Selection [Ctrl] + [E], [C] 

Uncomment Selection [Ctrl] + [E], [U] 

Toggle Bookmark [Ctrl] + [K], [Ctrl] + [K] 

Toggle All Outlining [Ctrl] + [M], [L] 

Toggle Outlining Expansion [Ctrl] + [M], [M] 

Start Automatic Outlining [Ctrl] + [M], [O] 

Stop Automatic Outlining [Ctrl] + [M], [P] 

View Menu Zoom in [Ctrl] + [+] 

Zoom out [Ctrl] + [ï] 
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Location Command Shortcut 

Debug Menu Breakpoints [Ctrl] + [D], [B] 

Output [Ctrl] + [D], [O] 

Watch 1 [Ctrl] + [D], [W] 

Watch 2 [Ctrl] + [Alt] + [W], [2] 

Watch 3 [Ctrl] + [Alt] + [W], [3] 

Watch 4 [Ctrl] + [Alt] + [W], [4] 

Locals [Ctrl] + [D], [L] 

Components [Ctrl] + [D], [P] 

Call Stack [Ctrl] + [D], [C] 

Memory 1 [Ctrl] + [D], [M] 

Memory 2 [Ctrl] + [Alt] + [M], [2] 

Memory 3 [Ctrl] + [Alt] + [M], [3] 

Memory 4 [Ctrl] + [Alt] + [M], [4] 

Disassembly [Ctrl] + [Alt], [D] 

Registers [Ctrl] + [D], [R] 

Program [Ctrl] + [F5] 

Execute Code (Debug) / Resume Execution [F5] 

Debug without Programming [Alt] + [F5] 

Halt Execution [Ctrl] + [Alt] + [Break] 

Stop Debugging [Shift] + [F5] 

Rebuild and Run [Ctrl] + [Shift] + [F5] 

Reset [Shift] + [Alt] + [F5] 

Step Into [F11] 

Step Over [F10] 

Step Out [Shift] + [F11] 

Toggle Breakpoint [F9] 

Address Breakpoint [Ctrl] + [D], [A] 

File Line Breakpoint [Ctrl] + [D], [F] 

Function Breakpoint [Ctrl] + [D], [U] 

Variable Watchpoint [Ctrl] + [D], [V] 

Memory Watchpoint [Ctrl] + [D], [E] 

Delete all breakpoints [Ctrl] + [Shift] + F9 
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Location Command Shortcut 

Build Menu Build All Projects [F6] 

Build Active Project [Shift] + [F6] 

Cancel Build [Ctrl] + [Break] 

Compile File [Ctrl] + [F6] 

Help Menu Help Topics [F1] 

Design Elements Palette Cancel current operation [Esc] 

Rectangle Tool [r] 

Ellipse Tool [e] 

Line Tool [l] 

Text Tool [t] 

Arc Tool [c] 

Image Tool [m] 

Wire Tool [w] 

Sheet Connector [s] 

Digital Input [i] 

Digital Output [o] 

Digital Inout [b] 

Analog Terminal [a] 

External Terminal [x] 

Sheet / Page Move item 1 grid unit or Scroll 1 grid unit [Up], [Down], [Left], or [Right] * 

Move selected shape 1 point [Shift] + [Up], [Down], [Left], or [Right] 

Move selected shapes off grid ** [Shift] + Left Click (hold) + Drag 

Disable/enable rubber-banding [Ctrl] + Left Click (hold) on one or more objects + 
Drag, or 

[Ctrl] + [Up], [Down], [Left], or [Right] 

Zoom to selection [Ctrl] + Left Click (hold) on white space + Drag 

Select multiple items [Ctrl] + Left Click (successive actions) 

Pan [Alt] + Left Click + Drag 

Scroll up / down Mouse Wheel Up / Down 

Zoom in / out [Ctrl] + Mouse Wheel Up / Down 

Scroll left / right [Shift] + Mouse Wheel Up / Down 

Large scroll up / down [Page Up] / [Page Down] 

Large scroll left / right [Shift] + [Page Up] / [Page Down] 
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Location Command Shortcut 

Navigation Switch between schematic pages. [Ctrl] + [F6]  (Use [Shift] for reverse direction.) 

Switch between open project files or open 
tabbed documents. 

[Ctrl] + [Tab]  (Use [Shift] for reverse direction.) 

Close a tabbed document. [Ctrl] + [w] 

Go back to previous cursor location in Code 
Editor. 

[Ctrl] + [-]  (Use [Shift] for reverse direction.) 

Code Editor Autocomplete [Ctrl] + [Space] 

Find References [Ctrl] + [Shift] + [R] 

Go To Declaration [F12] 

Go To Definition [Ctrl] + [F12] 

* If items are selected, using the arrow keys moves items 1 grid unit in the specified direction. If sheet/page is 
selected, using the arrow keys scrolls instead. 

** Components, wires, and other design-specific objects will always snap to grip. Other shapes not part of the 
actual design can be moved freely. 

See Also: 

Â File Menu 

Â Edit Menu 

Â Debugger Menu Commands 

Â Build Menu 

Â Design Elements Palette 

Â Customize Dialog 
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Dialogs 

Component Installer 

The Component Installer dialog is used to install new and updated Components from the Cypress web site. It 
shows all new Components and updated Component versions available online. You can use the pull-down menu to 
filter by device family/series, as well as a search box to further limit the Components displayed. 

 
 

To Open the Dialog: 

Select Find new Components from the Tools menu or click the Find new Components button  on the 
Component Catalog. 

If you have an open project, the default filter will be derived from the selected device of the active project. If there is 
no open project, the filter will default to "All." 

Use the Show only newer check box to limit the Components shown to only those newer than what you already 
have installed. 

To Select a Component: 

You can select one or more Components through the tri-state check box. 

If you select a Component, the description, image, and datasheet link are downloaded from the web content store 
and shown on the right hand side of dialog. 

To Install a Component: 

After selecting one or more Components, click the Install Checked Components button. 
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A download progress bar will display, indicating how many parcel files need to be downloaded in order to satisfy 
required dependencies. Parcel files will be on the order of 10 MB or less (e.g., BLE_v3_0 compresses to 8 MB), so 
the progress bar will simply reflect the number of parcel files downloaded. 

Â While the download/installation is in progress, the button will display as Cancel to cancel the process. 

Â When the download/installation is completed, the button will display as OK to close the dialog. 

Â If there were errors during the download process, they appear in the output window. 

See Also: 

Â Tools Menu 

Â Component Catalog 

Component Update 

The Component Update Tool dialog allows you to update versions of Components in your designs. 

 
 

Under the New Version column, bold items indicate Components that will have their version updated. By default, 
PSoC Creator selects the most current version of a Component (inlcuding online Components) to be updated. 

After a Component update operation has been completed, the tool generates a ComponentUpdateLog.txt file, 
which provides details of the update. This file is stored as in the corresponding project folder. 

To Open the Dialog: 

1. Open a PSoC Creator design project with one or more Components. 

2. Select Update Components from the Project menu. 

Notes 
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Ǐ If newer versions of Components are available (including online) in a design, an icon will be added to 
the status bar as follows: 

 

Click the icon to open the Component Update Tool dialog. 

Ǐ You can also right-click on the project in the Source tab of the Workspace Explorer and select Update 
Components. 

Component Version States: 

The Component Update Tool reports the state of various Component versions, under the Current Version and 
New Version columns. 

Â Obsolete ï An obsolete Component version should updated to a newer version. PSoC Creator will display a 
warning or error about this Component version in the Notice List Window. 

Â Prototype ï A pilot Component version is typically a working example only. It is not characterized and not 
regression tested. PSoC Creator will most often display a note about this Component version in the Notice List 
Window. In some cases, it will display a warning. 

Â Incompatible ï An incompatible Component version means that the selected Component and version is not 
compatible with the selected device for your design. PSoC Creator will display a warning or error about this 
Component version in the Notice List Window. 

Â Downloadable ï This version of the Component is available online. Selecting it will cause it to be downloaded 
and installed as a part of the update process. 

To View Datasheets: 

Click the Component link in the Name column at the top of each set of Component instances to display the latest 
version of the Component's datasheet. 
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To Update Components: 

The Components to be updated are selected automatically and shown in bold under the New Version column. 

 
 

1. As desired, pull down the menu under New Version for each Component and select the version you wish to 
use. You might use this to downgrade a Component to a previous version, for example. 

Note If desired, use the menu next to New Version to set all Components to the latest version (default) or to 
the current version. 

 
 

2. Click Next. 
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3. Review the information on the Review Pending Updates step. 

 
 

4. The Create workspace archive before updating check box will create an archive of your project. Leave 
selected or deselect to skip the archiving step. 

5. Click Finish to update the Component(s) or click Cancel to cancel. 

See Also: 

Â Component/Instance 

Â Workspace Explorer 

Â Notice List Window 

Â Environment Options 
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Customize 

The Customize dialog is used to display various toolbars, as well as customize which commands appear on 
toolbars. 

 

This dialog has three tabs: 

Â Toolbars 

Â Commands 

Â Keyboard ï This tab and its functionality should not be used. 

To Open this Dialog: 

Right-click in the PSoC Creator menu/toolbar area and select Customize. 

Toolbars Tab 

The Toolbars tab allows you to create, rename, remove, and reset toolbars. It displays the toolbars available and 
any toolbars you create. When a toolbar is displayed, a check mark appears to the left of it in this dialog box. 

Â New ï Displays the New Toolbar dialog box, which allows you to create and name a custom toolbar. 

Â Rename ï Displays the Rename Toolbar dialog box, which allows you to change the name of a custom toolbar 
only. 

Â Delete ï Deletes the custom toolbar selected in the Toolbars list. 

Â Reset ï Removes any changes to the predefined toolbar selected in the Toolbars list and resets it to its original 
state. Available only if you select a built-in toolbar. 

Note You can only delete and rename toolbars that you created. 

Commands Tab 

The Commands tab allows you to add and remove commands on toolbars and menus. 

Â Categories ï Specifies the set of commands that are displayed in the Commands list box. The categories of 
commands are based on menu titles provided by the tools and designers that the environment is currently 
supporting. This list of titles is dynamic so that the order of categories and the menu titles change, depending 
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on the tools and the designer, as well as any customizations made to them. Therefore, it is possible for two 
menus from different designers to have the same name, so the same title can appear twice but offer different 
command sets. 

Â Commands ï Displays the commands and command images based on the category you selected. You can 
drag a command onto the toolbar you want to customize. 

Â Modify Selection ï Displays a list of commands you can use to customize the display of the button on the 
toolbar. For example, you can change the image or accelerator keys, as well as specify whether to display text 
instead of an image for the command. This button is available after you select a command button on a toolbar 
you want to customize. 

See Also: 

Â Framework Description 

Â Standard Toolbar 

Dependencies 

The Dependencies dialog is used to show and select one or more user-level project dependency. The order of the 
dependencies determines the order that PSoC Creator will use to search for Components and code.   

 
 

To Open the Dialog: 

Select Dependencies... from the Project menu. 

Projects: 

This pull down allows you to select the project for which you want to include a dependency. This only applies if 
there are multiple projects in your workspace. 
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System Dependencies: 

This area shows the system-level dependencies for your project. 

For each dependency there are two check boxes: Components and Code. Components determines whether 
PSoC Creator searches the project for Components to include in the Component Catalog. Code determines 
whether a C static library is linked in to the project. 

User Dependencies: 

This area is where you can add/remove other dependencies to your project. It contains four buttons: Add, Remove, 
Move Up and Move Down. This section also contains Components and Code check boxes described under 
System Dependencies. 

Note If there were any default dependencies added to the Project Management Options dialog under Default 
Dependencies, those dependencies will be shown in this area for projects created after the dependencies were 
added. 

Subdependencies: 

If you have multiple projects in your workspace, there are cases where one or more projects use Components 
defined in another project in the same workspace. In this case, if you select the Components check box next to the 
project where the Component is defined, the Subdependencies dialog will display. 

 
 

Project dependencies are a list. For example, suppose a workspace has "Project A" that depends solely on "Project 
B" that depends solely on "Project C."  

Â Project A will not use Components or code from Project C, unless Project A has its own direct dependency on 
Project C. 

Â If modifying dependencies for Project A, selecting Subdependencies for Project B would show Project C. 

Â If adding a new dependency for Project A, the Subdependencies dialog makes it easy to add any other 
dependencies that may be necessary. 

Â If you do not add Project B Subdependencies for Project A may cause DRC errors or link errors in Project A.  

Build Order Tab: 

The Build Order tab is a read-only list of the order in which your projects will build. 
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See Also: 

Â Basic Hierarchical Design 

Â Project Management Options 

 

Device Selector 

Use the Device Selector dialog to choose which device to use in your design. 

 
 

The dialog provides a list of available devices, as well as various characteristics for each device. Using the dialog, 
you can: 

Â change the selection at any time during the design process 

Â customize how/what data is displayed for the devices 

Â filter which columns should be displayed/hidden 

  

Notes 

Â The title bar of the dialog displays the name of the project that the device is being set for and the name of the 
currently selected device. 

Â The Device Selector layout is saved on a per project basis. When you re-open the Device Selector for a 
particular project it will retain all the information from the previous session. 
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Â The Device Selector allows for targeting a project to a specific Silicon Revision. This will cause changes in the 
generated code such that it can only be programmed on a target device that has a matching Silicon Revision. 

To Open the Dialog: 

Select the design project for which you want to change the selected device in the Workspace Explorer and do one 
of the following: 

Â Select Project > Device Selectoré, or 

Â Right-click on the project and select Device Selectoré 

Note You can also open the Device Selector from the New Project dialog Device pull down menu when creating a 
new design project. The major difference is that when opening the Device Selector for a new design, none of Auto-
Select features are applicable and you will only see devices for the project type you have selected. 

To Select a Device: 

To select a device, do one of the following: 

Â Double-click a device row in the device table, or 

Â Click a device row and click OK. 

To quickly select the default device for a specific architecture, right-click anywhere in the device selector table area 
and select Select Default Device. Then pick your desired architecture. 

To Sort a Device Category: 

You can sort by any column in ascending or descending order by clicking on the header for that column. Clicking 
again will toggle the sort direction. When a column has a sort applied to it, an arrow will be displayed under the text 
in the column header. 

By default, the part number column in the device selector has the sort applied to it. To re-sort on the part number, 
right-click anywhere in the device selector table area, select Sort by Part Number, and pick your desired sort 
direction. This menu also provides a way to automatically scroll to whatever device is currently selected. 

To View Device Datasheet: 

Click View Datasheet.  

This opens a web page to the selected device's datasheet. 

To Show/Hide Columns: 

Click Hide/Show Columns. 
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This is used to hide/show in the device table. This opens Display Columns dialog that lists all the available columns. 

 
 

You can then select/unselect columns to alter what is displayed in the device table. 

Note These changes are made live as you change the state of the check boxes. Columns that have filters applied 
cannot be hidden. They are disabled in the dialog and are followed by the text ñ- Filteredò so you know why they 
cannot be hidden. 

Status information displays above the device table, showing how many columns are hidden. If no columns are 
hidden, no status information is provided. 

To Filter the Device Table: 

Each column in the Device Selector has a drop-down button used for filtering on the column. When pressed, a 
drop-down window displays a list of check boxes, one for each of the different values possible in that column. You 
can unselect as many of the values as desired, removing devices with those values from the set of displayed 
devices. These changes are not applied to the device table until you click off the window or press the [Enter] key 
(pressing [Esc] will close the window without applying any of the changes). By default all values are checked 
meaning that no filtering has been done. 

When filtering has been applied on a column, the column header (and the accent color on the button) changes to 
make it very obvious which columns have filters applied. The button also displays the value that has been left ñonò. 
If more than one value has been left ñon,ò only the first value will be displayed on the button. The value will be 
followed by ñéò indicating that more values are being displayed. In this case hovering the mouse over the button 
will produce a tool tip that displays all the values that are currently ñonò. 

There is a status bar just below the device table that shows how many devices are currently being displayed (i.e. 
how many devices passed all the filters) versus how many devices exist. There is also a link here that clears all the 
filters from the table making all the devices visible again. 

To Reset to Defaults: 

Click Reset to Defaults. 

This resets all the settings back to their defaults (removes filters, re-orders columns, resets which columns are 
displayed, etc.). 
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See Also: 

Â Workspace Explorer 

Â Creating a New Project 

Device Update Installer 

The Device Update Installer dialog is used to download and install new device support available on the Cypress 
web page. 

To Open the Dialog: 

Select Find new Devices from the Tools menu. 

If no new device support is available, a "No new devices are available." message displays. 

 
 

If new device support is available, the following dialog will display. 

 
 

To Install/Download a Device: 

Select one or more devices and click the Install button. 

Once the download is completed, click OK to close the dialog. 
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A pop up message will display to indicate that PSoC Creator needs to restart. 

 
 

Click Yes to restart; click No to cancel the installation. 

Enumeration Types 

The Enumeration Types dialog allows you to create and edit enumerations (or user-defined types) for your 
Components. This dialog is used in conjunction with defining parameters for a Component. The process of creating 
Components can be complex. This topic is provided as a help if you press [F1] for this dialog. For more in depth 
discussion regarding creating Components, refer to the Component Author Guide. 
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A Component can contain multiple types but each type name must be unique and each key in the types must be 
unique across all other types in that Component. The types defined for each Component in a given project are 
aggregated on the project (the project type cache) and the project type caches from all projects on a design's 
search path are aggregated into a design type cache. 

Â Internal to the symbol, the type and the type keys are accessible by their "short name." 

Â Outside of the symbol, the type and keys are identified using the "long name," which is the Component name 
followed by the actual type or key name (using "__" to separate the two). 

When evaluating a type or key for an expression, the evaluation system first looks in the enclosing symbol for the 
identifier. If it is not found there, the system queries the design type cache. If the design type cache does not 
recognize the identifier, it is reported as an unknown identifier. 

To Open the Dialog: 

Click the Types... button on the Parameters Definition dialog. 

To Add an Enumeration Type: 

1. Enter a name at the bottom of the 'Enum Set' table (where it says 'Enter type nameé'). 

2. In the Enum Item table, click in the empty row under Enum Item Name and type a name for the 1st name/value 
pair of the enumerated type; type a value under Value or accept the default. 

3. Optionally, enter a string in Display Name that will display in the Component's Configure dialog pull down 
menu for that parameter. 

4. Enter as many enum sets as needed and click OK to close the Enumeration Types dialog.. 

To Delete an Enumeration Type: 

Click Delete   next to the item to delete. 

See Also: 

Â Symbol Editor 

Â Parameters Definition dialog 

Â Component Author Guide 
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Family Migration Information 

The Family Migration Information dialog displays when you try to change a project from one device family to 
another family and vice versa. The dialog warns you that the device change being made is likely to require manual 
edits to the design, or that the migration is not supported. 

Note This dialog text will change depending the devices involved. Here are a couple examples. 

 
 

 
 

To Open this Dialog: 

This dialog opens when you try to change your project to or from a PSoC 4 device using the Device Selector. 

To Use this Dialog: 

Click OK to close the dialog and proceed with changing the device. 

Click Cancel to close the dialog and leave the project device unchanged. 
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See Also: 

Â Device Selector 

Â Options Dialog 

Find Code Example 

The Find Code Example dialog allows you to search for and open code examples installed on disk with PSoC 
Creator, as well as download and install code examples from the Cypress web site. Code examples show how 
various Components can be configured, and they include sample code to provide a better understanding of how a 
Component can be used. 

 
 

Most code examples have a description document that provides setup and configuration information. This 
document is displayed under the Documentation tab when you select a project from the list. Also available is 
example code located under the Sample Code tab. 

Code examples shown in the list will have different indicators, as follows: 

Â Install ï These are code examples that are online only and need to be installed before they can be used. 

Â Update ï These are code examples that have newer versions online than the code example already installed 
on disk. 

Â None ï These are code examples installed on disk with no updates available. 

To Open the Find Code Example Dialog: 

All Examples 

To open the dialog with all code examples available, select Find Code Example... on the Start page, or select 
Code Example... under the File menu. 
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Component-Specific Examples 

To open the dialog with a list of code examples associated with a corresponding Component, right-click on a 
Component in the Component Catalog or on the design canvas, and select Find Code Example...  

To Install/Update a Code Example: 

Click the Install or Update button, as appropriate. 

A download progress dialog displays. When completed, click OK to close the download progress dialog. This will 
also update the status of applicable code examples in the Find Code Example dialog. 

Also, if a new/updated code example includes new or updated versions of Components than those already installed 
on disk, then the new Components and Component versions will also be installed. 

To Select a Code Example: 

1. As needed, choose filters under Device Family or Filter by to narrow the list of available projects. 

Ǐ Select the Device Family for the project. For example, All, PSoC 3, PSoC 4000, PSoC 4200 BLE, 
PSoC 5LP, etc. 

Ǐ If desired, also select a keyword from the Filter by pull-down menu or type the project name or other 
words. This could be the name of a Component or different keywords used by code example 
developers to distinguish projects. 

2. Select a project or workspace from the list matching the given filtering criteria. 

Note It is possible that multiple projects will be contained in an example workspace. If any of the projects in a 
workspace matches the filtering criteria, the workspace and all of its projects will be shown. 

3. View the documentation and/or code for the project by clicking the appropriate tab, if desired. 

4. Click either Create Project or Create Workspace, as appropriate. The New Project wizard opens to complete 
the project/workspace creation process. 

Note If an online only code example has not been installed, an error message will display indicating that you 
must install it before it can be created. If a code example update has not been installed, the previously installed 
version of the code example  

See Also: 

Â Creating a New Project 

Â Workspace/Project 

Â Component/Instance 
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Generate Verilog 

The Generate Verilog dialog allows you to choose the architecture, family, and/or device for the Verilog file being 
generated for your Component symbol. This dialog is used as part of creating a Component. For more in depth 
discussion regarding creating Components, refer to the Component Author Guide. 

 
 

To Open this Dialog: 

This dialog opens automatically when you select the Generate Verilog command from the Symbol canvas context 
menu. 

To Choose Architecture/Family/Device: 

The Target options may be used to specify a particular architecture, family, and/or device to which the Verilog file 
applies. 

Â Leave the default setting Generic Device selected to allow the Verilog file to apply to all devices. Deselect the 
check box to enable the Family, Series, and Device pull down menus. 

Â Choose a Family to create the Verilog file in a subfolder for a family. 

Â Choose a device Series to create the Verilog file in a subfolder for a series of devices. 

Â Choose a specific Device part number to create the Verilog file in a subfolder for a specific device. 

See Also: 

Â Component Author Guide 

Â Symbol Editor Context Menus 

Â Adding a Component Item 
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Import Component 

The Import Component dialog is used to import a Component from another project. It is also used to import one or 
more Components from a Component archive file. 

 
 

Note Imported Components retain all of the symbol and Component properties of the original Component. This 
includes Component Catalog Placement. If there are duplicate Components from different Dependencies in your 
project, the Component Catalog will display the Component from the dependency with the highest precedence. 

The dialog has the following options: 

Â Import from project/library ï Used to choose the project/library that contains the Component to import. 

Â Source Component ï When importing from a project/library, this option is used to specify which Component 
from the project/library to import. 

Â Import from archive ï Used to select the Component archive that contains the Component(s) to import. For 
more information, see Exporting a Component. All Components in the archive file will be imported. 

Â Target Project ï Used to select the specific project for which the Component will be imported. 

To Open this Dialog: 

1. Select the Components tab in the Workspace Explorer. 

2. Right-click on a project and select Import Component. 

To Import a Component: 

1. Select either Import from project/library or Import from archive. 

Ǐ If you selected Import from project/library, select the project that contains the Component to import. 
If necessary, click the browse button [...] and navigate to the folder containing the Component to import. 
In Source Component, select the Component to import from the project/library. 

Ǐ If you selected Import from archive, select the appropriate Component archive (.cycomp file). If 
necessary, click the browse button [...] and navigate to the folder containing the Component archive. 

2. In Target Project, select the project where the Component will be placed. 

3. Click OK. 

PSoC Creator adds the imported Component(s) to the selected project. 
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See Also: 

Â Dependencies 

Â Component Catalog 

Â Defining Catalog Placement 

Â Exporting a Component 

Â Workspace Explorer 

Merge Dialog 

The Merge dialog displays when you try to enable a Disabled Schematic page and there are one or more 
Component and/or wire instances that have the same name. 

 
 

To use the dialog: 

Select the instance in the New Name field, type a different name for the instance, and click OK. 

Note Component instances must be renamed in order to resolve the name conflict. Some wire and signal instances 
do not have to be renamed.  The OK button will not be enabled until all mandatory conflicts have been resolved. 

See Also: 

Using Disabled Schematic Pages 
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Modified Files 

The Modified Files dialog allows you to selectively save files when closing a project or workspace. 

 
 

This dialog displays automatically if you attempt to close a file or workspace/project that needs to be saved. 

To Use this Dialog: 

Â Click Yes to save the selected files. 

Â Click No to save none of the files. 

Â Click Cancel to close the dialog and leave the files open. 
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Notice Details 

The Notice Details dialog displays expanded information for messages in the Notice List window. The Notice Details 
dialog will display the entire message, as well as additional information if available. 

 
 

To Open this Dialog: 

On the Notice List window, click the   button next to the message or click the View Details button. 

There is also a command available to view details if you right-click on a notice. 

See Also: 

Â Notice List Window 
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Obsolete Device 

The Obsolete Device dialog displays when you open a project with a device that is no longer in the Cypress device 
catalog. This dialog suggests the next best alternative for your device, and provides a link to the suggested device 
datasheet for more information. 

 
 

This dialog provides you with three options: 

Â Click OK to open your project with the suggested device. 

Â Click choose another replacement to open the Device Selector and choose a different device. 

Â Click Cancel to open the Workspace with the project unloaded. 

 
 

Note The project will also be unloaded if you close the Device Selector without selecting a device. 

If you reload the unloaded project, PSoC Creator will select the default device for your project. You can use the 
Device Selector to change it, if needed. 

See Also: 

Â Device Selector 

Â Opening an Existing Project 
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Options Dialog 

The Options dialog allows you to specify various settings for PSoC Creator, such as where projects are stored or 
the color of wires. 

 
 

The dialog is divided into the following categories: 

Â Project Management (this topic) 

Â Design Entry 

Â Language Support 

Â Text Editor 

Â Program/Debug 

Â Environment 

To Open the Options Dialog: 

Select Options from the Tools menu. 

To Restore Defaults: 

Click Restore Defaults. 

All options revert to the default configuration. 

Project Management Options: 

The Project Management category of the Options dialog is used to set various options for project management. 

This category includes the following sections: 
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General: 

The General area contains various project management options. 

Â Projects location ï Used to specify the default location to save your projects. 

Â My Template projects location ï Used to specify the default location to save your My Template projects.  

Â PDL v2 (FM0+ devices) location ï Used to specify the default location where projects will look for the 
Peripheral Driver Library (PDL) version 2, for FM0+ devices. You can also specify a custom PDL path per 
project on the Peripheral Driver Library Build Settings dialog. 

Â PDL v3 (PSoC 6 devices) location ï Used to specify the default location where projects will look for the PDL 
version 3 for PSoC 6 devices. You can also specify a custom PDL path per project on the Peripheral Driver 
Library Build Settings dialog. 

Â Always show the Error List window if a build has errors ï yes (default) or no. 

Â Always display the workspace in the Workspace Explorer ï yes (default) or no. 

Â Display the Output window when a build starts ï yes (default) or no. 

Â Reload open documents when a workspace is opened ï yes (default) or no. 

Â Reload the last workspace on startup ï yes or no (default). 

Â Auto-Backup Designs ï yes (default) or no. If this option is selected, when you open designs created with 
previous versions of PSoC Creator, the older designs will be backed up to an archive (located in [Workspace 
Folder]/Backup). This backup ñcopyò will contain the version of the tool that was last used to save it (that is, the 
older version it can be opened with) in the file name. 

Â Don't show Keil registration ... ï yes or no (default). If selected, the Keil Compiler Registration dialog will not 
display every time you start PSoC Creator. 
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8051 Toolchains: 

This section is used to set the default 8051 toolchain. 

 
 

This option also allows you to specify paths to the binaries for each specific toolchain. 

Â DP8051 Keil Generic ï The default install location is C:\Keil\C51\BIN\ 

Example files that should be in the selected folder: A51.EXE, C51.EXE 
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ARM Toolchains: 

This section is used to set the default ARM toolchain. 

 
 

This option also allows you to specify paths to the binaries for each specific toolchain. 

Â ARM GCC Generic ï There is no default install location. It can be in whatever folder you extract the files. 

Example files that should be in the selected folder: arm-none-eabi-addr2line.exe, arm-none-eabi.ar.exe 

Â ARM MDK Generic ï The default install location is C:\Keil\ARM\BIN40\ 

Example files that should be in the selected folder: armar.exe, armasm.exe 

Note Some toolchains require environment variables to find its bin, include, and library paths. These variables are 
set by the toolchain installer. You may have to restart PSoC Creator in order to use the new environment variables. 

Default Dependencies: 

This option allows you to specify default libraries that appear as user dependencies on the Dependencies dialog for 
all newly created projects. Default dependencies apply to all new projects on a per user basis, so they will be the 
included for all your new projects. 

Note Projects created with PSoC Creator 1.0 and initially opened in the current version of PSoC Creator will be 
updated to include all default dependencies defined at that time. Existing projects for the current version of PSoC 
Creator will not be updated to include any default dependencies added in the future. 

This area contains four buttons: Add, Remove, Move Up and Move Down. For each dependency there are two 
check boxes: Components and Code to specify whether or not there is a dependency on the search path, code, 
both, or neither. 

See Also: 

Â Keil Compiler 
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Â Dependencies 

Â Toolchain Documentation 

 

Design Entry Options 

The Design Entry category of the Options dialog is used to set various options for the design entry tools. 

 
 

This category includes the following sections: 

General: 

The General section contains numerous fields to specify preferences for colors, widths, sizes, and fonts for most of 
the objects in the design entry tools. This section is divided as follows: 

Â Page ï settings for the display of the canvas, including grid type and color. 

Â Terminal ï settings for terminals including colors and fonts. 

Â Text ï settings for labels including whether to display expressions and the color or owner lines. 

Â Wire ï settings for wires including colors, widths, and fonts. There is also a setting for rubber-banding. When 
this option is turned on, wires will automatically be redrawn when you move objects. If rubber-banding is turned 
off, wires will not be redrawn and connections will be broken. Press the [Ctrl] key while moving objects to 
temporarily disable or enable rubber-banding, respectively. 

Sheet Templates: 

This section allows you to specify locations where PSoC Creator will look for sheet template files to be used with 
design entry tools. See Sheet Template Editor for information about creating sheet templates. 

Use the Add button to add more paths to locations for sheet templates; use the Remove button to remove paths. 
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Component Catalog: 

This section contains Component options: 

Â Show Hidden Components ï Selecting this check box displays all the hidden Components in the Component 
Catalog, including primitives. Primitives are basic Components that are used as building blocks in the typical 
Components found in the catalog. 

Â Enable Param Edit Views ï Selecting this check box allows you to view the Expression View in each 
Component's Configure dialog by right-clicking on the different tabs in that dialog. 

Warning Switching to the Expression View is an advanced feature. It requires a thorough knowledge of the 
valid parameter settings for the Component. Using this view makes it possible to create combinations of 
parameters that are not valid. Therefore, you may need to cancel any changes and restart the process if you 
cannot find valid parameters. 

Â Remember Dialog Sizes ï Selecting this check box makes it so that Componentsô Configure dialogs will 
save/restore their size on a per Component basis. Unchecking this box will cause the dialogs to open as their 
default size instead. 

Note If the saved size is larger than the current screen, the size will be adjusted to fit the screen. 

Â Reset Sizes ï Clicking this button will cause all the currently saved dialog sizes to be reset to the default size 
for their Components. This operation cannot be undone. 

Component Security: 

Allows you to add and remove paths to allowed third party customizers that can be used within PSoC Creator. 
PSoC Creator will generate errors for third party customizers not included in this section. When you try to open an 
external project, PSoC Creator displays the following: 

ñProject XXX contains Components that include special code that runs on your machine. Do you trust the 
source of the project and wish to use the projects Components.ò 

If you select Yes, then the path of the project is added to the relevant setting. After this, whenever you open this 
particular project, no messages will be shown and the project will load and build normally. 

If you select No, then the project will load with an error: 

ñComponent YYY is not available. Component Security is disabled for the project XXX. If you trust the author of 
the project and wish to allow this Component to run code on your computer during the design process, select 
Tools > Options > Design Entry > Component Security and add the project folder to the approved list.ò 

After this, whenever you open this project it will show this error until you add the path. 

See Also: 

Â Options Dialog 

Â Using Design Entry Tools 

Â Sheet Template Editor 

Â Component Catalog 

Â Configure dialog 
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Language Support Options 

The Language Support section of the Options dialog contains settings for using an installed datasheet language 
pack. 

 
 

General Options: 

The following options are available under the General (default) section: 

Datasheet Language 

Specify whether to Use Locale or to Force Language. If a datasheet language pack is installed, the Force 
Language option will enable a pull-down menu with different languages to select. 

When opening a datasheet, if the specific language and version is not available, the Select Datasheet dialog will 
display to select an appropriate datasheet. 

See Also: 

Â Options Dialog 

Â Select Datasheet 
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Text Editor Options 

The Text Editor category of the Options dialog is used to set various options for the code editor. 

 
 

This category includes the following sections: 

Â General 

Â Inline Diagonstics and Autocomplete 

Â Fonts and Colors 

Â Find and Replace 

General: 

This section provides options to change various editor behaviors. 

Lines/Columns 

Â Show Line Numbers ï This check box allows you to control whether or not to display the line numbers. 

Â Highlight Current Line ï This check box allows you to enable and disable the current line indicator, which 
shades the current line. 

Â Enable Column Guide ï This check box allows you to enable the column length guide. If enabled, you can 
specify the column length in characters. 

Line Modification Colors 

These options allow you to change the color shown in the margins for Saved Changes and Unsaved Changes. 

Click the colored box to display the Color selection dialog. 

Tab size 
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The Tab Size field allows you to specify the tab length in characters. 

Â If you enable the Soft Tabs feature and then press the [Tab] key, the text editor uses the specified number of 
spaces instead of a tab key stroke. 

Note Turning the Soft Tabs feature on or off does not affect previously inserted tabs. 

  

Inline Diagnostics and Autocomplete: 

This section provides options to change settings for inline diagnostics and autocomplete: 

 
 

Enable semantic parsing 

This controls whether the advanced editor features such as autocomplete, inline diagnostics, Go To definition, and 
the code explorer tool window are enabled. 

Â Enable inline diagnostics ï If the Enable semantic parsing check box is selected, this check box is enabled 
to turn on and off the inline diagnostic feature. 

Â Enable autocomplete ï If the Enable semantic parsing check box above is selected, this check box is 
enabled to turn on and off the Autocomplete feature. 

Ǐ Show completion results automatically ï If the Enable autocomplete check box is selected, this 
check box is enabled to show the completion results. If checked, items will be shown; otherwise, they 
will won't. 

Ǐ Sort alphabetically ï If the Enable autocomplete check box is selected, this check box is enabled to 
turn on and off the sorting mechanism for autocomplete. If checked, items will be arranged 
alphabetically; otherwise, they will be arranged in order of anticipated value. 

Ǐ Filter unmatched items ï This option causes non-matching strings to be removed from the popup. It 
causes the set of choices to be reduced as you types. By default, this option is enabled. 
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Ǐ If the Filter unmatched items check box is enabled, the Match text anywhere in completion check 
box becomes available to all the search to return matches in the middle of strings; not just from the 
beginning. For example, the string ñPWMò will return matches for ñPWM_1ò and ñMyPWMò. By default, 
this option is enabled when the Filter unmatched items check box is enabled. 

Ǐ Macro Filtering ï This option is used to specify that Macros (#define) can be omitted from the popup 
list with the following options: 

- Show all (can be slow)  

- Show all (except system defines) (default) 

- Show macro-functions only  

- Show none  

Note These options apply a filter to what macros are included in the auto-complete window for the All 
and Macros only displays. You can still toggle between All, Macros only, and Non-macros by pressing 
[Ctrl] + [Space]. 

  

Ǐ Tab behavior ï This option is used to allow how the [Tab] key is used while the popup is displayed, as 
follows: 

- Accept autocomplete (default)  

- Close autocomplete window  

- Perform UNIX-style Tab-completion (The [Tab] key adds as many characters as possible to the 
word being typed such that the result is still a match for the set of matches prior to the 
completion.) 

Ǐ Minimum characters required for popup ï This option is used to specify how many characters to 
type before the autocomplete popup displays. The valid range is 1-10. The default value is 1.  

Note When the popup is already open this option is ignored. 
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Fonts and Colors: 

This section provides options to change the various fonts and colors: 

 
 

Â Show settings for ï Pull-down to select options for different types of files to use in the editor. 

Â Use defaults ï This will restore the settings for the currently selected file type back to their original values 
provided by PSoC Creator. 

Â Font ï Pull-down to select a font type for the selected Display items. 

Â Size ï Pull-down to select a font size for the selected Display items. 

Â Display items ï List to select the various items in the editor that can be changed. 

Â Font style ï Pull-down to select different styles for the font: bold, italic, strikeout, and underline. 

Â Item foreground/background ï Pull-downs to select colors for the selected Display items and background. 

Ǐ Custom ï Buttons to open custom color chooser. 

  

Find and Replace: 

Â Display informational messages ï Selecting this check box will display informational messages related to 
Find & Replace in PSoC Creator. 

Â Automatically populate Find What ... ï Selecting this check box populates the Find What field with the 
highlighted word(s) in the Text Editor. 

See Also: 

Â Options Dialog 
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Â Code Editor 

Â Find Replace 

Program/Debug Options 

The Program/Debug section of the Options dialog contains various options for configuring the device, debugger, 
MiniProg3, and kits. 

 
 

General: 

Under the General category, you can configure the following: 

Â Evaluate ï Text box to specify the number of children retrieved at a time in the variable view. 

Â Default Radix ï Pull down menu to specify the default Radix display in various windows. 

Â On Run/Reset, run to ï Radio option to select the "run to" point: Reset Vector, Main, or First Breakpoint. 

Â Ask before deleting all breakpoints ï Check box to indicate if PSoC Creator will ask you before deleting 
breakpoints. 

Â Require source files to exactly match the original version ï Check box to indicate if source files should 
match the original version. This option will allow you to edit code while debugging. 

Note Changes will not take affect until after you recompile. 

Â Disable Clear-On-Read ï Allows the debugger to read the CLR registers without actually causing the data to 
be cleared. This applies to PSoC 3 and PSoC 5LP devices only. 

Â Mask interrupts when stepping on ARM devices ï This option masks interrupts from triggering while 
stepping though code in the debugger. This prevents the debugger from unexpectedly stepping into interrupt 
handler code. This applies to all devices except PSoC 3. 



Understanding PSoC Creator 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 146 

Â Automatically reset device after programming ï After programming, automatically does a reset to cause 
new program to execute. 

Â Automatically show disassembly if no source ï Automatically opens the disassembly window if no source 
code is found for current debug line. 

Â Allow debugging even if build failed ï If the build failed, but the output from a previous build still exists, 
provide a dialog box to allow starting the debugger with the old build. 

Note When debugging an old build, the code being debugged may not match the source code in the editor. 

Fonts and Colors: 

Under the Fonts and Colors category, you can adjust the font type and size, as well as various colors and 
properties on the different debugger windows available in PSoC Creator. 

Â Choose the window or control in the Show settings for pull-down menu. Click Use Defaults to reset the 
settings to the default. 

Â Choose the Font type.  (Bold font items indicate they are fixed-width fonts.) 

Â Choose the font Size. 

Â Under Display items, choose an item to change and either select a color from the Item foreground or Item 
background pull-down menus, or click the associated Custom... button to create a custom color. 

Â Choose the Font Style to change the text format to bold, italic, strikeout, and/or underline, if applicable. 

Device Recognition: 

Device Recognition is used to configure PSoC Creator to recognize 3rd party devices. This is done so that the 
Select Debug Target dialog can list correct information about devices that are attached to a computer. 

Note that while this configuration allows PSoC Creator to recognize 3rd party devices, these devices cannot be 
selected for debugging. One use of Device Configuration is to configure the size of the Instruction Register and 
Data Register for 3rd party devices attached in a JTAG chain. 

Note that Device Configuration can be accessed in two ways: from the Options dialog and from the Select Debug 
Target dialog by right-clicking on a node. 

Port Configuration: 

This section is used to configure the appropriate port. 

MiniProg3: 

Â Active Protocol ï Selects the protocol used to communicate with the target device. 

Â Clock Speed ï Selects the frequency at which the MiniProg3 attempts to communicate with the target device. 
The selected speed should be no more then 1/3 of the Bus Clock speed of the target device. Additionally, while 
slower speeds are possible for debugging, the speed should be at least 1 MHz to program the device. 6 MHz is 
the highest recommended clock speed for PSoC devices. 

Â Power ï Specifies the amount of voltage that the MiniProg3 will provide to the target device or whether power 
is from an external source. 

Â Acquire Mode ï Selects the mechanism used to reset the device so that debugging is possible. 

Â Connector ï Selects which connector on the MiniProg3 to use for sending data. 
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FX2LP-SWD (First Touch Kit 3 / First Touch Kit 5 / DVK3 / DVK5): 

Â Active Protocol ï Displays the protocol used to communicate with the target device. 

Â Power ï Specifies the amount of voltage that the MiniProg3 will provide to the target device or whether power 
is from an external source. 

Â Acquire Mode ï Selects the mechanism used to reset the device so that debugging is possible. 

Touch Tuning Bridge: 

Â Active Protocol ï Displays the protocol used to communicate with the target device. 

Â Power ï Specifies the whether the voltage is from an internal or external source. 

Â Acquire Mode ï Selects the mechanism used to reset the device so that debugging is possible. 

DVKProg1: 

Â Power ï Specifies the whether the voltage is from an internal or external source. 

Â Acquire Mode ï Selects the mechanism used to reset the device so that debugging is possible. 

KitProg: 

Â Power ï Shows the options available on the board for selecting power. Not configurable. 

Â Acquire Mode ï Shows the acquire mode supported by the board. Not configurable. 

KitProg2: 

Â Power ï Specifies the amount of voltage is supplied to the target device or whether power is provided from 
another source. 

Â Acquire Mode ï Shows the acquire mode supported by the board. Not configurable. 

CMSIS-DAP: 

Â Power ï Shows the options available on the board for selecting power. Not configurable. 

Â Acquire Mode ï Shows the acquire mode supported by the board. Not configurable. 

Â Max Clock Speed ï Shows the speed at which communication happens. Not configurable. 

See Also: 

Â Options Dialog 

Â Using the Debugger 

Â Select Debug Target 

Â Device Configuration 

Â Debugger Windows 
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Environment Options 

The Environment section of the Options dialog contains several settings to specify how things display in PSoC 
Creator. 

 
 

General Environment Options: 

The following environment options are available under the General (default) section: 

Detect when files are changed outside this environment 

This check box specifies whether PSoC Creator will detect changes made outside of PSoC Creator. If checked, you 
can also specify whether to Auto-load changes, if saved. 

Show Start Page at Startup 

This check box allows you show or hide the Start page at startup. If you do not show the Start page at startup, you 
can open it from the View menu. 

Select Editor Tab on Right-Click 

If this check box is selected, the mouse right-click action on a document window tab selects that document for 
display in addition to displaying a menu. If this check box is not selected, the right-click action only displays a menu. 

Number of Recent Files 

This text box allows you to specify the number of files shown under the Recent Files and Recent Projects items 
under the File menu, as well as projects shown on the Start page. 

External File Extensions 

Use this field to enter file extensions which will open with other applications instead of PSoC Creator. Separate the 
extensions using commas. 



Understanding PSoC Creator 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 149 

See Also: 

Â Options Dialog 

Â File Menu 

Â View Menu 

Â Component Update 

Â Window Types 

  

Print Preview 

The Print Preview dialog allows you to preview a document before printing it. 

 
 

The types of PSoC Creator documents you can preview include: schematics, symbols, source code files, and some 
design-wide resources files. 

To Open the Print Preview Dialog: 

Click the File menu and select Print Preview. 

To Use the Print Preview Dialog: 

Â Click Print to print the document. 

Â Use the Zoom pull-down menu to view the preview at difference sizes. 

Â For files with multiple pages, use the various page view options. Use the Page box to jump to a specific one 
page view. 

Â Click Close to close the Print Preview dialog. 
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Properties 

The Properties dialog provides information about selected items in other windows, such as the Workspace Explorer, 
Schematic Editor, Symbol Editor, and so on. 

 
 

In many cases, you can change different values - or properties - of the selected items. In addition to project-level 
properties, each file in a project has properties. These properties allow you to set various options at a file level. 

Depending on how you opened this dialog, it may contain different categories of properties, such as: 

Â General ï file type, path, name 

Â Document ï create date, current user 

Â Schematic ï page count, title 

Â Symbol ï catalog placement, summary 

Â Build filters ï Configurations, Cores, Processors, Toolchains  

To Open the Dialog: 

Right-click on an item in PSoC Creator (for example, design canvas or file), and select Properties. 

See Also: 

Â Working with Text 

Â Defining Catalog Placement 

Â Assigning a Core in a Multi-Core Design 
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Reloading Files 

If you work on PSoC Creator files outside the application, PSoC Creator -- when it regains focus -- will check if any 
files that are open have been changed on disk. If any files have changed, PSoC Creator will display two possible 
prompts, asking which of the files should be reloaded. If both types of documents exist, both prompts will be 
displayed. 

To stop PSoC Creator from attempting to reload files that have been modified outside of the application you can 
uncheck the Detect when files are changed outside this environment option in Environment Options. 

Reloading Modified Files: 

If the files requiring reloading have unsaved changes made from within PSoC Creator, the Reload Modified Files 
dialog will be displayed. 

 
 

Any modified files that are reloaded will cause all unsaved changes to be lost. 

Â Check All ï This option checks all the files specifying that they should all be reloaded. 

Â Uncheck All ï This option unchecks all the files specifying that none of the files should be reloaded. 
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Reloading Unmodified Files: 

If the files requiring reloading have no unsaved changes made from within PSoC Creator, the Reload Files dialog 
will be displayed. 

 
 

From this dialog, the option to automatically reload unmodified files without prompting first can be set. If set to true 
this dialog will no long be displayed. 

Note The option can be also changed from the Environment Option: Auto load changes, if saved. 

See Also: 

Â Modified Files 

Â Environment Options 
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Select Datasheet 

The Select Datasheet dialog is used to select an appropriate datasheet to open. This dialog displays when you try 
to open a datasheet, but the specific language and version of that datasheet is not available. 

 
 

To Use the Dialog: 

Select the appropriate datasheet to open and click OK. 

See Also: 

Â Language Support Options 

Select Sheet Template 

The Select Sheet Template dialog is used to select the sheet template to use for your design. 
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To Open the Dialog: 

Â For an existing project, right click on your design canvas and select Change Template. 

Templates: 

This area lists the available sheet templates to select for your design. Click on a template to select it. 

Preview: 

This area shows a preview of the selected template. 

See Also: 

Â Schematic Editor 

Â Sheet Template Editor 

Sheet Template Page Setup 

The Sheet Template Page Setup dialog is used to specify various attributes for your sheet template. This is different 
from the Windows Page Setup dialog, used for printing. 

 
 

This dialog only displays when you create a new sheet template. See Sheet Template Editor for more information. 

Paper: 

Choose a paper size from the pull down menu, or specify custom Width and Height measurements in inches. 

Orientation: 

Specify Portrait or Landscape. 

Margins: 

Specify the Top, Bottom, Left, and Right margins in inches. 
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See Also: 

Â Sheet Template Editor 

Signal Name 

The Signal Name dialog is used to name a signal. 

 
 

A signal can have the following valid names: 

Â mywire_1 ï base name only 

Â mywire_1[0] ï base name with a bit index 

Â mywire_1[1:0] ï base name with bus indices 

Â [0] ï bit index only 

Â [1:0] ï bus indices only 

To Open the Dialog: 

Open this dialog in two ways: 

Â For a wire with no label, double-click the wire, or right-click and select Edit Name and Width. 

Â For a wire with an existing label, double-click the wire label. 

Use Computed Name and Width: 

Select this check box to have PSoC Creator automatically specify the name and width; unselect to do it manually. 

Specify Full Name: 

1. To specify a name, you must first unselect the Use Computed Name and Width check box. 

2. Then, select the Specify Full Name check box to enable the associated text box. 

3. Use this text box to enter a base name for the signal. 



Understanding PSoC Creator 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 156 

Indices: 

Use this section to select one of the following index options. This section becomes available when you unselect the 
Use Computed Name and Width check box. 

Â None ï Select this option for no indices on the base name (e.g., my_wire). If you unselect the Specify Full 
Name check box, then the None option is disabled. 

Â Bit ï Select this option to set a bit index on the signal (e.g., [0]). 

Â Bus ï Select this option to set bus indices on the signal (e.g., [1:0]). 

Note The maximum bus width allowed is 1024. 

Preview: 

This field shows you how the signal name will appear on the schematic. 

See Also: 

Â Wire Labels and Names 

Â Working with Wires 

Â Drawing Buses 

Terminal Name 

The Terminal Name dialog is used to name a terminal. 

 
 

A terminal can have the following valid names: 

Â Base name only (Terminal_1) ï A terminal must have a base name that begins with a letter. 

Â Base name with bus indices (Terminal_1[1:0]) ï You may specify left and right indices, if desired. 

To Open the Dialog: 

Open this dialog in two ways: 

Â Drag a new terminal onto your design, or 

Â Double-click the label or terminal. 
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Specify Name: 

The Specify Name field is used to enter a base name for the signal. 

Indices: 

Use this section to select one of the following index options: 

Â None ï Select this option for no indices on the base name (e.g., Terminal_1). 

Â Bits Range ï Select this option to set bus indices on the signal (e.g., [1:0]). 

Note The maximum bus width allowed is 1024. 

Preview: 

This field shows you how the signal name will appear on the schematic. 

See Also: 

Â Signal Name 

Â Working with Schematic Terminals 

Â Working with Component Terminals 

Tuner Communication Setup 

The Tuner Communication Setup dialog allows you to configure the settings used for reading parameters back from 
the PSoC device. It allows for selecting the communication port and selecting properties. 

 
 

Currently, tuners only support communication via I2C. This can be done using the EZ I2C Component or the 
standard I2C Component. 
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To Open the Dialog: 

Open this dialog from the appropriate tuner application. 

Currently, the only tuner application is provided with the CapSenseÈ Components. Refer to the Component's 
datasheet, available from the Component Catalog. 

Interface Description: 

Ports 

This is a list of all of the ports attached to the computer that can be used to communicate with the tunable 
Component. Based on which item is selected, different options will be available for the Port Configuration. 

Port Configuration 

This section allows for configuring the interface specific options for communicating with the Component. This is 
necessary to ensure both Component and tuner are configured the same. 

For I2C communication, there are four pieces of required information: 

Â The voltage the port needs to supply to the device, if any. 

Â The speed at which the data can be clocked into the target device. 

Â The Address of the slave device that is being communicated with. 

Â The size of sub-addresses used for indicating what block of data to read. 

Port Information 

This section displays information about the currently selected port. 

See Also: 

Â CapSenseÈ Component datasheets (available from the Component Catalog) 
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Updated Configuration Files 

If you updated the version of the Peripheral Driver Library (PDL) installed on your computer, the Updated 
Configuration Files dialog might display during a build of an existing project. This dialog lists files in your project that 
might not be compatible with the newer PDL version. Use this dialog to replace the listed files, if needed. 

 
 

If you are sure that the listed files are correct, then click Cancel to proceed with the build with these files. 

If you want files from the newer PDL version, then click Replace to copy new files from the PDL. The existing files 
will be renamed to <filename>.old. 

See Also: 

Â Peripheral Driver Library 
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4 Using Design Entry Tools 

The PSoC Creator design entry tools allow you to create a design using abstract symbols and focus on the system 
rather than the low-level device details. 

This section is divided into the following main categories: 

Â Schematic Editor ï primary tool to create designs 

Â Code Editor ï tool to edit source code 

Â Design-Wide Resources ï tools to configure settings for an entire design 

Â Symbol Editor ï tool used to create Components 

Â UDB Editor ï tool used to configure a UDB implementation 

Â Other Tools 

Ǐ Schematic Macro Editor 

Ǐ Sheet Template Editor 

Ǐ Format Shape 

Additionally, there are several topics that pertain to both editors: 

Â Common Toolbars 

Â Design Elements Palette 

Â Working with Text 

Â Working with Lines 

Â Working with Shapes 

Â Design Entry Reserved Words 
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Schematic Editor 

The Schematic Editor allows to you to create and edit schematics for your designs and implementations for your 
symbols. 

 
 

The main Components of the Schematic Editor include: 

Â Design Canvas ï the canvas on which you draw designs 

Â Design Elements Palette 

Â Common Design Entry toolbars ï commands common to the design entry tools 

Â Context Menus ï commands available by right-clicking 

Â Component Catalog ï library of Components to use in your schematic 

  

This section contains various topics related to working with the Schematic Editor: 

Â Creating a New Schematic 

Â Configuring Component Parameters 

Â Working with Wires 

Â Rubber-Banding 

Â Drawing Buses 

Â Wire Labels and Names 

Â Using Multiple Pages and Connectors 
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Â Disabling/Enabling Schematic Pages 

Â Working with Schematic Terminals 

  

Schematic Editor Context Menu Commands 

The Schematic Editor contains various commands available on right-click ï or context ï menus. The commands 
available will vary depending on whether you right-click on the canvas itself or on a Component/element. The 
following are the commands available: 

On Canvas: 

 

Â System Reference ï Provides access to the most current System 
Reference Guide on disk, as well as a link to a web page for other versions 
and translations of the document, if available. 

Â Paste ï Same as command from the Standard Toolbar. 

Â Select All ï Selects everything on the canvas. 

Â Zoom ï Same as zoom commands from the View Menu. 

Â Generate Symbol ï Creates a new symbol with an automatically generated 
default shape; it will automatically include terminals representing the 
schematic terminals of the source schematic. 

Â Change Template ï Opens the Select Sheet Template dialog to 
select/change a sheet template to use for your design. 

Â Disable Page ï Disables the selected page. See Disabling/Enabling 
Schematic Pages. 

Â Properties ï Opens the Properties dialog. 
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On Selected Object(s): 

 

Â Cut, Copy, Paste, Delete ï Same as commands from the Standard 
Toolbar. 

Â Select All ï Selects everything on the canvas. 

Â Zoom ï Same as zoom commands from the View Menu. 

Â Shape ï Same as shape commands from the Common Design 
Entry Toolbars. 

Â Select ï Allows you to select a specific object when two or more 
objects are drawn on top of each other. 

Â Align ï When two or more objects are selected, this command 
allows you to align selected shapes: left, right center, top, middle, 
and bottom. 

Â Configure ï Opens the Configure Component Parameters dialog 
to edit parameters for the Component instance. 

Â Enable/Disable ï Enables or disables the selected Component. 
Disabling a Component means that PSoC Creator will ignore it; this 
sets the CY_REMOVE flag to true on the Configure dialog under 
the Built-In tab.  

Â Open Datasheet ï Opens the datasheet for the selected 
Component. 

Â Find Code Example ï Opens the Find Code Example dialog for 
the selected Component. 

Â Open Component Web Page ï If available, opens a web page for 
the Component, where you can access datasheets in different 
languages. 

Â Launch Tuner ï If the selected Component has a tuner application, 
this command launches the tuner. 

Â Format Shape ï Opens the Format Shape dialog to change 
various characteristics for the selected shape(s). 

Â Generate Macro ï Creates a Schematic Macro from the selected 
elements. 

Â Show in analog editor ï Shows the selected Component in the 
Design-Wide Resources Analog Device Editor. 

See Also: 

Â Design Elements Palette 

Â Standard Toolbar 

Â Common Design Entry Toolbars 
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Creating a New Schematic 

The process of creating a new schematic varies depending on what you are trying to accomplish with the 
schematic. Within a project, a schematic can be either the top-level design schematic or a Component 
implementation. The process varies for each context. 

Top-Level Design Schematic: 

If you create a new design project, a top-level design schematic will be created for you along with the rest of the 
initial files in your design. This schematic is the top-level design document in which you express your design 
graphically using Components and connections. For more information about creating a design project, see My First 
Design "Hello World" and Creating a New Project. 
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Component Implementation Schematic: 

If you are working with a library project and Components, a schematic can be the implementation of a Component. 
For more information about creating Components, refer to the Component Author Guide. 

Within a Component, you must add a schematic implementation manually. You can add a schematic at the 
Component level or the project level. At either level, you are adding a Component item of the type schematic. For 
more information, see Adding a Component Item. 

Â When you add a schematic at the Component level, you are adding a new schematic item to the existing 
Component: 

 

  

Â When you add a schematic at the project level, you create a new Component with a schematic as a 
Component item: 
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Note You may only have one top-level (generic device) schematic per Component. You may also only have one 
schematic for each architecture, family, and device level of your Component. 

See Also: 

Â Creating a New Project 

Â Component Author Guide 

Â Adding a Component Item 

Â Schematic Editor 

Â Workspace Explorer 

Component Catalog 

The Component Catalog is a Schematic Editor tool window that contains one or more sets of Components to use in 
a design. The Components are organized into categories. Each category contains a tree with the Components. 
There can also be one or more tabs with different trees and categories. 

 
 

Component Tabs 

By default, there are two tabs of Components: Cypress and Off-Chip. Cypress Components are always installed. 
These are developed by Cypress for use in your designs. Off-Chip or "External" Components, if installed, are used 
to document connections the device may have on the development board. They are used for documentation 
purposes only. They are described in the External Library Component Datasheet. 
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Note The location and order of the Components in this catalog are determined by various properties for each 
Component. They do not necessarily reflect the actual library in which they are stored. Also, not every Component 
is available for every device. 

Component Preview 

Below the Components is an area with the following: 

Â Open Datasheet ï Link to open the selected Component datasheet. 

Â Description ï Short summary of the Component. 

Â Component Preview ï Preview of the selected Component symbol. 

Toolbars: 

 
 

The Component Catalog contains a set of tools to work with the catalog, as follows: 

Â Show Latest Versions ï Shows only the most recent versions of Components with numbers. If there is only 
one version, no numbers are shown. 

Â Show All Versions ï Shows all versions of Components with Component numbers. If there is only one version, 
no numbers are shown. 

Â Expand All ï Expands all nodes to show every visible Component. 

Â Collapse All ï Collapses all nodes to show only category folders. 

Â Find new Components ï Opens the Component Installer dialog to find and install new Components and 
Component versions. 

Â Clear Results ï Clears the Search for filter. 

Â Search for ï Filters the Components shown to those that match the text entered in this field. 

Context Menu Commands: 

If you right-click on a Component in the tree view, you can access the following commands: 

 

  

Â Open Datasheet ï Select this option to open the Component's 
datasheet. 

Â Find Code Example ï Select this option to open the Find Code Example 
dialog to open a code example specifically for the selected Component. 

Â Open Component Web Page ï If available, this option opens a web 
page for the Component, where you can access datasheets in different 
languages. 

Â Properties ï Select this option to see the basic properties of the 
Component. The properties include the library path of the Component. 
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To View the Component Datasheet: 

Click the Open Datasheet link, or select the option from the context menu. The datasheet for that Component will 
open. 

To Add a Component to a Schematic: 

Click on a Component in the catalog and drag it onto the Schematic Editor canvas. 

To Search for a Component: 

Type text in the search field. As you begin typing, the Components available will filter based on what you type. 

 
 

Click Clear Results   to clear the search results and restore the Component Catalog to view all Components. 

See Also: 

Â Schematic Editor 

Â Tool Windows 

Â Component/Instance 

Â Find Code Example 

Â Component Installer 
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Configure Component Parameters 

When you drag an instance of a Component onto your schematic, you can configure it with the Configure dialog. 

 
 

Note This help topic is generic. Many Components have customized parameter configuration user interfaces. Refer 
to a Component's datasheet for specific information. 

To Open this Dialog: 

1. Double-click a Component instance or right-click on a Component instance and select Configure. 

2. Edit the parameters as appropriate and click OK. 

To Open the Component Datasheet: 

Click the Datasheet button. 

If a Component has a datasheet, it will open in a separate window. 

To Rename the Component Instance: 

By default, the Component instance will receive the name "INSTANCE_1" where INSTANCE is the name of the 
Component, such as PGA, Counter, Timer, etc. 

Type the instance name you prefer in the Name field. 

Note Once you generate source code for a Component, case-only name changes will be ignored on subsequent 
code generation updates. For information about generating code, see Building a PSoC Creator Project and 
Generated Files. 
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Built-In Parameters: 

 
 

Every Component contains a tab with the following built-in parameters: 

Â Component Major Version - This parameter displays the major version number of the Component. 

Â Component Minor Version - This parameter displays the minor version number of the Component. 

Â Config Data in Flash - Controls whether the configuration structure is stored in flash (const, true) or SRAM (not 
const, false). 

Â Disable - This parameter is used to disable the Component and remove the instance from the generated netlist 
during a build. The default value is false. 

Â Suppress API generation - This parameter is be used to prevent PSoC Creator from generating APIs for the 
specific instance. The default value is false. 

Â User Comments - User provided instance specific comments. 

For more information about built-in parameters, refer to the Component Author Guide. 

See Also: 

Â Component Catalog 

Â Schematic Editor 
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Working with Wires 

Using the Schematic Editor, you can draw wires to connect Components and wires. This section covers a few of the 
different techniques to use when working with wires: 

Â Drawing a Wire 

Â Connecting to a Terminal 

Â Drawing Multi-point Wires 

Â Connecting to another Wire 

Â Selecting a Wire/Net 

See also Wire Labels and Names and Drawing Buses. 

To Draw a Wire: 

1. Click the Draw Wire tool.  

2. Click on the design canvas and drag the mouse to the desired location. 

3. Click the left mouse once to continue the wire in a different direction. 

4. Double-click to end the wire. 

Note The Schematic Editor draws a digital (green) wire when it is connected to digital Components or not 
connected to any Components. To draw an analog (red) wire, you must connect it to analog Components. 

To Connect to a Terminal: 

1. To begin drawing a wire, first create an input and output Component on your schematic. 

2. Click the Draw Wire tool.  

3. Move your pointer toward the contact point of one of the terminals. 

Notice as you near the contact point that your pointer changes to a black X: 

 
 

4. Click and release the mouse button, and move the pointer to begin drawing the wire. 

Notice that the pointer changes to a + . 

As you near the next terminal contact point, your pointer again changes to a black X: 

 
 

5. Click the left mouse button at the second terminal contact point to establish the connection. 
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The wire becomes selected with a dashed box surrounding it: 

 
 

To Draw Multi-Point Wires: 

1. Use the first example, and move the second terminal down on your schematic: 

 
 

2. Click the Draw Wire tool.  

3. Click and release the mouse button, and move the pointer to begin drawing the wire. 

4. Move the pointer down toward the second terminal. 

Notice that wire changes shape to an inverted L. 

 
 

5. Move the pointer down to be even with the terminal, click and release the mouse button, and move the pointer 
right ï toward the terminal. 
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Notice that wire obtains an additional point. 

 
 

You can create as many points as you need by repeatedly clicking the mouse at different points on your 
schematic. 

6. Click the left mouse button at the second terminal contact point to establish the connection. 

The wire becomes selected with a dashed box surrounding it. 

To Connect to Another Wire: 

1. Use the first example again, and create an additional output terminal on your schematic. 

2. Click the Draw Wire tool.  

3. Move your pointer toward an existing wire. 

Notice as you near the contact point that your pointer changes to an X: 

 
 

4. Click and release the mouse button, and move the pointer to begin drawing the wire. 

Notice that a dot appears on the wire to denote a connection point. 

 
 

5. Click the left mouse button at the third terminal contact point to establish the connection. 

The wire becomes selected with a dashed box surrounding it. 

To Select a Wire/Net: 

Â To select a wire, click on it once with the left mouse button. 

Â To select a segment of a wire net from one connection point to another, right-click on a wire and select Select 
Wire Segment. 
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Â To select an entire wire net, right-click on a wire and select Find Wire Trace. 

See Also: 

Â Using Design Entry Tools 

Â Schematic Editor 

Â Design Elements Palette 

Â Signal Name 

Rubber-Banding 

The rubber-banding feature automatically redraws your wires as you move objects on your design schematic. The 
feature is enabled by default. 

 
 

To Use Rubber-Banding: 

Select one or more objects on your schematic and move them to another location on your screen. Notice as you 
move the objects, the wires stretch with the movement. You can move items by dragging the mouse or using 
[Arrow] keys. 

If you stop the movement with the mouse for a moment, PSoC Creator will show a preview of how the wires will be 
redrawn. Using [Arrow] will not show a preview. 
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To Correct a Rubber-Banding Problem: 

Sometimes, PSoC Creator may not be able to redraw the wires. In this case, the move will not be allowed. The 

cursor will show a "No"  symbol, and the status bar will display a message indicating the move was not allowed. 

 
 

If you release the mouse button, the Component will move back to the previous location. A dialog will also display 
as follows: 

 
 

Try selecting fewer objects or temporarily disabling rubber-banding. You can also select a larger region of objects 
and try to move them as a unit. 
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To Temporarily Disable Rubber-Banding: 

When rubber-banding is turned on, press and hold the [Ctrl] key while moving a Component. The wire preview will 
not be shown during a move. If you release the [Ctrl] key, the preview will reappear. 

If you release the mouse button while holding the [Ctrl] key, the wires will not be redrawn for this move, and the 
connections will be broken. 

To Turn Off Rubber-Banding: 

1. Open the Options dialog from the Tools menu. 

2. Under the Design Entry category, scroll down to the Wires section. 

3. Find the rubber-banding option and select Off. 

4. Click OK to close the dialog. 

Now when you move a Component, the wires are not redrawn by default. 

To Temporarily Enable Rubber-Banding: 

When rubber-banding is turned off, press the [Ctrl] key while moving a Component. 

See Also: 

Â Design Entry Options 

Â Keyboard Shortcuts 

Drawing Buses 

To draw a bus, you simply connect a wire to a multiple bit connection. The wire inherits the bus width automatically. 
You may also specify the width of a wire name, using the Signal Name dialog. This allows you to create a bus 
without connecting it to anything. It also allows you to rip signals from the bus to connect to smaller width signals. 

The following diagram shows an example of two Pins Components -- one configured with individual 1-bit terminals 
connected to wires and the other configured as a 4-bit bus: 
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To Connect Buses to Smaller Width Signals (Ripping Signals): 

You cannot directly connect a bus to a smaller width signal (without receiving DRC errors in the Notice List 
window). Instead, you must create a multi-point wire and label the portion of the wire connecting to the smaller 
width terminal, as shown in the following example: 

1. Create a 4-bit Pins Component and four AND Components each with a 1-bit terminal width. 

 
 

Refer to Configure Component Parameters, Component Catalog, and Working with Shapes as necessary. 

2. Use the Draw Wire tool  and make a multi-point connection from the 4-bit port to the farthest single-bit 
Component terminal. 

As soon as the connection is made, an error will display about inconsistent widths (among other connection 
errors). 

 
 

3. Click on the canvas to de-select the entire wire. 

4. Double-click on the wire segment connecting to a single-bit terminal. 
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The Signal Name dialog opens to name the wire. See Signal Name for more information. 

 
 

5. De-select Use computed name and width and de-select Specify Full Name. 

6. Select the Bit option and select Index [3]. 

7. Click OK to close the dialog. 

Notice the label displays and the wire connecting to the terminal becomes thin. 

 
 

8. Connect the bus to each of the other single-bit terminals. Label them [0], [1], and [2], respectively, using the 
same process as described above. 

 
 

Tip You can copy and paste the completed wire, and then double-click the label to edit the signal name. 

Note You can connect various width signals using the same process and not all bits from an input pin need to be 
used. However, every bit of an output bus must be driven. 
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See Also: 

Â Signal Name Dialog 

Â Working with Wires 

Â Wire Labels and Names 

Â Notice List Window 

Wire Labels and Names 

This section provides details about displaying and editing wire labels in the Schematic Editor. A wire can have an 
explicit User Name, and every (valid) wire has an Effective Name. You can see these names on the schematic 
canvas, if displayed, or in the Properties dialog. 

Â Wire Label ï The wire label is the displayed name of a wire. Displaying the wire label is optional, and it is only 
displayed for wires with User Names. 

Â User Name ï The User Name is the label you specify for a wire, using the Signal Name dialog. Not every wire 
must have a User Name. 

Â Effective Name ï This is the name computed by the connectivity subsystem. The name is derived from the 
sources in the schematic, for example, connected input schematic terminals. Every (valid) wire has an Effective 
Name and is never empty. 

Wire Label Display Scheme in the Schematic Editor: 

Â If you provide a name, PSoC Creator will display the label with the User Name. 

Â If the wire does not have a User Name, PSoC Creator will not display the label. 

Â When you edit the name, the User Name will be set. The Effective Name cannot be set. 

Â The wire properties in the Properties dialog show the Effective Name and User Name. 

Note If you copy and paste a wire with a User Name, PSoC Creator will not rename the wire, even though PSoC 
Creator will rename other pasted elements, such as Components and terminals. There may be some cases where 
copying and pasting a wire with a User Name connected to terminals and Components will cause DRC errors, and 
you will have to rename the wire appropriately, or remove the label. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 180 

To Set a User Name for a Wire: 

1. Double-click on a wire to open the Signal Name dialog. 

 
 

2. On the dialog, de-select Use computed name and width and select Specify Full Name. 

3. Type the desired User Name in the field and click OK. 

The specified User Name will be shown attached to the wire. 

 
 

Note If a wire has an existing User Name, you can double-click the label to open the Signal dialog. 

To Move a Wire Label: 

Click the wire label to select it, and drag it another location. The wire anchor will always display attached to the 
middle of the wire segment. 

 

See Also: 

Â Schematic Editor 

Â Properties 
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Â Signal Name 

Â Working with Wires 

Using Multiple Pages and Connectors 

You can add multiple pages to your design if it is too large for one sheet, or if you just want to separate different 
sections of your design for readability. You connect elements on different pages using sheet connectors. This topic 
shows you how to add a page to your schematic and how to connect elements on different pages. 

To Add a Page: 

Right-click on the schematic page tab at the bottom of the schematic, and select Add Schematic Page. 

 
 

The new page is added as a tabbed document. 

To Rename a Page: 

1. Right-click on the schematic page tab at the bottom of the schematic, and select Rename Page. 

The Rename Page dialog displays. 

 
 

2. Type the name for the page and click OK. 

The page tab displays the name you entered. 
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To Delete a Page: 

Right-click on the schematic page tab at the bottom of the schematic, and select Delete Page. 

The selected page tab is removed. 

Note You cannot delete the page tab if there is only one. 

To Use Sheet Connectors: 

Sheet connectors connect to wires or buses on multiple sheets, with the connection point in the center of the 
shape. They are unnamed and have no defined flow direction. 

Every simple wire name and every bit of a bus present on multiple sheets must be connected to a sheet connector 
on each sheet where used. When using sheet connectors with input terminals and buses, keep in mind that when a 
base name is used in an input terminal, it must define the entire signal. So, using bits of a signal that were not 
defined by the input terminal on a separate page will violate the existing rules. See Wire Labels and Names and 
Drawing Buses. 

Note You can connect wires by name on the same page of a schematic without sheet connectors. 

1. Click the Wire icon  and draw a wire on two different pages of your schematic. 

2. Double-click each wire and give each wire the same name (e.g., "foo"). 

Notice that the Notice List window shows a sheet connector error. 

 
 

3. Click the Sheet Connector icon  and place a connector on each wire on each page. 

Once all wires are connected, the Notice List window will clear. 

The following image shows some examples of valid sheet connections: 
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See Also: 

Â Working with Wires 

Â Wire Labels and Names 

Â Wide Terminals and Wires 

Disabling/Enabling Schematic Pages 

Disabling a schematic page allows you to specify a portion of a design to be excluded from the build. You can 
disable (and re-enable) one or more pages in your schematic design. This allows you remove sections for testing 
and debugging, as well as provide different configurations. 

Possible Build Errors 

Before disabling a schematic page, make sure the name of the schematic page tab starts with a letter, and includes 
only alphanumeric and space characters. 

When a schematic page is disabled, the system creates a macro in the cydisabledsheets.h file, named after that 
schematic page's tab. If the tab name begins with a number, or is otherwise not a valid C identifier, the system 
creates an invalid macro name. This will cause build errors. 

To Disable a Page: 

Right-click on the schematic page tab at the bottom of the schematic, and select Disable Page. 

 
 

The schematic page will be disabled and the word "Disabled" will appear on the schematic and the tab. 

To Enable a Disabled Page: 

Right-click on the schematic page tab at the bottom of the schematic, and select Enable Page. 

 
 

The schematic page will become active again. 

Note If there are other active pages in the schematic that have Component instance names that are the same as 
those on the page you are trying to enable, the Merge Dialog will display to resolve the conflicts. 

See Also: 

Â Schematic Editor 
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Â Merge Dialog 

Working with Schematic Terminals 

The terminal tools in the Design Elements Palette for schematics allow you to draw digital input, output, and inout, 
as well as analog and external terminals. 

         
 

Use schematic terminals when you are implementing a Component with a schematic to represent the external 
connectivity of the Component within the chip. For more information about creating Components, refer to the 
Component Author Guide. 

Note Schematic terminals are hidden from the Design Elements Palette when you are editing a top-level 
schematic; they are only available for Component implementation schematics. For more information, see Creating 
a New Schematic. 

To Place a Single Terminal: 

1. Click the appropriate Terminal tool on the Design Elements Palette and then click on the design canvas. 

The Terminal Name dialog displays. 

 
 

2. Specify the Terminal Name and Index information, as appropriate. 

3. Click OK. 

To Place Multiple Terminals: 

1. Double-click on the appropriate Terminal tool in the Design Elements Palette and then click on the design 
canvas. 

2. Click repeatedly on the canvas to place multiple terminals. 

This is called "sticky mode." 

3. Press [Esc] or click the Select Tool  to escape sticky mode. 
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To Rename a Terminal: 

1. Double-click the label to open the Terminal Name dialog. 

2. Type the appropriate Terminal Name. 

3. Click OK. 

Note If you copy and paste a terminal onto a schematic, PSoC Creator will rename the pasted Component by 
appending "_n" to the name, where n is next available number. 

To Delete a Terminal: 

Select the terminal and press [Delete] or click . 

See Also: 

Â Schematic Editor 

Â Design Elements Palette 

Â Terminal Name 

Code Editor 

The Code Editor, or text editor, allows you to view and edit source files in PSoC Creator. You can open multiple files 
in tabbed document windows, and copy and paste among files. 
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The following describe the different sections of the Text Editor: 

Â Code Pane ï The area where code or text is displayed for editing. It provides Autocomplete statement 
completion for the language in which you are developing. You can navigate back and forth to previous cursor 
locations, using [Ctrl]+[-] and [Ctrl]+[Shift]+[-], respectively. 

Â Indicator Margin ï A gray column on the left side of the Code Editor where indicators such as breakpoints, 
bookmarks, shortcuts, and Inline Code Diagnostics are displayed. Clicking this area sets a breakpoint on the 
corresponding line of code. For more information see the Debugger section. 

Â Selection Margin ï A column between the Indicator Margin and the Code Pane where you can click to select 
lines of code. This area shows line number. Also, changes to code are tracked here when you select Track 
Changes in the Options dialog, under Text Editor > General. 

Â Toolbar and Commands 

Â Code Explorer Window 

Â Autocomplete 

To Open the Text Editor: 

There are various ways to open a file in the Text Editor: 

Â Workspace Explorer ï Double-click a file. 

Â File menu ï Select New or Open to display a file. 

See Also: 

Â Document Windows 

Â Workspace Explorer 

Â Code Editor Toolbar 

Â Code Editor Context Menu Commands 

Â Autocomplete 

Â Code Outline Tool Window 

Â Find All References 

Â Inline Code Diagnostics 

Â Find Replace 

Â Options Dialog > Text Editor options 

Â Go To Line 

Â Using the Debugger 
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Code Editor Toolbar 

 
 

The Text Editor toolbar contains the following commands: 

Â Toggle Bookmark ï Adds/removes a bookmark in the margin for the current line. 

Â Comment Selection ï Changes selected text to a comment. 

Â Uncomment Selection ï Removes comment for selected text 

Â Increase Line Indent ï Indents selected text to next tab stop. 

Â Decrease Line Indent ï Outdents selected text to the previous tab stop. 

  

Code Editor Context Menu Commands 

The Text Editor contains various commands available on right-click ï or context ï menus. The commands available 
will vary depending on whether you are editing source code files or running the debugger. The following are the 
commands available: 

In Edit Mode: 

 

Â Insert Breakpoint ï Adds a new file/line breakpoint to 
the line that the cursor is currently on. See Breakpoints 
Window. 

Â Break Here Once ï Adds a new temporary file/line 
breakpoint to the line that the cursor is currently on. 
After this breakpoint has been hit once, it will 
automatically be removed. 

Â Go To Declaration ï Similar to the Go To Definition, this 
option jumps to the symbol implementation. However, 
unlike, the Go To Definition, this jumps to the actual 
declaration/implementation. Most of the time, this will 
jump directly to the source file that declared the function. 
The only cases where this will not occur are if there is 
no declaration found (e.g., declared in an included 
library). 

Â Go To Definition ï If tool tip information is not sufficient 
for answering whatever question you might have, this 
option jumps to the definition of the selected symbol. If 
the symbol is declared in a different source file, this will 
jump to the included header file. If the symbol is 
declared in the current source file, it will jump to that 
location. 

Â Find All Active References ï Allows you to search for 
all references to a symbol. See Find All References. 
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Â Go Back ï Go back to previous cursor location. 

Â Undo ï Undoes the last edit to the file. 

Â Redo ï Undoes the last undo 

Â Cut ï Cuts the selected text 

Â Copy ï Copies the selected text 

Â Paste ï Pastes the text currently in the clipboard into 
the file 

Â Delete ï Deletes the selected portion of text 

Â Select All ï Selects the text from the entire document 

In Debug Mode: 

The context menu contains all the same commands as in edit mode, plus the following commands: 

 

  

Â Add Watchpoint ï Adds a new watchpoint on the selected 
variable; see Variable Watchpoints 

Â Add Watch ï Adds the variable, or selected text to the watch 
window; see Watch Window 

Â Run to Cursor ï Resumes executing code till it reaches the 
line 

Â Set Next Instruction ï Jumps the program to the current line 
of code 

See Also: 

Â Text Editor 

Â Text Editor Toolbar 

Â Using the Debugger 

Â Debugger Toolbar Commands 

Â Debugger Menu Commands 

Â Variable Watchpoints 

Â Watch Window 
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Autocomplete 

If enabled, the autocomplete feature provides a context-aware drop-down list of all potentially relevant keywords, 
types, variables, macros, and functions as you type.  

 
 

Note This feature is enabled by default. You can disable it under the Text Editor Options. 

This feature helps you to write code faster. It also provides enormous value as a documentation source. You no 
longer need to constantly go back to the datasheet or source file to find the function you need. Simply start typing to 
see what is available. 

Note Completions are limited until the project has been built. 

In addition to providing the list of what is available, the Code Editor displays a tool tip of the selected item to provide 
the full signature. In the case of functions, this shows the return value, the name of the function, and the types and 
names of all argument variables. 

To Use the Feature: 

1. If not already enabled, enable to the Autocomplete feature in the Text Editor Options dialog. The feature is 
enabled by default. 

2. Create your design as usual, and click the Generate Application button   to allow PSoC Creator to 
generate or update the various API files.  

3. Open the Code Editor and begin typing; notice the drop-down list opens when it finds items that match. You can 
also initiate the feature using [Ctrl] + [Space]. 

4. Scroll through the list to find what you want, or just keep typing until the desired item is highlighted. You can 
press [Ctrl] + [Space] to toggle between show macros only, show non-macros only, or show all. 

5. Once the desired item is selected in the list, press [Tab] or [Enter] to autocomplete the word. [Esc] will cancel 
the autocomplete process. 

The selected item is inserted and case adjusted to match the actual signature that you completed. 

See Also: 

Â Code Editor 
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Code Explorer Window 

The code explorer feature allows you to see the entire structure of your source file with a quick glance. With it, you 
can see what is defined and where. You can also use it to jump to specific areas of your code. 

 
 

To Display the Code Explorer Tool Window: 

This tool window displays automatically when you open the Code Editor. It is located on the right side of the tool. If 
you close the tool window, you can open it again by selecting Code Explorer under the View menu. 

To Jump to Specific Location: 

Double-click an item or press [Enter] when the item is highlighted.  

The code editor will immediately scroll to that symbol. 

Toolbar: 

 
 

The Code Explorer toolbar contains the following formatting options to change how the outline is presented: 

Â Expand All / Collapse All ï Separate buttons to expand or collapse all nodes in the entire tree. 

Â Show in Groups ï Toggle button to group various symbols together or view them separately. 

Â Sort Order ï Button and pull-down to change the ordering by name or position in the file. 
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Context Menu: 

When you right-click on a node item in the tree, the following commands are available. See also Code Editor 
Context Menu Commands. 

 

Â Go To Declaration ï This option jumps to the declaration of the 
selected symbol. 

Â Go To Definition ï This option jumps to the definition of the 
selected symbol. 

Icons: 

Each item show in the tree includes an icon. The following lists what the icons mean: 

Â ï Include Directive 

Â ï Macro 

Â ï Struct 

Â ï Typedef 

Â ï Union 

Â ï Enum 

Â ï Enum constant 

Â ï Function 

Â ï Argument Variable 

Â ï Variable 

See Also: 

Â Code Editor 

Â Code Editor Context Menu Commands 

Find All References 

The Find All References feature allows you to find all items that are using a particular symbol (function, macro, 
variable, type).  

To use This Feature: 

Right-click on a symbol in the Code Editor and select Find All Active References from the context menu, or press 
[Ctrl] + [Shift] +[R]. 

PSoC Creator scans through the entire project in order to find all uses of the symbol, and displays the results of this 
search in the Find Results window.  

Double click on an entry in the Find Results to jump to that location in the source code. 
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See Also: 

Â Code Editor 

Â Find Results 

Inline Code Diagnostics 

When enabled, this feature displays compiler diagnostic information directly in the editor. This allows you to see 
what problems exist in the code without needing to do a full build of the project. 

 
 

Note This feature is enabled by default. You can disable it under the Text Editor Options. 

The diagnostics displayed in the editor may not correspond to the errors/warnings generated when performing a 
build. This is because the editor uses a generic build framework that does not have identical rule checkers as the 
active toolchain. Because of this, none of the diagnostics are displayed in the Notice List. The errors/warnings 
displayed in the Notice List are strictly limited to what is generated for the current design configuration. 

Note If an error about a missing include is shown, other errors in the document may not be displayed. This occurs 
because missing include files are considered fatal and limit what additional processing is performed. If a critical 
include cannot be found, it could very well cause almost every line in the file to be identified as an error, which 
would obscure the actual problem (missing include file). 

To Use the Feature: 

Save the current file. Any issues in the code will display with a waved line. 

Hover the mouse over the margin indicator or the waved line to see a tooltip of the problem. 

The margin on the left displays if the error is a warning or an error. 

See Also: 

Â Code Editor 

Â Reference Tooltips 
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Reference Tooltips 

If enabled, the Code Editor provides reference tooltips to make the code easier to read and understand, such as 
what a block of code is doing or what various arguments to a function do. 

 

 

 
 

Note This feature is enabled by default. You can disable it under the Text Editor Options. 

To Use the Feature: 

Hover the mouse over any reference type (variable, function, or macro) to see the declaring signature of that item.  

See Also: 

Â Code Editor 

Disabled Code 

The Code Editor identifies disabled code in a grayed-out color. This helps alleviate the issue of code being difficult 
to read due to congestion. 
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PSoC devices and Components used in designs are highly configurable, plus there are several different devices 
and toolchains supported by PSoC Creator. This requires the use of a significant number of #ifdef statements 
throughout the firmware code, which makes reading and debugging the code difficult.  

The disabled code feature significantly improves the readability and understandability of the code. It also helps 
improve the debugging experience. You can clearly see that large blocks of code are disabled and understand 
immediately why the debugger stepped over them. 

This functionality is provided automatically with no necessary user interaction. 

Find Replace 

The Find Replace dialog is used to locate text within a file and optionally replace it. 

 
 

This dialog varies slightly depending on how you opened it. There are separate help topics for Find in Files and 
Replace in Files. 

To Open the Find Replace Dialog: 

Use any of the following methods: 

Â Press [Ctrl]+[F] (for find) or [Ctrl]+[H] (for find and replace). 

Â On the Edit menu, select Find and Replace, and then select the appropriate find/replace command. 

Â Click the displayed find/replace button icon or select one of the find/replace options from the pull-down menu. 
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To Use the Find Replace Dialog: 

Find what 

Use this field to specify the string or expression to find. You can reuse one of the last 20 search strings by selecting 
it from this drop-down list, or type a new text string or expression to find.   

Replace with 

Use this field to replace instances of the Find what string with another string. To delete instances of the Find what 
string, leave this field blank. 

Expression Builder 

Use the triangular button next to the Find what and Replace with fields when the Use check box is selected under 
Find options. 

 
 

Click this button to display a list of wildcards or regular expressions, depending upon the Use option selected. 
Choosing any item from this list adds it to the Find what or Replace with string. 

Look in 

Use this pull-down menu to select Current Document or All Open Documents. 

Find options 

You can expand or collapse the Find Options section. The following options can be selected or cleared: 

Â Match case ï When selected, the Find Results windows will only display instances of the Find what string that 
are matched both by content and by case. For example, a search for "MyObject" with Match case selected will 
return "MyObject" but not "myobject" or "MYOBJECT." 
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Â Match whole word ï When selected, the Find Results windows will only display instances of the Find what 
string that are matched in complete words. For example, a search for "MyObject" will return "MyObject" but not 
"CMyObject" or "MyObjectC." 

Â Search up ï When selected, files are searched from the insertion point to the top of the file. 

Â Search hidden text ï When selected, the search will also include concealed and collapsed text, such as the 
metadata of a design-time control; a hidden region of an outlined document; or a collapsed class or method. 

Â Use ï Indicates how to interpret special characters entered in the Find what or Replace with fields. The 
options include: 

Â Wildcards ï Special characters such as asterisks (*) and question marks (?) represent one or more characters. 
See Wildcards. 

Â Regular Expressions ï Special notations define patterns of text to match. See Regular Expressions. 

Buttons 

Click the appropriate button, as follows: 

Â Find Next ï Click this button to find the next instance of the Find what string within the search scope chosen in 
Look in. 

Â Bookmark All ï Click this button to display bookmarks at the left edge of the text editor to indicate each line 
where an instance of the Find what string occurs. 

Â Replace ï Click this button to replace the current instance of the Find what string with the Replace with string, 
and find the next instance within the Look in scope. 

Â Replace All ï Click this button to replace all instances of the Find what string with the Replace with string, in 
all files within the Look in scope. 

See Also: 

Â Text Editor 

Â Find in Files 

Â Replace in Files 

Â Regular Expressions 

Â Wildcards 
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Find in Files 

The Find in Files dialog allows you to search the code of a specified set of files for a string or expression. The 
matches found and actions taken are listed in the Find Results window selected under Result options. 

 
 

To open the Find in Files dialog: 

Use any of the following methods: 

Â Press [Ctrl]+[Shift]+[F]. 

Â On the Edit menu, select Find and Replace, and then select Find in Files. 

Â Select Find in Files from the pull-down menu. 

 
 

To use the Find in Files dialog: 

Find what 

Use this field to specify the string or expression to find. You can reuse one of the last 20 search strings by selecting 
it from this drop-down list, or type a new text string or expression to find.   

Expression Builder 

Use the triangular button next to the Find what and field when the Use check box is selected under Find options. 
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Click this button to display a list of wildcards or regular expressions, depending upon the Use option selected. 
Choosing any item from this list adds it into the Find what string. 

Look in 

Use this pull-down menu to select Current Document or All Open Documents. 

Click the [...] button to select a directory in which to search. You can also check the Include subfolders check box 
to search sub folders of the specified search directory. 

Find options 

You can expand or collapse the Find Options section. The following options can be selected or cleared: 

Â Match case ï When selected, the Find Results windows will only display instances of the Find what string that 
are matched both by content and by case. For example, a search for "MyObject" with Match case selected will 
return "MyObject" but not "myobject" or "MYOBJECT." 

Â Match whole word ï When selected, the Find Results windows will only display instances of the Find what 
string that are matched in complete words. For example, a search for "MyObject" will return "MyObject" but not 
"CMyObject" or "MyObjectC." 

Â Use ï Indicates how to interpret special characters entered in the Find what or Replace with fields. The 
options include: 

Ǐ Wildcards ï Special characters such as asterisks (*) and question marks (?) represent one or more 
characters. See Wildcards. 

Ǐ Regular Expressions ï Special notations define patterns of text to match. See Regular Expressions. 

Â Look at these file types ï This list indicates the types of files to search through in the Look in directories. If 
this field is left blank, all of the files in the Look in directories will be searched. 

Ǐ Select any item in the list to enter a preconfigured search string that will find files of those particular 
types. 

Ǐ To find a type of file not available from the drop-down list, enter an asterisk (*) wildcard for the file 
name, followed by a period (.) and the desired file extension. To find more than one file type, enter 
multiple file extensions separated by a semicolon (;). 

Result options 

You can expand or collapse the Result options section. The following options can be selected or cleared: 

Â Find Results 1 window ï Select this option to display the results of the current search in the Find Results 1 
window. This window opens automatically to display your search results. To open this window manually, select 
Find Results from the View menu and choose Find Results 1. 

Â Find Results 2 window ï Select this option to display the results of the current search in the Find Results 2 
window. This window opens automatically to display your search results. To open this window manually, select 
Find Results from the View menu and choose Find Results 2. 

Â Display file names ï Select this check box to display a list of files containing search matches rather than 
displaying the search matches themselves. 

Buttons 

Click the appropriate button, as follows: 
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Â Find All ï Click this button to find all instances of the Find what string within the search scope chosen in Look 
in. The results are displayed in the Results window chosen under Result options. 

See Also: 

Â Replace in Files 

Â Find Replace 

Â Find Results 

Â Regular Expressions 

Â Wildcards 

  

Replace in Files 

The Replace in Files dialog allows you to search the code of a specified set of files for a string or expression and 
change some or all of the matches found. The matches found and actions taken are listed in the Find Results 
window selected under Result Options. 

 
 

To Open the Replace in Files Dialog: 

Use any of the following methods: 

Â Press [Ctrl]+[Shift]+[H]. 

Â On the Edit menu, point to Find and Replace, and then click Replace in Files. 
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Â Select Replace in Files from the pull-down menu. 

 

To Use the Replace in Files Dialog: 

Find what 

Use this field to specify the string or expression to find. You can reuse one of the last 20 search strings by selecting 
it from this drop-down list, or type a new text string or expression to find.   

Expression Builder 

Use the triangular button next to the Find what and field when the Use check box is selected under Find options. 

Click this button to display a list of wildcards or regular expressions, depending upon the Use option selected. 
Choosing any item from this list adds it into the Find what string. 

Look in 

Use this pull-down menu to select Current Document or All Open Documents. 

Click the [...] button to select a directory in which to search. You can also check the Include subfolders check box 
to search sub folders of the specified search directory. 

Find options 

You can expand or collapse the Find Options section. The following options can be selected or cleared: 

Â Match case ï When selected, the Find Results windows will only display instances of the Find what string that 
are matched both by content and by case. For example, a search for "MyObject" with Match case selected will 
return "MyObject" but not "myobject" or "MYOBJECT." 

Â Match whole word ï When selected, the Find Results windows will only display instances of the Find what 
string that are matched in complete words. For example, a search for "MyObject" will return "MyObject" but not 
"CMyObject" or "MyObjectC." 

Â Use ï Indicates how to interpret special characters entered in the Find what or Replace with fields. The 
options include: 

Ǐ Wildcards ï Special characters such as asterisks (*) and question marks (?) represent one or more 
characters. See Wildcards. 

Ǐ Regular Expressions ï Special notations define patterns of text to match. See Regular Expressions. 

Â Look at these file types ï This list indicates the types of files to search through in the Look in directories. If 
this field is left blank, all of the files in the Look in directories will be searched. 

Ǐ Select any item in the list to enter a preconfigured search string that will find files of those particular 
types. 

Ǐ To find a type of file not available from the drop-down list, enter an asterisk (*) wildcard for the file 
name, followed by a period (.) and the desired file extension. To find more than one file type, enter 
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multiple file extensions separated by a semicolon (;). 

Result options 

You can expand or collapse the Result options section. The following options can be selected or cleared: 

Â Find Results 1 window ï Select this option to display the results of the current search in the Find Results 1 
window. This window opens automatically to display your search results. To open this window manually, select 
Find Results from the View menu and choose Find Results 1. 

Â Find Results 2 window ï Select this option to display the results of the current search in the Find Results 2 
window. This window opens automatically to display your search results. To open this window manually, select 
Find Results from the View menu and choose Find Results 2. 

Â Keep modified file open after ï Select this check box to leave open the files that were modified during the 
Replace in Files operation.. 

Buttons 

Click the appropriate button, as follows: 

Â Find Next ï Click this button to find the next instance of the Find what string within the search scope chosen in 
Look in. 

Â Replace ï Click this button to replace the current instance of the Find what string with the Replace with string, 
and find the next instance within the Look in scope. 

Â Replace All ï Click this button to replace all instances of the Find what string with the Replace with string, in all 
files within the Look in scope. 

Â Skip File ï Becomes available when the Look in list includes multiple files. Click this button if you do not want 
to search or modify the current file. The search will continue in the next file on the Look in list. 

See Also: 

Â Find in Files 

Â Find Replace 

Â Find Results 

Â Regular Expressions 

Â Wildcards 
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Regular Expressions 

Regular expressions are a concise and flexible notation for finding and replacing patterns of text. A specific set of 
regular expressions can be used in the Find what field of the Find Replace window. 

To enable the use of regular expressions in the Find what field during find and replace operations, select Use > 
Regular Expressions under Find Options. 

The triangular button next to the Find what field displays a list of the most commonly used regular expressions. 

 
 

When you choose any item from the Expression Builder, it is inserted into the Find what string. 

Note There are syntax differences between the regular expressions that can be used in Find what strings and 
those that are valid in .NET Framework programming. For example, in Find Replace, the braces notation {} is used 
for tagged expressions. So the expression zo{1} matches all occurrences of zo followed by the tag 1, as in Alonzo1 
and Gonzo1. But within the .NET Framework, the notation {} is used for quantifiers. So the expression zo{1} 
matches all occurrences of z followed by exactly one o, as in "zone" but not in "zoo." 

Regular Expressions for Find and Replace: 

The following are the regular expressions available in the Reference List. 

Expression Syntax Description 

Any character . Matches any single character except a line break. 

Zero or more * Matches zero or more occurrences of the preceding expression, making all possible 
matches. 

One or more + Matches at least one occurrence of the preceding expression. 

Beginning of line ^ Anchors the match string to the beginning of a line. 

End of line $ Anchors the match string to the end of a line. 
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Expression Syntax Description 

Beginning of word <  Matches only when a word begins at this point in the text. 

End of word >  Matches only when a word ends at this point in the text. 

Line break \n Matches a platform-independent line break. In a Replace expression, inserts a line 
break. 

Any one character in 
the set 

[] Matches any one of the characters within the []. To specify a range of characters, list the 
starting and ending character separated by a dash (-), as in [a-z]. 

Any one character not 
in the set 

[^...] Matches any character not in the set of characters following the ^. 

Or | Matches either the expression before or the one after the OR symbol (|). Mostly used 
within a group. For example, (sponge|mud) bath matches "sponge bath" and "mud 
bath." 

Escape \ Matches the character that follows the backslash (\) as a literal. This allows you to find 
the characters used in regular expression notation, such as { and ^. For example, \^ 
Searches for the ^ character. 

C/C++ Identifier :i Matches the expression ([a-zA-Z_$][a-zA-Z0-9_$]*). 

Quoted string :q Matches the expression (("[^"]*")|('[^']*')). 

Space or Tab :b Matches either space or tab characters. 

Integer :z Matches the expression ([0-9]+). 

Additional Regular Expressions 

The list of all regular expressions that are valid in find and replace operations is longer than can be displayed in the 
Reference List. You can also insert any of the following regular expressions into a Find what string: 

Expression Syntax Description 

Minimal zero or more @ Matches zero or more occurrences of the preceding expression, matching as few 
characters as possible. 

Minimal one or more # Matches one or more occurrences of the preceding expression, matching as few 
characters as possible. 

Repeat n times ^n Matches n occurrences of the preceding expression. For example, [0-9]^4 matches any 
4-digit sequence. 

Grouping () Groups a subexpression. 

nth tagged text \n In a Find or Replace expression, indicates the text matched by the nth tagged 
expression, where n is a number from 1 to 9. 

In a Replace expression, \0 inserts the entire matched text. 

Right-justified field \(w,n) In a Replace expression, right-justifies the nth tagged expression in a field at least w 
characters wide. 

Left-justified field \(-w,n) In a Replace expression, left-justifies the nth tagged expression in a field at least w 
characters wide. 
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Expression Syntax Description 

Prevent match ~(X) Prevents a match when X appears at this point in the expression. For example, 
real~(ity) matches the "real" in "realty" and "really," but not the "real" in "reality." 

Alphanumeric character :a Matches the expression ([a-zA-Z0-9]). 

Alphabetic character :c Matches the expression ([a-zA-Z]). 

Decimal digit :d Matches the expression ([0-9]). 

Hexadecimal digit :h Matches the expression ([0-9a-fA-F]+). 

Rational number :n Matches the expression (([0-9]+.[0-9]*)|([0-9]*.[0-9]+)|([0-9]+)). 

Alphabetic string :w Matches the expression ([a-zA-Z]+). 

Escape \e Unicode U+001B. 

Bell \g Unicode U+0007. 

Backspace \h Unicode U+0008. 

Tab \t Matches a tab character, Unicode U+0009. 

Unicode character \x#### 
or 
\u#### 

Matches a character given by Unicode value where #### is hexadecimal digits. You can 
specify a character outside the Basic Multilingual Plane (that is, a surrogate) with the 
ISO 10646 code point or with two Unicode code points giving the values of the 
surrogate pair. 

Standard Unicode Character Properties 

The following table lists the syntax for matching by standard Unicode character properties. The two-letter 
abbreviation is the same as listed in the Unicode character properties database. These may be specified as part of 
a character set. For example, the expression [:Nd:Nl:No] matches any kind of digit. 

Expression Syntax Description 

Uppercase letter :Lu Matches any one capital letter. For example, :Luhe matches "The" but not "the". 

Lowercase letter :Ll Matches any one lower case letter. For example, :Llhe matches "the" but not "The". 

Title case letter :Lt Matches characters that combine an uppercase letter with a lowercase letter, such as Nj 
and Dz. 

Modifier letter :Lm Matches letters or punctuation, such as commas, cross accents, and double prime, 
used to indicate modifications to the preceding letter. 

Other letter :Lo Matches other letters, such as gothic letter ahsa. 

Decimal digit :Nd Matches decimal digits such as 0-9 and their full-width equivalents. 

Letter digit :Nl Matches letter digits such as roman numerals and ideographic number zero. 

Other digit :No Matches other digits such as old italic number one. 

Open punctuation :Ps Matches opening punctuation such as open brackets and braces. 

Close punctuation :Pe Matches closing punctuation such as closing brackets and braces. 
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Expression Syntax Description 

Initial quote 
punctuation 

:Pi Matches initial double quotation marks. 

Final quote punctuation :Pf Matches single quotation marks and ending double quotation marks. 

Dash punctuation :Pd Matches the dash mark. 

Connector punctuation :Pc Matches the underscore or underline mark. 

Other punctuation :Po Matches (,), ?, ", !, @, #, %, &, *, \, (:), (;), ', and /. 

Space separator :Zs Matches blanks. 

Line separator :Zl Matches the Unicode character U+2028. 

Paragraph separator :Zp Matches the Unicode character U+2029. 

Non-spacing mark :Mn Matches non-spacing marks. 

Combining mark :Mc Matches combining marks. 

Enclosing mark :Me Matches enclosing marks. 

Math symbol :Sm Matches +, =, ~, |, <, and >. 

Currency symbol :Sc Matches $ and other currency symbols. 

Modifier symbol :Sk Matches modifier symbols such as circumflex accent, grave accent, and macron. 

Other symbol :So Matches other symbols, such as the copyright sign, pilcrow sign, and the degree sign. 

Other control :Cc Matches Unicode control characters such as TAB and NEWLINE. 

Other format :Cf Formatting control character such as the bi-directional control characters. 

Surrogate :Cs Matches one half of a surrogate pair. 

Other private-use :Co Matches any character from the private-use area. 

Other not assigned :Cn Matches characters that do not map to a Unicode character. 

Additional Properties 

In addition to the standard Unicode character properties, the following additional properties may be specified as 
part of a character set. 

Expression Syntax Description 

Alpha :Al Matches any one character. For example, :Alhe matches words such as "The", "then", 
and "reached". 

Numeric :Nu Matches any one number or digit. 

Punctuation :Pu Matches any one punctuation mark, such as ?, @, ', and so on. 

White space :Wh Matches all types of white space, including publishing and ideographic spaces. 
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Expression Syntax Description 

Bidi :Bi Matches characters from right-to-left scripts such as Arabic and Hebrew. 

Hangul :Ha Matches Korean Hangul and combining Jamos. 

Hiragana :Hi Matches hiragana characters. 

Katakana :Ka Matches katakana characters. 

Ideographic/Han/Kanji :Id Matches ideographic characters, such as Han and Kanji. 

See Also: 

Â Wildcards 

Â Find Replace 

Â Find in Files  

Â Replace in Files 

  

Wildcards 

The following expressions can replace characters or digits in the Find what field of the Find and Replace window. 

To enable the use of regular expressions in the Find what field during find and replace operations, select Use > 
Wildcards under Find Options. 

The triangular button next to the Find what field displays a list of the available wildcards. When you choose any 
item from the Reference List, it is inserted into the Find what string. 

 
 

Wildcards for Find and Replace: 

The following are the wildcards available in the Reference List. 
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Expression Syntax Description 

Any single 
character 

? Matches any single character. 

Any single digit # Matches any single digit. For example, 7# matches numbers that include 7 followed by another 
number, such as 71, but not 17. 

Characters not 
in set 

[! ] Matches any one character that is not specified in the set. 

Escape \ Matches the character that follows the backslash (\) as a literal. This allows you to find the 
characters used in wildcard notation, such as * and #. 

One or more 
characters 

* Matches any one or more characters. For example, new* matches any text that includes "new", 
such as newfile.txt. 

Set of 
characters 

[ ] Matches any one of the characters specified in the set. 

See Also: 

Â Regular Expressions 

Â Find Replace 

Â Find in Files 

Â Replace in Files 

  

Find Results 

The Find Results window displays matches found when using the Find in Files and Replace in Files dialogs. 

 
 

There are two Find Results windows. The Result options allow you to choose the Find Results window where any 
matches found will be listed. The selected Find Results window opens automatically whenever matches are found. 

To Display Find Results Window Manually: 

Select Find Results from the View menu and choose Find Results 1 or Find Results 2. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 208 

To Select to a Match: 

Double-click any line in the results list. The source file is displayed in the Text Editor with the insertion point placed 
where the matched text begins. A symbol appears in the indicator margin of the Editor to mark the line that includes 
the match, and the status bar displays its full text. 

See Also: 

Â Text Editor 

Â Find in Files  

Â Replace in Files. 

  

Search Result 

The Search Result dialog displays informational messages for search results as part of Find. 

 
 

This dialog will only display when you select the option under Text Editor Options. 

You can disable this dialog by de-selecting the Always show this message check box. 

The messages you may see with this dialog include: 

Â The following specified text was not found: xxxx 

Â Find reached the starting point of the search. 

Â No more occurrences found in the specified documents. 

Â # occurrence(s) replaced. 

See Also: 

Â Text Editor 

Â Find Replace 

Â Text Editor Options 
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Go To Line 

The Go To Line dialog is used to go to a specific line of code. 

 
 

To Open the Dialog: 

Press [Ctrl] + [G] or select Go To from the Edit menu. 

To Go to a Specific Line: 

Type the line number and click OK. 

The cursor goes to the specified line number. 

See Also: 

Â Text Editor 
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Design-Wide Resources 

The PSoC Creator Design-Wide Resources (DWR) system provides a single location to manage all the resources 
in your design. Such resources include pins, clocks, interrupts, DMA, etc. Each new design project provides a 
default design-wide resources file (<project>.cydwr) file with the same name as the project. 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

 
 

Only design projects can have a <project>.cydwr file, and there can be only one file per design project. All 
modifications to the DWR information are stored in this file. This design-level information is stored in a way that 
makes it portable between devices. 

Note During the process of selecting a different device, if any errors will exist if the selection were to continue, you 
will be prompted before the device selection has actually changed. At this point, you can cancel the device change 
or continue and the appropriate errors will be generated. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 211 

To Open the <project>.cydwr File: 

If not already displayed, open the Source tab of Workspace Explorer for a design project. 

The <project>.cydwr file is located in the project tree, under the project's TopDesign.cysch file.  

 
 

Double-click the appropriate resource to open its editor. 

The file opens as a tabbed document in the work area, and it allows you to access the other design-wide resources 
in your project. 

You can switch between the different resources by clicking the appropriate tab, but you can only edit one resource 
at a time. 

To Add a <project>.cydwr File to a Design Project: 

You cannot copy or cut the <project>.cydwr file from within PSoC Creator directly; however, you can add the file as 
an existing item to another design project. You can also add a new .cydwr file to a design project. 

Â Add Existing Item ï Adds an existing .cydwr file to the design project. The file will be copied from the selected 
location into the design projectôs folder. It will also be renamed to match the project name. 

Â Add New Item ï Adds a new .cydwr file to the design project. If one already exists, a message will display to 
ask if you want to overwrite the file. 

To Delete/Exclude a <project>.cydwr File: 

You can delete the <project>.cydwr file or exclude it from your project. If no <project>.cydwr file exists inside the 
project, only default values will be used and you cannot edit them. 

See Also: 

Â Pin Editor 

Â Analog Device Editor 

Â Clock Editor 

Â MFT Editor 
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Â Interrupt Editor 

Â DMA Editor 

Â System Editor 

Â Directives Editor 

Â Flash Security Editor 

Â EEPROM Editor 

  

Pin Editor 

The Pin Editor consists of an interactive image of the selected device, as well as a table of available signals in your 
design. This editor allows you to manually assign and/or lock pins in your device before PSoC Creator executes the 
place and route operation of the build process. If you don't assign pins, or if you manually unassign them, PSoC 
Creator will automatically assign them during the next build. Assigned and locked pins will stay in the same location 
for each subsequent build. Unlocked pins could potentially be moved on subsequent builds, depending on resource 
usage. 

 
 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

To Open the Pin Editor: 

Double-click the .cydwr file in the Source tab of Workspace Explorer. 
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The file opens as a tabbed document in the work area, and it allows you to access the various design-wide 
resources in your project. The Pin Editor (Pins tab) displays on top by default. If another editor is displayed, click 
the Pins tab to bring it to the top. 

Device Image: 

The selected device image shows the various pins and ports. Each pin contains its corresponding pin number. 
Each pinôs functionality (i.e., Vcc, n/c, etc.) or port name displays next to or inside the pin. Hovering the mouse over 
a particular pin will show all of the capabilities of that pin. 

Perimeter vs. Ball Grid Array 

For TQFP, QFN, and SSOP/SOIC devices, the Pin Editor shows the pins in a perimeter view. For BGA/CSP 
devices, it shows the pins using a ball grid array view. The following image shows an example of each view. 

 
 

The coloring of the pins, as well as the port/pin numbers and labels are the same for both views. The process for 
assigning and locking pins is also the same for both views. However, for the perimeter view, any assigned signal 
name displays adjacent to the pin, but it doesn't for the ball grid array view. 

Pin Coloring and Style 

The style of the pin can help identify certain characteristics of the pin, as described in the following tables. 

Static Image 

Pin Style Description 

Text Color Black with white text indicates this is a no-connect pin. 

Text Color Dark green with white text indicates this is a power pin. 

Text Color 
Orange with white text indicates this is a reserved pin. The reason the pin is reserved (that is, used for 
debugging, used for external crystal, etc.) will be displayed next to the pin in orange. 

Text Color White with black text and a light gray border indicates an unassigned port pin. 

Text Color Light blue with black text and a black border indicates an assigned, unlocked, port pin. 

Text Color Dark blue with black text and a black border indicates an assigned, locked, port pin. 
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Pin Style Description 

Text Color 
(or Text 
Color) 

Red with black or white text means this is an invalid pin assignment. Black text means that the current 
assignment is invalid, but it may be possible to assign other pins to this port; white text means the pin is either 
no-connect or power. This state could occur when switching the selected device after making some pin 
assignments. An error will be added to the Notice List for each invalid assignment. 

 

Pins that have signals assigned to them are drawn with a black border. 

  

Dragging a Pin 

Pin Style Description 

Text Color 
White with black text indicates that pin guidance information has not yet been calculated. This pin may or 
may not be a valid assignment once it has been calculated. 

Text Color Green with black text indicates this is a valid (recommended) assignment. 

Text Color 
Yellow with black text indicates this is a valid assignment, but there is a consequence if you select it  (for 
example, resource usage). 

Text Color (or 
Text Color) 

Gray with black or white text means this is a not a legal pin assignment due to silicon or design constraint. 

 

Pins that have signals assigned to them are drawn with a black border. 

  

Signal Table: 

The signal table contains all the signals in a table format with the following columns: 

Column Description 

(Status) 
If assigned, this contains an indicator for the assignment's validity, as shown in the table under Dragging a Pin. 
If an illegal assignment has been made (and locked), there will be an error icon for that signal. 

Name The name of the signal as defined for the pin. If the pin has an alias, it is shown in parentheses. 

Port 
The device's pin shown in port form. This field can also be used to make a pin assignment by selecting the 
desired port[pin] from the drop-down list. An asterisk (*) indicates that a particular assignment is preferred. An 
empty cell indicates no assignment has been made.  

Pin 
The device's pin number for the device to which this signal is assigned. This field can also be used to make a 
pin assignment by selecting the desired pin number from the drop-down list.  An asterisk (*) indicates that a 
particular assignment is preferred. An empty cell indicates no assignment has been made. 

Lock 
Specifies whether or not the signalôs assignment is locked (i.e., cannot be moved by a build). This cell is only 
editable for assigned pins. 

  

Signals can be displayed in one of the following states: 

Â Assigned and Locked ï A signal that has been assigned and locked to a particular pin is displayed in the table 
as a dark blue row. 

Â Assigned and Unlocked ï A signal that has been assigned but not locked is displayed in the table as a light 
blue row. 

Â Unassigned ï Signals that have not been assigned are white. This will be auto-assigned by PSoC Creator on 
the next build. 

Note Double-clicking a row in the table will display the design containing the associated Pins Component, and open 
the Configure dialog for it. 
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To Assign a Pin: 

Assign a pin using either of the following methods: 

Â Click on a signal in the Signal Table or on a pin already assigned elsewhere on the device and drag it to the 
desired location on the device image. 

Note While dragging a pin, a tooltip will indicate whether or not the current location is valid in addition to the 
coloring noted above. 

Â Select an assignment from the Pin column pull-down menu in the Signal Table. You can also type the pin 
assignment in the field. While typing, legal assignments that are still possible based on what has currently been 
typed will display. Values are entered in the form of: 

Ǐ P#[#] ï Specifies a location where the first # is the port number and the second # is the offset within the 
port. 

Ǐ P#[#:#] ï Specifies a range of locations where the first # is the port number, the second number is the 
offset within the port where the MSB of the signal should be placed, and the last # is the offset within 
the port where the LSB of the signal should be placed. 

Ǐ A range can also be specified as any combination of the above two formats separated by commas. 

To Unassign a Pin: 

Unassign a pin using either of the following methods: 

Â Right-click on an assigned pin on the device image and select Auto-assign <signal> during build. 

Â Select the <Auto-assign during build> row from the Port or Pin column pull-down menu in the Signal Table. 

To Unassign All Pins: 

Right-click anywhere in the device image section of the Pin Editor and select Auto-assign all during build. 

To Lock a Pin: 

Lock a pin using either of the following methods: 

Â Manually assign a pin; it will be locked by default. 

Â If a pin is assigned but not locked, right-click on the pin in the device image and select Lock <signal> or select 
the Lock check box in the table for the desired signal. 

On the right-click menu, the Lock All option will lock all assigned pins. 

To Unlock a Pin: 

Right click on the pin in the device image and select Unlock <signal> or de-select the Lock check box in the table 
for the desired signal. 

On the right-click menu, the Unlock All option will unlock all locked pins. 
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To Scroll, Pan, and Zoom: 

If device image is too large, scroll bars will display to allow you to see other areas of the device. Use these 
techniques as appropriate: 

Â To auto-scroll, drag a signal to the edge of the device image. 

Â Use the mouse wheel to scroll up and down; press [Shift] + mouse wheel to scroll left and right. 

Â To pan, press [Alt] + left click and drag. 

Â To zoom, press [Ctrl] + mouse wheel. 

See Also: 

Â Mapper, Placer, Router 

Â Design-Wide Resources 

  

Analog Device Editor 

The Analog Device Editor provides an interconnect view of the PSoC device along with place-and-route results for 
a particular design. The editor also allows for manual place-and-route with the ability to lock-down all or some of the 
results. 

 
 

It operates in two separate modes: 

Â Design ï shows the results of a build in design mode (this is default mode of the tool) 

Â Debug ï provides a view into the current state of the device while debugging (see Analog Device Editor 
Debugging) 
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The Analog Device Editor contains three major sections: analog interconnect diagram, design information table, 
and properties. 

Analog Interconnect Diagram: 

The analog interconnect diagram shows how various analog Components, wires, switches, and pins are laid out on 
the device and how they may be connected. Unused resources are shown as gray. Used resources are shown as 
black if they are not selected. If a used Component or pin is selected, it is shown as blue. Selected routes and 
switches are shown as the color chosen in the table. The following image shows the Legend used for the 
interconnect diagram. 

 
 

If you hover the cursor over used resources, tooltips display relevant information. This same information will be 
displayed in the Properties area when the resource is selected. 

Wires 

Wires can be locked (cannot move between builds). This includes resources locked by MARS Components and 
control files (even though the editor can over-ride those placements). Locked wires are solid lines; unlocked wires 
are dashed lines. 

Wires locked in the Analog Device Editor can also be unlocked. Wires locked by other sources must be unlocked by 
those sources. 

Switches 

Switches are displayed as circles. A solid color means the switch is closed. White means the switch is open. Gray 
means the state is not known. 

Â In design mode, the check box selections in Properties for muxes control the display of run-time changeable 
switches. 

Â In debug mode, the state is based on the value of the actual register and can be edited from the GUI. If the mux 
that ñownsò the switch is hardware-controlled it is displayed in gray when debugging. 

Note: DMA access to a software-controlled AMux will potentially cause the debugger to show erroneous states. 

Switch breakpoints are shown by a dotted/dashed line around the switch. If the breakpoint is enabled the line is red; 
if disabled, it is amber. 

Switches are grouped within the device and this shall be shown by a dotted box around the circles. These groups 
allow either at-most-one active terminal or any number of active terminals. The latter shall be distinguished in the 
diagram with a gray fill in the surrounding box. 
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Pins and Components 

Locked pins and Components include a small pad-lock icon. 

Digital pins used in the design are shown with a black background, white text, and teal ñtipsò. However, no routing 
information is shown for digital pins. 

Design Information Table: 

The columns have the following headings. 

Â Name refers to the instance name. 

Â Lock is a check box coercing the item to use the associated resource. It is possible to lock or unlock all listed 
items in the Lock column using the pull-down menu, as follows: 

 

 

Â Lock All ï Lock all routes in the design. 

Â Unlock All ï Unlock all routes in the design. 

Â Lock selection ï Locks/unlocks the selected route. Locked routes 
are shown as solid lines; unlocked routes are shown as dashed 
lines. 

Â Unlock selection ï Marks the selected wire as unused. See Route 
Editing. 

Â Cleanup... ï Opens the Locked Route Cleanup dialog to remove 
locked net information that is no longer applicable to the current 
design. 

 

  

Â Color allows the user to choose a display color in the Interconnect panel, from a pull-down, for a routing 
resource. Note that it is common for resources to be displayed multiple times (for example, when a net 
connects a pin to an analog resource in the top schematic), and so changing the color in one place requires a 
(silent) change everywhere else. 

Â Type is the Component name (e.g. ñPGA_v1_70ò) or resource type (i.e. ñMUXò or ñNETò). 

The entries in the table are listed alphabetical order by instance name and only that column may be used to change 
the order of entries. 

Each entry (Components, pins and muxes) is expandable/collapsible to show lower levels of the Component 
hierarchy and the resources to which they are connected. 

There are buttons at the top of the table to toggle on and off viewing selected items: Components, Muxes, and 
Pins. 

Properties: 

The Properties area displays information based on the selection in the table or diagram. If you select multiple 
items, the area will not show any information. The area displays differently if you select pins/Components versus 
muxes. 
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Component/Pins View 

For Components and pins, this area displays various read-only properties depending on what is selected. The 
properties that can be displayed include the following: 

Â Net name (for nets only) 

For a named a wire in the schematic, the tool displays that name. When the schematic wire is un-named, it 
displays a machine-generated net name. 

Â Drive mode (for pins only) 

Â Component name 

Â Resource name 

Â Lock status 

Use the buttons at the top of the panel to order the properties alphabetically or by category. 

Mux View 

For muxes, the Properties area displays an editable image of the selected mux to choose the active channels in 
the interconnect diagram and Ohm Meter. If the target is a differential mux then making a channel active always 
applies to both connections. 

  
 

The diagram includes check boxes to choose the active channels(s) of the mux. It also shows the net names 
associated with each channel and the common terminal. The coloring for each net will be the same as that chosen 
in the table. When you select and de-select a channel, the change is reflected in the interconnect diagram and the 
Ohm meter. 

Use the Check All and Uncheck All buttons at the top of the panel to select all or de-select all channels, 
respectively. 

Note If the AtMostOneActive parameter is set to "true," then you can only select one channel and the Check All 
button will be disabled. 

See Also: 

Â Analog Device Editor Context Menus 
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Â Ohm Meter 

Â Manual Placement 

Â Route Editing 

Â Analog Device Editor Debugging 

Analog Device Editor Context Menus 

The Analog Device Editor contains various commands available on right-click ï or context ï menus. The commands 
available will vary depending on whether you right-click on a pin, Component, or signal. You can right-click on items 
in the interconnect diagram and in the table. The following are the commands available: 

On Component: 

 

Â Go to <Component> in schematic ï Opens the selected 
Component in the Schematic Editor.  

Â Start Ohm meter ï Opens the Ohm Meter to the selected 
signal. 

Â Lock to/Unlock From <Location>  ï Toggles lock/unlock for 
this Component to/from the existing location. 

Â Relocate ï Allows you to move the selected primitive to 
another location. This option is disable if no other valid 
locations are available. See also Manual Placement. 

Â Lock All ï Lock all routes in the design. 

Â Unlock All ï Unlock all routes in the design. 

Â Copy ï Copies the interconnect diagram to a bitmap file that 
you can paste in an appropriate editor. 

Â Select All ï Selects everything on the interconnect diagram. 

On Pin: 

 

Â Go to <Pin> in schematic ï Opens the selected pin in the 
Schematic Editor. . 

Â Start Ohm meter ï Opens the Ohm Meter to the selected pin. 

Â Lock to/Unlock from <Location>  ï Locks/unlocks this pin 
to/from the existing location. 

Â Go to in pin editor ï Opens the Pin Editor and selects the same 
pin. 

Â Lock All ï Lock all routes in the design. 

Â Unlock All ï Unlock all routes in the design. 

Â Copy ï Copies the interconnect diagram to a bitmap file that you 
can paste in an appropriate editor. 
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Â Select All ï Selects everything on the interconnect diagram. 

On Wire: 

 

Â Lock route ï Locks/unlocks the selected route. Locked routes are shown as 
solid lines; unlocked routes are shown as dashed lines. 

Â Rip up ï Marks the selected wire as unused. See Route Editing. 

Â Re-route ï Switches the Analog Device Editor to Manual Routing mode. 
See Route Editing. 

Â Remove obsolete "Entire Net" route data ï Removes nets that were 
locked as part of an entire net when you change the schematic. 

Â Lock All ï Lock all routes in the design. 

Â Unlock All ï Unlock all routes in the design. 

Â Copy ï Copies the interconnect diagram to a bitmap file that you can paste 
in an appropriate editor. 

Â Select All ï Selects everything on the interconnect diagram. 

On Switch: 

 

Â Add/Edit breakpoint ï Used to add or edit breakpoints. See Analog Device 
Editor Debugging. 

Â Lock route ï Locks/unlocks the selected route. Locked routes are shown as 
solid lines; unlocked routes are shown as dashed lines. 

Â Rip up ï Marks the selected wire as unused. See Route Editing. 

Â Re-route ï Switches the Analog Device Editor to Manual Routing mode. 
See Route Editing. 

Â Lock All ï Lock all routes in the design. 

Â Unlock All ï Unlock all routes in the design. 

Â Copy ï Copies the interconnect diagram to a bitmap file that you can paste 
in an appropriate editor. 

Â Select All ï Selects everything on the interconnect diagram. 

See Also: 

Â Analog Device Editor 

Â Schematic Editor 

Â Pin Editor 

Â Ohm Meter 

Â Manual Placement 
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Â Route Editing 

Â Analog Device Editor Debugging 

  

Ohm Meter 

The Ohm Meter displays the resistance between pairs of points (pins and/or Components but not wires or switches) 
in the Analog Device Editor interconnect view. The dialog allows you to change probe points in the diagram and see 
the parasitics. The dialog also contains SPICE route data. 

 
 

Probes are displayed in the interconnect diagram with an attached pin. The first-placed pin is pink and, when it is 
placed, all legal destination probe points are automatically marked with blue probes. Select a blue pin to see the 
resistance for that route. Re-selecting the start-point for probing clears previous probes, clears the dialog results, 
and refreshes the legal destination (blue) probes. 

To Open the Ohm Meter: 

Right-click on a pin or Component in the diagram or the table and select Start Ohm Meter >. Then point to the 
access point from which to start. 
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Parasitic Tab: 

This tab displays the resistance between the two points when you click a blue pin in the diagram. This includes the 
total resistance and the resistance of every switch in the route. 

 
 

The Access Point pull-down menu allows you to change the second selected pin as an alternative to clicking on 
different blue pins. 

SPICE Tab: 

This tab shows a SPICE netlist for the route. This is read-only text. 

 
 

Use the Copy to Clipboard button to copy the data to a simulator of your choice. 

See Also: 

Â Analog Device Editor 
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Manual Placement 

The Analog Device Editor manual placement feature allows you to specify where analog Components should be 
placed when a build is performed. You cannot use this feature to place pins. Instead you must use the Pin Editor. 

To Manually Place a Component: 

Right-click on a Component and select Relocate >. Then point to the desired location. The menu will only allow 
valid moves. If no move is available, the menu item will be disabled. 

 
 

You may move a Component to a currently occupied location. The existing Component will be placed in a new 
location by the subsequent build. 

Signal Routing 

After selecting the new location, the routed signals will be redrawn in a temporary state, also known as a rat's nest. 
This is only shown if the route is selected. 

 
 

During a build, the routing will updated to follow allocated signals. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 225 

Resource Locking 

All Component moves result in the resource being locked. The Component will be shown with a lock symbol.  

To unlock the resource, right-click on the Component and select Unlock from <location>. 

If you unlock the resource before doing a build, the unlock action will move the Component back to its original 
location. 

If you unlock the resource after doing a build, the icon will remain until you do another build, because the editor 
interprets the lock being in place from an external source. 

See Also: 

Â Analog Device Editor 

Â Pin Editor 

Â Context Menus 

Â Route Editing 

  

Route Editing 

Route editing consists of ripping up routes and re-routing signals, as well as manually selecting switches to route 
signals. Context Menus are included on various elements to facilitate route editing. 

Rip-Up 

Â Nets ï When a net is ripped up, the wires and switches used to route the net are marked as unused 

Â Net-Ties/Net-Joins ï When a Net-Tie or Net-Join is selected, you can rip up the entire net or any of the sub-
nets collected to form the entire net. Ripping up any of the sub-nets is the same as ripping up a net. Ripping up 
the entire net causes all of the individual sub-nets to be ripped up, as well as the additional resources used to 
implement the net-tie and net-join Components. 

Â Muxes ï Rip-up of a mux is applied to the entire mux. When a mux is ripped up, all of the wires and switches 
used to route the mux are marked as unused. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 226 

Re-Route 

When you select the Re-Route command, the Analog Device Editor enters manual route editing mode. In this 
mode, you can manually route signals by clicking on switches to open or close them. Switches available for routing 
are shown highlighted in the default color; switches not available are grey. When you select a switch to route a 
signal, addition switches become available to select. 

 

 

 

 

Open switches are shown as hollow circles; closed switches are shown as solid circles. 

While editing, the Status Bar shows the operation in progress. 

Two buttons are available: Commit Edit or Cancel Edit. "Commit" saves and locks the routing; "Cancel" reverts 
the Analog Device Editor the state prior to editing. 

Mux Routes 

Editing a mux arm is similar to editing a signal net with the following differences: 

Â The endpoints to be connected are nets rather than pins. 

Â When you start editing a mux, all of the resources used by the mux (for all arms) are temporarily marked as 
unused to allow the user maximum flexibility in reusing resources shared with other arms. 

Net-Ties and Net-Joins 

Editing net-ties and net-joins are similar to editing a mux. However instead of joining a single pair of nets, editing 
these may involve any number of sub-nets. 

Â The endpoints to be connected are nets rather than pins (like muxes). 

Â There are separate rip-up and edit operations since there is no resource sharing. 

See Also: 

Â Analog Device Editor 

Â Analog Device Editor Context Menus 
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Analog Device Editor Debugging 

The debug view in the Analog Device Editor allows users to view/modify the live state of the analog routing on the 
chip. The debug view will automatically become active when you start debugging. While in debug mode, the 
interconnect diagram background is yellow, and the label at the bottom right indicates that it is in debug mode. 

 
 

The Analog Device Editor will automatically go back to the design view when the debug session has stopped. 

Open/Close Switches: 

In debug view, you can use the context menu to open/close any switch that is not DSI controlled. Switches that are 
DSI controlled will be displayed with a grey center to indicate that they are ñused;ò however, PSoC Creator does not 
know the current state of the switch. 

Note Because the state of the Analog Device Editor can be changed without the CPU running, it may be out of 
date. Right-click on the interconnect diagram and select Refresh to update all visible debug windows. 

Switch Breakpoints: 

Breakpoints are implemented with the on-chip address breakpoint(s). The breakpoint applies to the whole register, 
which controls a number of switches and unrelated elements. The debugger determines whether the break 
occurred as a result of the switch-of-interest and ignores (continues execution) other changes. 
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To set a breakpoint, right-click on a switch. You can set the following conditions: on changed, on opened, on closed. 

 
 

Once select, the breakpoint displays in the Memory Watchpoint window. 

You can set multiple breakpoints in a signal register with a single breakpoint resource. If the maximum number of 
breakpoints has been reached (regardless of the use) and you try to set a new one, PSoC Creator will indicate that 
the break cannot be set until another breakpoint is cleared or disabled. 

See Also: 

Â Analog Device Editor 

Â Analog Device Editor Context Menus 

Â Memory Watchpoint 

Locked Route Cleanup 

The Locked Route Cleanup dialog that lets you clean up locked route information for nets where either the net no 
longer exists in the schematic, or is no longer locked due to schematic changes. You can selectively delete any of 
this data without unlocking anything else. 

 
 

To Open this Dialog: 

Select Cleanup... from the Locked pull-down menu in the Analog Device Editor table. 
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To Use this Dialog: 

Select one or more nets for which to remove locked route information,and click OK. 

You can also use the Select All or Deselect All buttons. 

See Also: 

Â Analog Device Editor 

  

Clock Editor 

The Clock Editor is a design-wide resources tool to create and edit clocks. This tool allows you to view all clocks, 
add and delete design-wide clocks, as well as edit design-wide and system clocks. 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

 
 

To Open the Clock Editor: 

Double click the Clocks icon in the Design-Wide Resources tree, located in the Source tab of Workspace Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the Clock Editor (Clocks tab) 
displayed on top. 
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Clock Editor Toolbar: 

The toolbar contains the following commands: 

Â Add Design-Wide Clock ï This command allows you to add a design-wide clock to your design. See Add/Edit 
Design-Wide Clock. 

Â Delete Design-Wide Clock ï This command allows you to delete any design-wide clocks you may have 
added. 

Â Edit Clock ï This allows you to edit design-wide clocks in your design. See Add/Edit Design-Wide Clock. 

Clock Table: 

The Clock Editor displays all the clocks using a table. By default, clocks are sorted by Type. You can sort by any 
column by clicking the column header and switch between ascending and descending order 

Note A secondary sort is always performed on the Nominal Frequency column. 

Column Description 

Type The clock type: 

¶ System ï internal and external clocks sources that can be used in your design 

¶ Design-wide ï clocks declared in the clock editor that are sharable across the entire design 

¶ Local ï clocks added to schematics via Components 

¶ Boost ï low voltage analog boost clock shown when the Variable Vdda option is selected in 
the System Editor. 

Name The name of the clock. 

If a clock is in an error state, an icon will display by the clock's name. Hovering over the icon will 
display a tooltip with a message describing the error. This errors will also be displayed in the Notice 

List Window. 

Domain Analog or Digital. This information is determined by PSoC Creator. 

Desired 
Frequency 

The desired frequency for the clock. If not used ó? MHzô will be displayed. 

Nominal 
Frequency 

The nominal frequency for the clock. This is determined by the system solving the clocks. If not 
solvable ó? MHzô will be displayed. 

Accuracy Displays the clockôs accuracy as a percent. 

Tolerance Displays the tolerance range entered for the clock as a percent. If no tolerance has been specified ó-ó 
will be displayed. 

Note Tolerance can only be specified for Auto clocks. 

Divider Displays the divider used for the clock. This may have been specified elsewhere or calculated when 
the clocks were solved. 

Start on Reset If checked, this option will cause the _Start() function to be called for the clock pre-main (checked by 
default). You can set this option for all óNewô local clocks and all design-wide clocks. 

There is a pull-down menu next to the column header, which allows you to check or uncheck all the 
applicable boxes at once. 

System clocks show this box as read-only. For them the value is determined by their enabled state in 
the Configure System Clocks dialog. óExistingô clocks also have this field as read-only. It displays the 
óStart on Resetô value for its source clock in this case. 

Source Clock The clock, if any, used to create the clock. Clocks whose input clock was not explicitly specified (i.e., 
<Auto> was selected) will be displayed as "Auto: Clock the solver picked." 
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Digital and Analog Clocks: 

PSoC Creator automatically figures out whether a user-created clock is digital or analog. It looks across the whole 
design at the fanout and if the clock drives analog primitives, it is an analog clock. If the clock does not connect to 
an analog primitive, it is assumed to be digital. If a clock connects to a mixture of digital and analog primitives, a 
DRC error is generated. 

Tolerance Support: 

PSoC Creator will support a robust system of clock accuracy and tolerance related DRCs. 

Local and design-wide clocks have the ability to add required tolerances (+X%, -Y% or +X ppm, -Y ppm). 

System clocks internal to the device display their accuracy information. System clocks that come from outside the 
device (e.g., XTAL, XTAL 32kHz, and Dig Sig) will allow you to enter accuracy statistics (+X%, -Y% or +X ppm, -Y 
ppm). The default accuracy values will be +0%, -0%. 

The PSoC Creator clock system will take the accuracy of the reference clock, the actual achieved frequency, and 
compare that against the tolerance and requested frequency. If the achieved frequency/accuracy falls outside the 
requested bounds, a DRC error will be generated. 

See Also: 

Â Configure Local Clock 

Â Configure System Clocks 

Â Add/Edit Design-Wide Clock 

Â Select Source Clock 

Â Clock Component Datasheet (available from the Component Catalog) 

Â Design-Wide Resources 
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Configure Local Clock 

The Configure clock dialog allows you to configure various characteristics for a local clock that you placed onto a 
schematic. Refer also to the Clock Component datasheet available from the Component Catalog. 

 
 

This dialog has the following main sections: 

Â Clock Name ï Allows you to type a name for the local clock. 

Â Configuration ï Allows you to specify characteristics for the clock. 

Â Summary ï Displays information about the clock being create and the source clock being used (if Source is 
not <Auto>). 

To Create a Local Clock: 

Create a local clock by dragging a clock Component form the Component Catalog onto a schematic. 

To Open the Dialog: 

Double-click the clock Component to open the Configure Clock dialog. 

To Configure a Local Clock: 

You can configure the local clock as follows: 

1. In Name, type a name for the clock or accept the default name. 

2. For Clock Type, select New or Existing. New clocks use device resources and have APIs generated for them. 
Existing clocks do not use hardware resources and do not have APIs generated for them; they are simply an 
alias to a clock already defined. 

3. Specify the Source configuration, as follows: 

Â Clock Type: New / Source: <Auto> ï Enter the Frequency and optionally a Tolerance range. PSoC Creator 
figures how to implement it. 
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Â Clock Type: New / Source: Specified ï Select a particular source clock from the pull down menu to divide 
down. Then enter a desired frequency or explicit divider. 

Ǐ If you specify a Desired Frequency, PSoC Creator calculates the divider automatically. 

Ǐ If you specify a Divider, PSoC Creator uses it as specified. 

Â Clock Type: Existing / Source: Specified ï Create an alias for the given source clock. 

You can view the clock characteristics for various clocks using the design-wide resources Clock Editor. 

See Also: 

Â Design-Wide Resources 

Â Clock Editor 

Â Component Catalog 

Â Clock Component Datasheet (open from the Component Catalog) 

  

Configure System Clocks 

The Configure System Clocks dialog provides a graphical diagram showing the various system clocks in the 
selected device for your design, as well as their relationship to each other. 

 
 

This dialog allows you to specify different characteristics about the system clocks. 
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Â A check mark indicates that the clock is enabled. When a clock is disabled it turns gray and its contents are 
replaced by text explaining how to enable it. Some clocks cannot be disabled. 

Â The lines show where clock signals can go. If a line is gray, then the current clock configuration does not use 
that path. 

Â The error icon   indicates that the clock is configured incorrectly. Hovering over the icon will display a 
message indicating exactly what is wrong. 

Note This dialog will contain different clocks and options depending on the device selected for the design. For 
some devices, this dialog will be split into different tabs for high-frequency and low-frequency clocks. 

For specific details about the configuration options for system clocks, refer to the appropriate Technical Reference 
Manual. 

  

Digital Signal: 

The Digital Signal can be configured to use any routed digital signal in your design. When using the output from a 
digital pin as the Digital Signal, you will need to ensure that the pin is configured with the input as unsynchronized. 
This is done via the Input tab in the Pins Component Configure dialog by deselecting the "Input Synchronized" 
option. For more information, refer to the Pins Component datasheet. 

To Open this Dialog: 

In the Design-Wide Resources Clock Editor: 

Â Double-click a system clock, or 

Â Select a system clock and click Edit Clock. 

To Enable/Disable a System Clock: 

Click the check box for the appropriate clock to enable or disable. 

Note Some clocks cannot be disabled. Their check boxes are dimmed. 

See Also: 

Â Design-Wide Resources 

Â Clock Editor 

Â Clock Component Datasheet (open from the Component Catalog) 

Â Pins Component Datasheet (open from the Component Catalog) 
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XTAL Configuration 

The XTAL Configuration dialog is used to configure characteristics for the external crystal. 

 
 

To Open the Dialog: 

Enable the XTAL on the System Clock Editor, and click the Configure button. 

To Configure the XTAL: 

Select/enter the appropriate fields and click OK. 

Fields: 

The following fields are used to configure the XTAL as needed. 

Frequency/Accuracy: 

Use these fields to specify the frequency and accuracy of the XTAL. 

Enable fault recovery: 

This check box enables fault recovery. Fault recovery allows the output of the XTAL to be switched from the XTAL 
clock to the IMO if the XTAL is detected to have stopped working properly. It uses the watchdog/error signal inside 
the XTAL. 

Note This field produces an error: "The XTAL clock cannot use fault recovery when it is also used by the IMO." 
when it is set to true and the XTAL sources the IMO. 

Enable oscillator voltage pumps: 

This check box controls the oscillator voltage pumps, via bit 3 (xpump_dis) of the FASTCLK_XMHZ_CSR register. 
This can be used to save power and reduce jitter. The check box is not selected by default, meaning this feature is 
not enabled. 
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Use default timeout: 

This check box is selected by default. It indicates whether the system will use the default timeout at startup, or a 
user-customized one. 

Â Startup timeout (ms) ï When using the default timeout, this field is read only and displays the default timeout 
value. If you deselect the Use default timeout check box, this field becomes enabled to specify a timeout 
based on specific XTAL requirements. 

Halt on XTAL startup error: 

This check box enables the ñwhile(1);ò code in the ECO error handler. It is enabled by default, and the application 
halts before main(). If you deselect this check box, the code will continue to main (and you are expected to handle 
the clock error appropriately). 

Note This field is ignored when the XTAL does not source the bus clock. No message will be shown if this occurs. 

Reference levels: 

Â Automatic ï This option is selected by default. Reference levels are calculated from the given XTAL 
frequency. The XTAL clock initialization uses these values to set the CFG1 register. 

Â Manual ï This option is used by advanced users. This enables the Feedback and Watchdog fields to fine tune 
the reference level configuration. The XTAL clock initialization uses these values in the CFG1 register. 

Ǐ Enable automatic gain control ï This check box enables automatic gain control (AGC). AGC 
measures oscillation amplitude and compares it to a reference value. If it is too high or low, an internal 
adjustment is made in the XTAL to increase or decrease amplitude. This reduces drive level and helps 
to meet crystal requirements. It is not needed in all cases. This check box is not selected by default. 
When it is selected, the Feedback field becomes visible under Watchdog. 

Ǐ Watchdog ï The watchdog (XERR/error detection) is a circuit that measures oscillation amplitude and 
compares it to a reference value. If it is too low, an error signal that goes to a status register bit is 
asserted. This bit can be polled in software, and also controls a mux that implements "fault recovery." 
The watchdog is used at XTAL startup to determine when oscillations have reached an acceptable 
amplitude, and the XTAL can be used as a clock source throughout the part. The watchdog reference 
level is the voltage to which the oscillation amplitude is compared when determining if oscillation is 
acceptable. 

Ǐ Feedback ï The feedback reference level is the voltage of which the oscillation amplitude is compared. 

Amplitude adjustment: 

Â Automatic ï This option is selected by default. The Amplifier Gain (AMPIADJ) field is calculated from the 
given XTAL frequency. This option allows you to specify Shunt capacitance and Load capacitance of the 
crystal. These will be used with the XTAL frequency to calculate the value of AMPIADJ, which the XTAL clock 
initialization uses to set the CFG0 register. 

Â Manual ï This option is used by advanced users. This enables the Amplifier Gain (AMPIADJ) field to 
manually enter a specific value for AMPIADJ. The XTAL clock initialization uses this value to set the CFG0 
register. 

See Also: 

Â Clock Editor 

Â Configure System Clocks 
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System Clock APIs 

System Clock APIs are provided with the cy_boot generated API files. System clock APIs are listed and described 
in the System Reference Guide. 

After a successful build, generated files are located in the Workspace Explorer, in a folder named 
"Generated_Source/<Architecture Name>/cy_boot". For more information about the build process, refer to 
Generated Files. 

See Also: 

Â System Reference Guide 

Â Workspace Explorer 

Â Generated Files 

  

Add/Edit Design-Wide Clock 

The Add/Edit Design-Wide Clock dialog allows you to add and edit various design-wide clocks in your design. 

 
 

Note Design-wide clocks use resources on the device and have APIs generated for them with a "Cy" prefix. 

To Open the Dialog: 

You open this dialog from the Clock Editor. 

Â Click Add Design-Wide Clock to open the dialog to create a new design-wide clock. 

Â Double-click an existing design-wide clock to open the dialog for editing. 
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To Configure Design-Wide Clock: 

You can configure the design-wide clock as follows: 

1. In Name, type a name for the clock or accept the default name. 

2. In Clock Type (PSoC 4/PSoC 6 only), select "New" or "Existing." 

3. In Source, select the type of source clock from the pull down menu. 

Â Selecting "<Auto>" allows you to specify the Desired Frequency and optionally the Tolerance. The source and 
divider are then calculated by PSoC Creator. 

Â Selecting "<Select Signal...>" opens the Select Source Clock dialog to select from a list of available signals. 

Â Selecting "<Select Pin...>" (PSoC 4/PRoC BLE devices only) opens the Select Source Clock (from Pin) dialog 
to select from a list of available pins. 

Â Selecting any other specific base clock allows you to specify the Desired Frequency or Divider, as follows: 

Ǐ If you specify a Desired Frequency, PSoC Creator calculates the divider automatically. 

Ǐ If you specify a Divider is selected, PSoC Creator uses it as specified. 

You can view the clock characteristics for various clocks using the design-wide resources Clock Editor. 

Note For PSoC 4/PRoC BLE devices, there is a Use fractional divider check box. If you specify the 
Frequency option, selecting the Use fractional divider check box means that PSoC Creator will calculate the 
fraction. If you specify the Divider option, this check box provides a manual option for you to specify the 
fraction. 

4. On the Advanced tab, specify whether or not to synchronize this clock with the MASTER_CLK (synchronize, 
by default). This tab is not applicable to PSoC 4/PSoC 6 devices. 

See Also: 

Â Design-Wide Resources 

Â Clock Editor 

Â Select Source Clock 

Â Select Source Clock (from Pin) 
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Select Source Clock 

The Select Source Clock dialog provides a tree view or a table view of the various signals (in alphabetical order) in 
your design from which you can select an input signal for a given clock. 

 
 

To be used as a clock input, a signal must meet all of the following requirements: 

Â The signal must be a digital signal. 

Â If the signal is from a terminal, the terminal must be at the Top Schematic level. 

Â If not at the Top Schematic level, then the signal must not be connected to a schematic terminal. 

To Open the Dialog: 

You can open this dialog as follows: 

Â From the Configure System Clocks dialog, click the ellipsis button [...] in the Digital Signal clock section. 

Â From the Add/Edit Design-Wide Clock dialog, under Source, choose the "<Select Signal...>" option in the pull 
down menu. (For PSoC 4/PRoC BLE devices, you must select Clock Type "Existing.") 

Signal Frequency: 

This field is used to specify the frequency of the selected signal. 

Accuracy: 

These fields are used to specify the accuracy of the selected signal. The value is always displayed as a percent, 
but can be entered as a % or ppm. 

Toolbar: 

The toolbar provides expand and collapse commands to show or hide the entire signal tree. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 240 

Show Un-named Signals: 

Select this check box to show all the signals in your design; de-select to show only named signals. 

See Also: 

Â Design-Wide Resources 

Â Clock Editor 

Â Add/Edit Design-Wide Clock 

Â Configure System Clocks 

  

Select Source Clock (from Pin) 

The Select Source Clock dialog provides a table view of the various pin signals (in alphabetical order) in your 
design from which you can select an input signal for a given clock. 

This dialog applies to PSoC 4/PRoC BLE devices only. 

 
 

To be used as a clock input, a signal must meet be a digital input pin. 

To Open the Dialog: 

Open this dialog from the Add/Edit Design-Wide Clock dialog. 

1. In Clock Type, select "Existing". 

2. In Source, choose the "<Select Pin...> option in the pull down menu. 

Signal Frequency: 

This field is used to specify the frequency of the selected signal. 
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Accuracy: 

These fields are used to specify the accuracy of the selected signal. The value is always displayed as a percent, 
but can be entered as a % or ppm. 

Toolbar: 

The toolbar provides expand and collapse commands to show or hide the entire signal tree. 

Table Fields: 

The signal table contains all the signals in a table format with the following columns: 

Column Description 

Name The name of the signal as defined for the pin. 

Port The device's pin shown in port form. This also indicates if the pins is unlocked. 

Pin The device's pin number for the device to which this signal is assigned.  

Alias When applicable, this shows an alternate name defined for a pin. 

Show Unlocked Pins: 

Select this check box to show any unlocked pins in your design. 

See Also: 

Â Design-Wide Resources 

Â Clock Editor 

Â Add/Edit Design-Wide Clock 
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MFT Editor (Certain FM Devices Only) 

For a certain set of FM devices, the multi-function timer (MFT) is a function block that enables three-phase motor 
control. In conjunction with a Programmable Pulse Generator (PPG) and an ADC, the MFT provides a variety of 
motor controls. The MFT Editor is a graphic representation that allows you to select and configure various blocks 
within the MFT, in order to generate the corresponding PDL code. 

 
 

To Open the MFT Editor: 

Double click the MFT icon in the Design-Wide Resources tree, located in the Source tab of Workspace Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the MFT Editor (MFTs tab) displayed 
on top. 

To Configure One or More Blocks: 

Select a block in the diagram or from the drop-down above the properties area. 

Use the properties area to configure the selected block(s).  

When you build the project, cymft_config.h and cymft_config.c files will be generated if any of the blocks in the MFT 
have a Configure property set to true.  

MFT Blocks: 

An MFT consist of the following blocks: 

Â Free-Run Timer (FRT) Unit ï An FRT is a timer function block that outputs counter values for the operational 
criteria of the function blocks in the MFT. The MFT employs 3 channels. 
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Â Output Compare Unit (OCU) ï An OCU is a function block that generates and outputs PWM signals on the 
basis of the counter values of the FRT. The OCU employs 6 channels (2 channels Ĭ 3 units). 

Â Waveform Generator (WFG) Unit ï A WFG is a function block that is located downstream from the OCU and 
generates signal waveforms for motor control from OCU output (RT0 to RT5) signals and PPG signals. The 
WFG employs 3 channels. 

Â Noise Canceller (NZCL) Unit ï An NZCL is a function block that generates DTIF interrupts to the CPU from 
external input signal (DTTIX signal) for motor emergency shutdown. The NZCL employs 1 channel. 

Â Input Capture Unit (ICU) ï An ICU is a function block that captures the FRT count value and generates an 
interrupt in the CPU when a valid edge is detected in an external input pin signal. The ICU employs 4 channels 
(2 channels Ĭ 2 units). 

Â ADC Start Compare (ADCMP) Unit ï An ADCMP is a function block that generates AD conversion start 
signals on the basis of the FRT counter value. The ADCMP employs 6 channels. 

  

Interrupt Editor 

The Interrupt Editor allows you to change the priority of interrupt service routines (ISRs) in your design. This editor 
is part of the design wide resources file, which includes other resources, such as the Clock Editor. 

There is difference between non-multi-core devices (PSoC 3/PSoC 4/PSoC 5LP) and multi-core devices (some 
PSoC 6). 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

Non-Multi-Core Devices 

For most devices, the Interrupt Editor looks similar to the following. 
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The Interrupt Editor contains a table with the following columns: 

Â Instance Name ï The instance name is also used as the ISR name. This property is read-only in the table. 

Â Interrupt Number ï This information (interrupt number) will only be available after place-and-route. This 
property is read-only in the table. 

Â Priority ï This is used to enter the interrupt priority. The valid range is displayed in the header. The smaller the 
number, the higher priority. 

If changing devices results in an illegal value, then an error icon will be displayed in the instance name cell. An error 
will also be placed in the Notice List window. 

Multi-Core Devices 

For multi-core devices, such as some PSoC 6 devices, there are separate tabs and editors for each core. For non-
multi-core PSoC 6 devices, the System Editor is the same as above. 

 
 

The Interrupt Editor contains a table with the following columns: 

Â Instance Name ï The instance name is also used as the ISR name. This property is read-only in the table. 

Â Interrupt Number ï This information (interrupt number) will only be available after place-and-route. This 
property is read-only in the table. A deep sleep wakeup capable image is disabled when assigned to a deep 
sleep capable location. 

Â Enable [Per Core] ï Provides a checkbox to enable an interrupt in a particular core. The priority and vector 
values can only be set for cores where the interrupt is enabled. The arrow on the header of this column can be 
used to check all/uncheck all. 

Â Priority [Per Core] ï This is used to enter the interrupt priority. The valid range is displayed in the header. 
Note: smaller numbers equal higher priority. 
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Â Vector [Per Core if Applicable] ï Some cores do not have enough vectors to support all interrupts on the 
device. This column allows mapping an interrupt into a specific location. A deep sleep wake-up capable image 
is displayed when assigned to a deep sleep capable location and the interrupt number is also deep sleep 
capable.  

If changing devices results in an illegal value, then an error icon will be displayed in the instance name cell. An error 
will also be placed in the Notice List window. 

To Open the Interrupt Editor: 

Double click the Interrupts icon in the Design-Wide Resources tree, located in the Source tab of Workspace 
Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the Interrupt Editor (Interrupts tab) 
displayed on top. 

To Change Priority: 

Enter a value for the appropriate interrupt in the text box. 

See Also: 

Â Design-Wide Resources 

Â Interrupt Component Datasheet (open from the Component Catalog) 

  

DMA Editor 

The DMA Editor displays all the direct memory access (DMA) Components that have been directly placed in the 
design, as well as all the DMA Components ñinsideò placed Components. 

Note The DMA Editor does not display for devices that do not have DMA. 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 
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The DMA Editor consists of a table where each row represents a DMA instance. The table contains the following 
columns: 

Â Name ï The name of the DMA instance. This property is specified in the Component Configure dialog and is 
read-only in the table. 

Â Priority ï Specifies or indicates the priority of the DMA. 

Ǐ PSoC 3/PSoC 5LP ï There is a default value assigned, denoted as ñDefault <#>ò, so that it can be 
distinguished from explicitly selecting the default number. Unselected default values will be updated as 
the device changes; values explicitly chosen will not. If changing devices results in an illegal value, an 
error icon will be displayed in the cell. An error will also be placed in the Notice List window. 

Ǐ PSoC 4/PSoC 6 ï The priority is specified in the Component Configure dialog. This property is read-
only in the table. 

Â Block Number ï PSoC 6 only has up to two DMA blocks and each DMA block consists of up to 16 channels. 
This information will only be available after place-and-route. This property is read-only in the table. 

Â Channel Number ï This information will only be available after place-and-route. This property is read-only in 
the table. 

Note If no DMA resources are used in a design, the DMA Editor will display a message to that effect. 

To Open the DMA Editor: 

Double click the DMA icon in the Design-Wide Resources tree, located in the Source tab of Workspace Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the DMA Editor (DMA tab) displayed 
on top. 

To Change Priority: 

For PSoC 3 and PSoC 5LP, click the down arrow on the menu, and select the appropriate Priority value from the 
pull-down menu. 

For PSoC 4 and PSoC 6, the priority must be set in the DMA Component itself. The DWR simply shows the value 
specified in the Component. 

To Sort DMA Editor Table: 

By default the DMA Editor is sorted in ascending order by the Priority column, with a secondary sort on the 
channel number column. 

To sort by a different column, click the appropriate column header. There will always be a secondary sort performed 
on the channel number column. 

To Select/Edit a DMA: 

Double-click an entry in the table; PSoC Creator opens the schematic file and highlights the associated DMA 
instance, plus it opens the Configure DMA dialog, where you can edit various parameters. 

Refer to the appropriate device DMA Component datasheet for more information. 
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See Also: 

Â Design-Wide Resources 

Â Working with Interrupts 

Â DMA Wizard 

Â Editing Component Parameters 

Â DMA Component datasheet (open from the Component Catalog)  

DMA Wizard 

The DMA Wizard aids in quick and accurate development of applications that use DMA. The wizard guides you 
through the process of defining transaction descriptors. It also generates the necessary C code that you can copy 
and paste into your application. The DMA Wizard only works in the context of a design project that contains at least 
one DMA Component. If there is no DMA Component in your design, the wizard displays a message to that effect. 

The DMA Wizard contains the following steps: 

Â Getting Started (this topic) 

Â Global Settings 

Â Transaction Descriptors 

Â Generated Code 

To Open the DMA Wizard: 

Select DMA Wizard from the Tools Menu. 

The system will analyze your project for DMA Components and open the wizard. If there are no DMA Components 
in your design, a message will display stating that you need to open a project with a DMA Component. 
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Getting Started: 

The Getting Started step allows you to select the project and DMA instance for you to configure. 

 
 

This step contains the following fields: 

Â Project ï This lists all the design projects in the currently open workspace that contain DMA Components. By 
default the ñActiveò project is selected if it fits the previous requirements. 

Â DMA ï Used to select the channel (DMA Component) to use. 

After selecting the appropriate project and instance, click Next > to proceed to the next step. 

See Also: 

Â DMA Wizard Global Settings 

Â DMA Wizard Transaction Descriptors 

Â DMA Wizard Generated Code 

Â DMA Editor 
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DMA Wizard Global Settings 

The Global Settings step is where you configure the global transaction descriptor (TD) settings 

 
 

This step contains the following settings: 

Source: 

Â Source ï This can be SRAM, Flash, or EEPROM. It can also be a Component that was created with the ability 
to be used with the DMA Wizard. If the selected Component has more than one possible source, a second 
drop-down will appear allowing for a more specific selection. 

Â Base Addr ï Depending on which PSoC device is used, the contents of the Base Address may or may not be 
automatically provided. When not filled in by default, a C expression needs to be provided. This is used to 
provide the upper 16 bits of the address for the DMA Channel configuration. If not added, an error icon will 
appear. This will not prevent you from continuing with the wizard. It will only generate code that will not compile. 

Destination: 

Â Destination ï This can be SRAM or a Component that was created with the ability to be used with the DMA 
Wizard. If the selected Component has more than one possible destination, a second drop-down will appear 
allowing for a more specific selection. 

Â Base Addr ï Depending on which PSoC device is used, the contents of the Base Address may or may not be 
automatically provided. When not filled in by default, a C expression needs to be provided. This is used to 
provide the upper 16 bits of the address for the DMA Channel configuration. If not added an error icon will 
appear. This will not prevent you from continuing with the wizard. It will only generate code that will not compile. 

Set Manually: 

The following fields are defined automatically. To set these manually, select the Set Manually check box. 

Â Bytes per Burst ï Allows you to set the number of bytes to transfer in a single burst. This value is calculated to 
be the maximum value that is supported by both the source and the destination. To the right of this field the 
range of legal values for the current source and destination is displayed. If you enter an invalid value or if there 
is no legal value, an error icon will appear next to the field. This will not prevent you from continuing with the 
wizard. It will only generate code that will not compile. 
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Â Each Burst Requires a Request ï Allows you to set whether or not each burst requires a request before it is 
sent. The value is automatically calculated based on the selected source and destination. 

Transaction Descriptors: 

Â Number of TDs ï Specifies the number of transaction descriptors to create (between 1 and 128). 

Â Single Chain or Loop ï This determines what the Next TD will be for the last TD entered. If single chain the 
Next TD will be END. If Loop it will loop back to the first TD. 

After configuring the appropriate settings, click Next > to proceed to the next step. 

See Also: 

Â DMA Wizard 

Â DMA Wizard Transaction Descriptors 

Â DMA Wizard Generated Code 

Â DMA Editor 

  

DMA Wizard Transaction Descriptors 

The Transaction Descriptors step is where you configure settings for each individual transaction descriptor (TD). 

 
 

This step contains the following fields: 

Field Description 

TD# Displays the logical Transaction Descriptor number. It is used in conjunction with Next TD. 

Endian Enables 2- or 4-byte endian byte swapping. When set to 2 or 4, the Bytes per Burst setting must be set 
as a multiple of the endian selection. An error will be added to the cell if this is not the case. This will not 
prevent you from continuing with the wizard. It will only generate code that will not compile. 

Enable trq Enables terminating this TD on a rising edge of the trq signal. 
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Field Description 

Enable nrq Enables the generation of the nrq signal when the TD completes. 

Length The length in bytes for this TD (0 to 4095). This field is a C expression that is evaluated at run time. If 
endian swapping is enabled, the length must be a multiple of endian swap size. An error will be added 
to the cell if this is not the case. This will not prevent you from continuing with the wizard. It will only 
generate code that will not compile. 

Source The lower 16-bit source address for the DMA transfer. This field is a C expression that is evaluated at 
run time to configure the TD. It is combined with the upper 16-bit base address provided on the Global 
Settings page. If a Component is selected as the source, this field may be a drop-down list of 
addresses. In any case, the cell is editable. If empty, an error icon will be added to the cell. This will not 
prevent you from continuing with the wizard. It will only generate code that will not compile. 

Inc (Source) Enables incrementing of the Source address as the DMA progresses through the specified number of 
bytes. 

Destination The lower 16-bit destination address for the DMA transfer. This field is a C expression that is evaluated 
at run time to configure the TD. It is combined with the upper 16-bit base address provided on the 
Global Settings page. If a Component is selected as the source, this field may be a drop-down list of 
addresses. In any case, the cell is editable. If empty, an error icon will be added to the cell. This will not 
prevent you from continuing with the wizard. It will only generate code that will not compile. 

Inc 
(Destination) 

Enables incrementing of the Destination address as the DMA progresses through the specified number 
of bytes. 

Auto Next Specifies whether or not to automatically execute the next TD once this TD completes without requiring 
another request. 

Next TD Specifies the next logical TD in the chain of TDs. Set to END if this TD chain is complete with this TD. 

  

The Reset to Defaults button will reset all the values in the table to be their default, calculated values. 

After configuring the appropriate settings, click Next > to proceed to the next step. 

See Also: 

Â DMA Wizard 

Â DMA Wizard Global Settings 

Â DMA Wizard Generated Code 

Â DMA Editor 
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DMA Wizard Generated Code 

The Generated Code step is where the code is displayed for you to copy and paste into your design. 

 
 

The Copy to Clipboard button adds the code to the clipboard. You can also use standard keyboard shortcuts and 
the right-click menu, as needed. 

Note If any errors were ignored in the previous steps, an error icon will display reminding you that the code will not 
work. 

See Also: 

Â DMA Wizard 

Â DMA Wizard Global Settings 

Â DMA Wizard Transaction Descriptors 

Â DMA Editor 
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System Editor 

The System Editor is used to edit various system properties. It contains a table with different categories of 
properties, such as Configuration, Programming/Debugging, and Operating Conditions. The available categories 
change based on your design. 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

 
 

To Open the System Editor: 

Double click the System icon in the Design-Wide Resources tree, located in the Source tab of Workspace Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the System Editor (System tab) 
displayed on top. 

To Edit a Property: 

Click in the Value column for a property to edit. 

Different properties have different methods of editing. Some properties have a check box to toggle on and off, some 
have a pull down menu to choose an option, and some have a text field in which to enter a value. 

If you enter an invalid value, an error will display to indicate the invalid value and how you might correct the 
problem. 

Property Descriptions: 

Under each category, there are one or more rows of properties you can edit. When you highlight a particular 
property, its description displays in the text box at the bottom of the editor. The table contains the following columns: 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 254 

Â Option ï This column displays the name of each row/level in the hierarchy. 

Â Value ï This column displays the current value of a setting and allows you to change it when applicable. 

The table contains the following options: 

Option Description Note 

Configuration 

Device Configuration 
Mode 

This property controls how the device will be configured pre-main, 
such that it reflects the design. The options available are 
Compressed, UnCompressed, and DMA. (The DMA option applies 
to PSoC 3 and PSoC 5LP devices only.) 

¶ Compressed results in a smaller amount of FLASH being 
consumed but requires more time after a reset to get to main. 

¶ UnCompressed will use the same amount of FLASH as DMA, 
but will perform a software copy of configuration data. 

¶ DMA will result in more FLASH being consumed for 
configuration, but will require less time to get to the user-defined 
main function. 

Not applicable to FM0+ 
devices. 

Enable Error 
Correcting Code (ECC) 

If true, the ECC will be used to detect and correct errors in the 
FLASH memory. Selecting this option hides the "Store Configuration 
Data in ECC Memory" option. 

WARNING Exercise caution changing this setting during 
development. Excessive re-programming of this setting may cause 
unexpected results. 

Applies to PSoC 3 and PSoC 
5LP devices only. 

Store Configuration 
Data in ECC Memory 

If this option is enabled, device configuration data will be stored in 
ECC memory to reduce main FLASH memory usage. Error 
correction may not be used when this option is enabled. 

Applies to PSoC 3 and PSoC 
5LP devices only. 

Instruction Cache 
Enabled 

If true, the device will write data coming from the FLASH to the 
instruction cache SRAM. 

Applies to PSoC 3 and PSoC 
5LP devices only. 

Enable Fast IMO 
During Startup 

If true, the fast IMO will be used. This configuration balances the 
need for rapid boot and configuration against peak power 
consumption. If true, the IMO will run at the faster speed of 48 MHz 
instead of 12 MHz during device startup. 

This configuration balances the need for rapid boot and 
configuration against peak power consumption. If true, the IMO will 
run at the faster speed of 48 MHz instead of 12 MHz during device 
startup and between CyPmSaveClocks() and CyPmRestoreClocks() 
functions calls. See System Reference Guide for more information 

about these functions. 

WARNING Exercise caution changing this setting during 
development. Excessive re-programming of this setting may cause 
unexpected results. 

Applies to PSoC 3 and PSoC 
5LP devices only. 

Clear SRAM During 
Startup 

If enabled, writes zeros to SRAM before initializing variables. If 
disabled, variables that do not have an explicit initializer will not be 
initialized to zero. This option should only be disabled if the 
application requires a faster startup time and does not contain any 
code or libraries that depend on the value of un-initialized variables. 

Applies to PSoC 3 devices 
only. 

Read Accelerator 
Enabled 

If true, the device will accelerate read operations using cached 
values. 

Applies to PSoC 4 devices 
only. 

Unused Bonded IO This option controls how unused bonded pins will be used for 
internal analog place and route. 

¶ ñAllow but warnò option will allow the analog router to make use 
of unused pin switches in the current design, but will give out 

warnings on the pins whose switches are used. 

Not applicable to FM0+ 
devices. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 255 

Option Description Note 

¶ ñAllow with infoò option will allow the analog router to make use 
of unused pin switches in the current design, and will give out 
notes on the pins whose switches are used. 

¶ ñDisallowedò option will disallow the analog router to use any of 
the unused pin switches in the current design. 

Heap Size Defines the number of SRAM bytes to reserve for the Heap space. Applies to PSoC 4 and PSoC 
5LP devices only. 

Stack Size Defines the number of SRAM bytes to reserve for the Stack space. Applies to PSoC 4 and PSoC 
5LP devices only. 

Include CMSIS Core 
Peripheral Library Files 

The CMSIS (Cortex Microcontroller Software Interface Standard) 
Core Peripheral Library contains APIs to access core registers and 
peripherals. Checking this option will include the APIs from the 
current version of the standard in the project. The current version is 
tied to the version of the cy_boot Component in your project. Refer 
to the System Reference Guide for more information. Deselect the 
box and add the files manually if you wish to use a different version 
of the standard.  

Applies to PSoC 4 and PSoC 
5LP devices only. 

Programming/Debugging 

Chip Protection The different chip protection levels provide limitations on what 
resources are accessible by the CPU and Debugger: 

¶ Open: full access 

¶ Protected: no debugging 

¶ Kill: the device can never be reprogrammed 

  

Note: 

1. Programming a PSoC 4/PRoC BLE device using PSoC 
Creator will set the chip protection to "Open" even it is 
selected as "Protected" or "Kill" mode. 

2. In order to set the Chip protection to "Protected" or "Kill" 
mode, select the appropriate mode in PSoC Creator and 
program the PSoC 4/PRoC BLE device using PSoC 
Programmer after enabling "Chip Lock" feature in PSoC 
Programmer Options > Programmer Options. 

  

Applies to PSoC 4 devices 
only. 

Debug Select Sets the Port 1 preferred program/debug interface (JTAG or SWD) 
that the chip enables by default for use after power up or reset. 

¶ For PSoC 4/FM0+, JTAG is not available. 

¶ Setting to GPIO frees the pins for use as GPIOs but does not 
completely disable the debug interface for flash protection 
purposes. "Enable Device Protection" must be set for this 
purpose, or "Chip Protection" must be set to Open. 

  

Note This setting must match how you intend to program your 
device in a 3rd party IDE. See also Integrating into 3rd Party IDEs. 

  

For more information about programming and debugging options 
see the device datasheet or Technical Reference Manual (TRM). 

  

WARNING Exercise caution changing this setting during 
development. Excessive re-programming of this setting may cause 
unexpected results. 

PSoC 3/PSoC 5LP/PSoC 6 
options include: 

¶ 5-wire JTAG 

¶ 4-wire JTAG 

¶ SWD (serial wire debug) 

¶ SWD+SWV (serial wire 
debug and viewer) 

¶ GPIO 

  

PSoC 4/FM0+ options 
include: 

¶ SWD (serial wire debug) 

¶ GPIO 

  

Enable Device 
Protection 

When completing a production design, you may select the Enable 
Device Protection feature. Enabling this feature causes the part to 

Applies to PSoC 3 and PSoC 
5LP devices only. 
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Option Description Note 

disable debugging at run-time. It is still possible to connect a 
programmer, but debugging will be disabled. It is not recommended 
to enable it for multi-device JTAG chains, since it may break the 
chain. 

Note This setting does not affect flash protection. It is only used to 
disable debug access to the PSoC 3 or PSoC 5LP device. 

Embedded Trace 
(ETM) 

Enables the Cortex ETM Trace capability for outputting real-time 
debug information while the processor is running.  This will reserve 
the trace pins as debug pins. When not used for trace, PSoC 

Creator makes the pins available as a GPIO. 

Applies to PSoC 5LP and 
PSoC 6 devices only. 

Use Optional XRES Enables hardware reset via the optional XRES pin (P1[2]). This is in 
addition to the dedicated XRES pin on this device. 

WARNING Exercise caution changing this setting during 
development. Excessive (over 1000 times) re-programming of this 

setting may cause the selection to become permanent. 

Applies to PSoC 3 and PSoC 
5LP devices with more than 

48 pins. 

Enable XRES Enables hardware reset via the optional XRES pin (P1[2]). This 
device does not have a dedicated XRES pin, if disabled it is not 
possible to program the part without a power cycle or to issue a hard 
reset from the debugger. 

By default, the reset is done by toggling the XRES pin. The power 
cycle method is highly dependent on the design of your board, and 
may not be possible. If a XRES pin is not available and the Power 

Cycle does not work, the part cannot be reprogrammed. 

To ensure that the device can be programmed, this option should be 
enabled. 

WARNING Exercise caution changing this setting during 
development. Excessive (over 1000 times) re-programming of this 
setting may cause the selection to become permanent. 

Applies to PSoC 3 devices 
with 48 pins or less. 

  

Operating Conditions 

These settings specify the various voltages and temperature ranges in which the device is used. Various 
Components in the device use these values for configuration information, so you should use correct values. There 
are numerous ways these settings can affect your design, including: 

Â The USB_Start function has an option to use Vddd to set the internal USB regulators for enumeration. 

Â The ADC_CountsTo_Volts() API uses these voltages for the Vssa to Vdda Input Range. 

Â The SAR_ADC Component uses the Vdda voltage setting for configuring the Input Range and Reference. 

Â The SC block Components (TIA, PGA, PGA_Inv, Sample_Hold, Mixer) enable boost clocks when the Vdda is 
set below 2.7 V. 

Â The VDAC8 Component generates a note explaining that the range of the VDAC is limited to the range from 0 
V to Vdda. 

Â Static Timing Analysis uses smaller timing delays in the UDBs if Vddd is >= 1.8 V (and you selected the 0 ÁC ï 
85 ÁC Temperature Range). IO delays are smaller if the voltage (VddioN) is 3.3 V or higher. 
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Option Description Note 

Pin Voltages 
(VDDA, VDDD, 
VDDIO<X>, VDDR, 
VBUS, etc.) 

Individual options are available for each power pin on the selected 
device. The input value indicates the input voltage on the 
corresponding pin. 

The exact list of options will 
change based on the 
selected device. 

External PMIC Output This option provides the ability to enable an external PMIC input to 
provide VDDD power to the device. Options include: 

¶ Disabled 

¶ Enabled 

Applies to PSoC 6 devices 
only. 

Temperature Range Specifies the temperature range at which the device will be 
operated. 

PSoC devices operate reliably across a wide temperature range. If 
your design will only ever run at typical room temperatures, 
however, the timing constraints are more easily satisfied. Selecting 
the narrower temperature range for your application helps the tool to 
find timing-compliant routing solutions. 

Available selections are: 

¶ 0C ï 85C (PSoC 3 and 
PSoC 5LP only) 

¶ -40C ï 85C (all devices)  

Variable VDDA Option to create low voltage analog boost clock. Useful to allow low 
voltage boost when Vdda varies over time such as a battery 
powered application. 

Not applicable to FM0+ 
devices. 

Power Mode This option provides the ability to switch between using the LDO 
Linear Regulator or the SMIO Buck to supply VCCD. 

Note There is no hardware protection when using the SMIO Buck. 

No configuration available for Ultra Low Power (ULP) devices. 

Applies to PSoC 6 devices 
only. 

Note: The voltage values are used by certain APIs (for example, ADC_CountsTo_Volts), as well as Component 
Configure dialogs (for example, the ADC_DelSig Component uses this Vdda information for showing input range if 
Vref is selected to Vdda/4 or Vdda/3). Although it is recommended to update the actual Vddx voltages in the DWR 
System Editor, the device will not get damaged if a different valid (as per the datasheet) supply voltage is given. 

Analog Reference 

For some devices, there is an additional section with the following options: 

Option Description Note 

Reference Source This option specifies the system wide programmable reference 
source. Available selections are: 

¶ Bandgap (1.20 V) 

¶ VDDA (3.30 V) 

Applies to PSoC Analog 
Coprocessor and PSoC 
4100PS series devices only. 

Bandgap Reference 
Gain 

This option controls the Bandgap multiplier used by all 
programmable references.Available selections are: 

¶ 1x (1.20 V) 

¶ 2x (2.40 V)  

Applies to PSoC Analog 
Coprocessor and PSoC 

4100PS series devices only. 

Voltage Reference 
Value 

This option specifies the system wide programmable reference 
voltage.  Voltage options are based on 1/16th increments of VDDA 
and Bandgap * Reference Gain. This voltage is accessible by the 
voltage reference Component. Different selections ranging from 0.08 

V to 1.20 V. 

Applies to PSoC Analog 
Coprocessor and PSoC 
4100PS series devices only. 

VDDA references 
active during 

DeepSleep 

This option specifies whether or not VDDA-based references will 
remain active when the chip is in Deep Sleep. References which are 
based off of the bandgap reference (VBGR) are never active in 
DeepSleep. 

Applies to PSoC Analog 
Coprocessor and PSoC 

4100PS series devices only. 

Bandgap Value This option specifies the analog reference value. The system 
reference requires less power but provides lower performance than 

Applies to PSoC 6 devices 
only. 
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Option Description Note 

the local reference. This voltage is accessible by the voltage 

reference Component. Options: (System, Local, External Pin) 

Opamp Reference 
Current 

Selects the reference current available to the opamps. Selecting a 
lower value will reduce power consumption but will result in lower 

performance. See the opamp component datasheet for more details. 

Applies to PSoC 6 devices 
only. 

Available in DeepSleep This option specifies whether or not the bandgap reference will 
remain active when the chip is in Deep Sleep. 

Applies to PSoC 6 devices 
only. 

  

See Also: 

Â Design-Wide Resources 

  

Directives Editor 

The Directives Editor is used to add, remove, and edit directives. See Directives for more information about the 
directives available in PSoC Creator. 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

 
 

To Open the Directives Editor: 

Double click the Directives icon in the Design-Wide Resources tree, located in the Source tab of Workspace 
Explorer. 
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The <project>.cydwr file opens as a tabbed document in the work area, with the Directives Editor (Directives tab) 
displayed on top. 

To Add a Directive: 

Click the Add Directive button on the top left of the editor. 

To Edit a Directive: 

Enter a Component/Signal name, Directive Type, and Directive Value as appropriate in each column. 

Â Component (Signal) Name - Use this column to enter the signal or Component name. Currently there is no 
validation check for this column, except you must enter a name in this column if you enter a value in the 
Directive Value column. 

Note The Component Name for this field is the fully elaborated name of the Component as specified in the 
<project>.rpt file after a successful build (e.g, "\Counter_1:CounterUDB:sC8:counterdp:u0\"). You can find 
the <project>.rpt file under the Output tab in the Workspace Explorer. 

Â Directive Type - Use this column to select a valid directive type from the drop down list. The initial value for this 
column is INVALID. If you enter a value in the Directive Value column, you must change the Directive Type to 
the appropriate type. Valid types include: 

Ǐ ForceSignal: Maps to the 'placement_force' directive format used for arbitrary logic. Allows the 
assignment of a UDB PLD location to the output signal of a block of logic to tell the placer to put that 
output in that UDB PLD. This generates a rule of the form: 

    attribute placement_force of [signal name] : signal is "[UDB spec]"  

    where [UDB spec] : U(x,y)[A|B] or U(x,y,[A|B])i  

 

Ǐ ForceComponentUDB: Maps to the 'placement_force' directive format for UDB Components. Assigns 
the location of UDB Component listed to the location specified. This generates a rule of the form: 

    attribute placement_force of [Component name] : label is "[UDB spec]"  

    where [UDB spec]: U(3,2)  

 

Ǐ ForceComponentFixed: Maps to the 'placement_force' directive format for Fixed Function blocks. 
Assigned the location of the fixed block listed to the location specified. This generates a rule of the 
form: 

    attribute placement_force of [Component name] : label is "[fixed spec]"  

    where [fixed spec] : F([fixed block],i)  

    where [fixed b lock] : CAN, Comparator, I2C, SC, Timer, VIDAC, ...  

 

Ǐ Group: Maps to the 'placement_group' directive format. Groups the specified signal name into the 
specified group. This generates a rule of the form: 

    attribute placement_group of [signal name] : signa l is "[group name]"  

 

Â Directive Value - Use this column to specify the value for the directive, based on the selected Directive Type. 
Each type has certain rules for its value. If the value does not follow the rules of the type, an error icon will 
display next to the text (for example, see signal_5 in the image). Mouse over the error icon to show the reason 
of the error. 
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To Delete a Directive: 

Click a row in the table and click the Delete Directive button. 

See Also: 

Â Design-Wide Resources 

Â Directives 

  

Flash Security Editor 

The Flash Security Editor allows you to control the read/write access to the flash memory. This feature is designed 
to secure proprietary code. 

Flash rows are displayed as a table where each editable cell in the table represents a single row of flash 
(64/128/256 bytes depending on the PSoC 4 device; 256 bytes for PSoC 3 and PSoC 5LP devices). Each row of 
flash can have its protection level independently set. 

Note This feature is not applicable to PSoC 6 devices, for which flash security is handled by the MPU/SMPU/PPU 
as part of the firmware. 

 
 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information. 

Protection Levels: 

The tool offers four levels of protection, as follows. You can assign one of four protection levels (two levels for 
PSoC 4) to each row; see the table below. flash protection levels can only be changed by performing a complete 
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flash erase. For more information on PSoC flash and security features, refer to a device datasheet or Technical 
Reference Manual (TRM). 

Â Unprotected (U) ï No protection. 

Â Factory Upgrade (F) ï Read protected. No device external to the PSoC device can read a flash block that is 
read-protected. The SPC Read commands cannot be used to read a block that is read protected. Only the 
processor and the PHUB can access a block of flash that is read protected. (This option is not available for 
PSoC 4 devices.) 

Â Field Upgrade (R) ï External write protection. No device external to the PSoC device can erase or write a row 
of flash that is external write protected. Includes all Read Protect restrictions. (This option is not available for 
PSoC 4 devices.) 

Â Full Protection (W) ï Fully protected. Neither the PSoC CPU nor any device external to PSoC can erase or 
write a block of flash that is fully protected. Includes all protections from lower levels of flash data protection. 
This level is used when a block of flash should never be modified by an internal process or external device. 

  

  PSoC 3 and PSoC 5LP PSoC 4 

Protection 
Setting 

Allowed Not Allowed 
Allowed Not Allowed 

Unprotected External read and 
write, 
Internal read and write 

ï External read and write, 
Internal read and write 

ï 

Factory Upgrade External write, 
internal read and write 

External read n/a n/a 

Field Upgrade Internal read and write External read and 
write 

n/a n/a 

Full Protection Internal read External read and 
write, 

Internal write 

Internal read, External 
read 

External write, 
Internal write (see Note 

below) 

  

Note To protect the PSoC 4 device from external read operations, you must change the device protection settings 
to ñProtectedò in the DWR System Settings. You must also enable ñChip Lockò from Options > Programmer 
Options before programming the device for these settings to take effect. You must use the PSoC Programmer tool 
to program the device.  

To protect the bootloader portion of flash, set the corresponding rows to ñfull protection.ò PSoC Creator lets you 
easily select the protection setting for each row. 

Note The Full Protection level cannot be used on the last two rows of flash for Bootloader or Bootloadable projects. 
These rows are used for application metadata and require internal write access. 

To Open the Flash Security Editor: 

Double click the Flash Security icon in the Design-Wide Resources tree, located in the Source tab of Workspace 
Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the Flash Security Editor (Flash 
Security tab) displayed on top. 
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To Change a Single Row of Flash: 

To change the protection level on a single flash row, click the corresponding cell in the table and make your 
selection from the drop-down list. 

 
 

To Change Multiple Rows of Flash: 

To change the protection level on multiple rows of consecutive flash at once, proceed as follows: 

1. Select your starting and ending flash row numbers using the fields provided at the top of the editor. 

 
 

By default the starting and ending values are set to include all rows of flash. 

2. Select your desired protection level from the drop-down list located to the right of the previous fields. 

3. Click the Set button. 

Generated Hex (PSoC 3 Only): 

There are two generated hex files with flash security levels in them. During a build, the flash protection data is 
gathered from the CyFlashSecurityModel and outputted as a hex file (located at 
Generated_Source/[Architecture]/protect.hex). This data is then combined into the overall hex file for the project 
(located at [Platform (DP8051-Keil_Generic/Debug, é)]/[Configuration (Debug, Release)]/[Prj Name].hex). 

See Also: 

Â Design-Wide Resources 
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EEPROM Editor 

The EEPROM Editor allows you to set up EEPROM data from PSoC Creator without requiring any code to run in 
the PSoC application. It is a grid that displays the EEPROM memory according to the display options. Each cell is 
editable, with a default value of 0xFF. 

Note PSoC Creator collects DWR information dynamically. Depending on the complexity of the design, it may take 
a few seconds to update the DWR information.  

 
 

The left column shows the base addresses. The top row shows the offsets for each column. The ASCII display on 
the right is similar to that shown in the Memory Window. 

To Open the EEPROM Editor: 

Double click the EEPROM icon in the Design-Wide Resources tree, located in the Source tab of Workspace 
Explorer. 

The <project>.cydwr file opens as a tabbed document in the work area, with the EEPROM Editor (EEPROM tab) 
displayed on top. 

To Change Single Cell Value: 

To change the value of a single cell, click in the cell and either type the desired value or use the menu to select a 
value from the list. 

To Change Multiple Cell Values: 

To change the value of multiple cells, use fields below the grid. Enter or select the appropriate values for From 
address, to, and Value. The click Set. 
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To Import/Export Data: 

You can write a sequence of bytes in an external editor in comma-separated value (CSV) format, save it as a CSV 
file, and import the file into PSoC Creator. Click Import, navigate to the CSV file location, select it and click Open. 
The changes are applied in the EEPROM Editor. 

You can also make edits in the EEPROM Editor, export the data as a CSV file, then open the file in an external 
editor. Click Export, navigate to the location to save the file, and click Save. 

To Include EEPROM Image in Hex file: 

Select this check box to include the EEPROM image in the hex file. If selected, programming time increases. The 
default is not selected. 

Note If this check box is not selected, there is no functional change to your project. 

To Change the Display: 

The following settings are stored in the user configuration file and change the display of all projects for that user. 
These values change the display only; they do not modify the actual values of the data. 

Â Use the View pull-down menu to change the size of the data displayed in the editor: 8-bit, 16-bit, or 32-bit. 

Â Use the Format pull-down menu to change the format of the data displayed in the editor: Hex, Signed Int, 
Unsigned Int. 

Bootloader Support: 

You can use the EEPROM Editor on any type of project. However, you cannot use it for both bootloader and 
bootloadable. PSoC Creator will indicate an error if such a condition occurs. 

For multi-application bootloaders, the EEPROM is equally divided amongst all bootloadables. 

Rules: 

1. If you have set up a bootloader/multi-application bootloader project to use EEPROM, then no bootloadable 
project using that bootloader is allowed to use EEPROM (the DWR in the bootloadable project will not allow 
you to turn on EEPROM for that project). 

2. If the bootloader is not using EEPROM and it is not a multi-application bootloader, then any bootloadable 
projects using that bootloader may enable EEPROM in their DWR and use the full EEPROM memory region. 

3. If you have a multi-application bootloader and that bootloader is not using EEPROM, then bootloadables using 
that bootloader may use EEPROM. The EEPROM will be divided evenly amongst the bootloadable .cyacd files 
(e.g. *_1.cyacd has the first half of EEPROM and *_2.cyacd has the upper half of the EEPROM data). 

See Also: 

Â Design-Wide Resources 

Â Memory Window 

Â Bootloader/Bootloadable Component datasheet (available from the Component Catalog) 
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Symbol Editor 

The Symbol Editor allows you to create and edit Components that can then be used in your designs. 

 
 

The process of creating Components can be complex. These topics are provided as a help if you press [F1] for the 
various dialogs you may encounter. For more in depth discussion regarding creating Components, refer to the 
Component Author Guide. 

The main topics of the Symbol Editor include: 

Â symbol sheet ï the canvas on which you draw Components 

Â Design Elements Palette 

Â Symbol Editor Context Menus ï commands specific to the Symbol Editor 

Â Common toolbars ï commands common to the design entry tools 

  

This section also contains various topics related to working with the Symbol Editor: 

Â Creating a Symbol 

Â Symbol Wizard 

Â Symbol Editor Context Menus 

Â Working with Component Terminals 

Â Defining Catalog Placement 

Â Creating Symbol Parameters 

Â Creating Parameter Validators 
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Creating a Symbol 

Creating a symbol is only one aspect of creating a Component. The process of creating Components can be 
complex. For more in depth discussion regarding creating Components, refer to the Component Author Guide. 

You create a symbol within a project. So first, either create a new project or open an existing one. 

1. Once you have opened a project, select the Components tab in the Workspace Explorer. 

2. Right-click on a Component or project, and select Add Component Item... 

You can also select this option from the Project menu. 

The Add Component Item dialog displays. 

 

3. Select the Empty Symbol icon. 

4. Enter a Component name. 

5. Select the Destination. 

Note This option is only available if you open this dialog from the Project menu. 

6. Click Create New. 

The symbol is added to the existing Component or a new Component is created with the new symbol. 

See Also: 

Â Component Author Guide 

Â Library Component Project 

Â Adding a Component Item 

Â Symbol Wizard 

Â Create Symbol from Schematic 
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Symbol Wizard 

The Symbol Wizard allows you to create a basic symbol and specify the names and types of terminals. The wizard 
also offers a preview of the symbol, as well as the option to change the title color. 

 
 

Creating a symbol is only one aspect of creating a Component. The process of creating Components can be 
complex. For more in depth discussion regarding creating Components, refer to the Component Author Guide. 

To Open the Symbol Wizard: 

1. Open a project (or create a new project) and select the Components tab in the Workspace Explorer. 

2. Right-click on a Component or project, and select Add Component Item... to open the Add Component Item 
dialog. 

3. Select the Symbol Wizard icon and click Create New. 

To Add a New Terminal: 

Enter the Terminal name and select a Type for each Component terminal; create separate terminals using different 
rows. 
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To Add a Symbol Label: 

Use the Symbol label text box to add optional text or an expression to be displayed under the symbol. 

 

Note This field is normally used to enter an expression to display the value of a single parameter for the 
Component in the symbol (for example, Param name = `=$ParamName`). See Using Text Substitution for more 
information about expressions. 

To Delete a Terminal: 

Double-click the row header cell for a terminal. A dialog will display to confirm the deletion. 

You can also select a row and click the Delete  button. 

To Change Terminal Order: 

Select a row and use the Up Arrow and Down Arrow buttons to rearrange the terminal order in the table. This will 
also affect how the terminals will appear on the symbol, as shown in the preview. 
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To Change the Title Color: 

To change the color of the symbol title, select a color from the Title color pull-down menu. There are several pre-
defined Cypress colors. You may also choose a custom color. 

 
 

See Also: 

Â Component Author Guide 

Â Library Component Project 

Â Adding a Component Item 

Â Creating a Symbol 

Â Create Symbol from Schematic 

Â Using Text Substitution 
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Symbol Editor Context Menus 

The Symbol Editor contains various commands available on right-click ï or context ï menus. The commands 
available will vary depending on whether you right-click on the canvas itself or on a Component/element. The 
following are the commands available: 

On Canvas: 

 

Â Paste ï Same as command from the Standard Toolbar. 

Â Select All ï Selects everything on the canvas. 

Â Zoom ï Same as zoom commands from the View Menu. 

Â Symbol Parameters ï Opens the Parameters Definition dialog. See 
Creating Symbol Parameters. 

Â Generate Verilog ï Generates a Verilog file based on the Symbol's 
definition. See Generate Verilog. 

Â Properties ï Opens the Properties dialog. 

  

On Selected Object(s): 

 

Â Cut, Copy, Paste, Delete ï Same as commands from the Standard 
Toolbar. 

Â Select All ï Selects everything on the canvas. 

Â Zoom ï Same as zoom commands from the View Menu. 

Â Shape ï Same as shape commands from the Common Design Entry 
Toolbars. 

Â Select ï Allows you to select a specific object when two or more objects 
are drawn on top of each other. 

Â Align ï When two or more objects are selected, this command allows you 
to align selected shapes: left, right center, top middle, and bottom. 

Â Edit Name and Width ï For terminals only, opens Terminal Name dialog. 

Â Format Shape ï Opens the  Format Shape dialog to change various 
characteristics for the selected shape(s). 

Â Properties ï For terminals only, opens the Properties dialog. 

  

See Also: 

Â Symbol Editor 

Â Common Design Entry Toolbars 
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Â Design Elements Palette 

Â Standard Toolbar 

Adding a Component Item 

The primary purpose of the Add Component Item dialog is to add new items to a Component. It can also be used to 
create a new Component within a library project. Adding Component items and creating Components can be a 
complex set of instructions and procedures. This topic is provided as a help for this dialog. For more in depth 
discussion regarding creating Components, refer to the Component Author Guide. 

 
 

The dialog provides templates of the different types of items you can add to a Component. The options available 
will vary depending on the type of item you select and whether you are adding an item to a Component or creating 
a new Component. 

To Open the Dialog: 

In the Workspace Explorer, under the Components tab, right-click on a Component or project or select Add 

Component Item... . 

Â Select a Component   to add a new Component item within the Component. 

Â Select a project   to create a new Component within the project. 

You can also use the Project menu to open this dialog; however, the Destination field does not get selected 
automatically as it does for the context menu. 
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To Use the Dialog: 

The Add Component Item dialog contains the following sections: 

Templates 

The Templates area displays icons for the different types of available Component items. Currently the available 
templates include: 

Â Symbol ï Contains the symbol templates to create an empty symbol or to use the Symbol Wizard. See also 
Creating a Symbol. 

Â Implementation ï Contains the implementation templates. See also Creating a New Schematic. 

Â API ï Contains the API templates to create C, header, and assembly files. 

Â Library ï Contains a set of library templates to allow Component authors to add libraries for different compiler 
tool-chains and configurations (DEBUG/RELEASE). 

Â Misc ï Contains miscellaneous templates to create a documentation file, Control File, XML file or any other 
type of miscellaneous file. 

Beside each template, there is a brief description for each Component item. 

Target generic device 

The Target generic device check box disables/enables the Family, Series, and Device pull-down menus. These 
options determine where in the project hierarchy the new item will be stored. This field is only available for certain 
types of Component items, such as implementations, API files, etc. The check box will become active for different 
template items you select. 

Â Select the Target generic device check box to create the selected Component item at the top-level of the 
Component and disable the other options; de-select to enable them. 

Â Choose a Family to create the Component item in a subfolder for a family (e.g., PSoC3, PSoC4, or PSoC5.). 

Â Choose a device Series to create the Component item in a subfolder for a series of devices (e.g., CY8C32, 
PSoC 4000, PSoC 4200 BLE, CY8C52LP, etc.). 

Â Choose a specific Device part number to create the Component item in a subfolder for a specific device. 

Component Name 

The Component Name field allows you to specify a name for the Component when you create a new Component 
for a project. This field is disabled when adding Component items at the Component level. 

Item Name 

The Item Name field allows you to specify a name for some Component items. The following Component items 
derive their name from the Component Name: 

Â Symbol 

Â Schematic 

Â Control file 

Â Verilog file 
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Configuration 

The Configuration field only applies to Library template files. It allows you to specify if the library is for debug 
mode, release mode, or both. 

Destination 

The Destination field is only active when you open this dialog using the Add Component Item command from the 
Project menu. This field is a pull-down menu that allows you to select the project or Component to which you want 
to add the Component item. Notice that if you select a project, the Component Name field becomes active. 
Conversely, if you select a Component, the Component Name field becomes inactive. 

Create New vs. Add Existing 

The Create New button displays by default. If you click this button, PSoC Creator will create a new file of the 
selected type and it to the Component. 

This button contains a pull-down toggle   that switches it to Add Existing. If you switch it, a navigation button 
[...] becomes active to select an existing file of the selected type. Then when you click the Add Existing button, the 
selected file will be copied to the Component folder and added to the Component. Files may be renamed during the 
copy process to ensure they comply with file naming restrictions imposed on certain file types. 

See Also: 

Â Component Author Guide 

Â Library Component Project 

Â Symbol Wizard 

Â Create Symbol from Schematic 

Â Workspace Explorer 

Â Creating a New Schematic 

Â Creating a Symbol 

Working with Component Terminals 

The terminal tools in the Design Elements Palette for schematics allow you to draw digital input, output, and inout, 
as well as analog and external terminals. 

          
 

Use Component terminals when you are creating a symbol in the Symbol Editor, as part of creating a Component. 
For more information about creating Components, refer to the Component Author Guide. 
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To Place a Terminal: 

Select the appropriate Terminal tool from the Design Elements Palette and click on the canvas. The Terminal 
Name dialog will display. 

 

To Rename a Terminal: 

Right-click a terminal and select Edit Terminal Name. 

The Terminal Name dialog will display. 

Use the dialog to specify the terminal name and/or indices, as appropriate. 

To Show/Hide a Terminal Label: 

1. Right click the terminal and select Format Shape to open the Format Shape dialog. 

 

2. Change the Show Label property to true/false to show/hide the label, respectively. 

3. Click OK. 

To Delete a Terminal: 

Select the terminal and press [Delete] or click . 
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See Also: 

Â Component Author Guide 

Â Symbol Editor 

Â Design Elements Palette 

Â Terminal Name dialog 

Â Format Shape dialog 

Defining Catalog Placement 

As part of creating a Component, you can use the Catalog Placement dialog to define how symbols are displayed 
in the Component Catalog under various trees and tabs. 

 
 

The process of creating Components can be complex. This topic is provided as a help if you press [F1] for this 
dialog. For more in depth discussion regarding creating Components, refer to the Component Author Guide. 

To Open the Catalog Placement Dialog: 

1. Right-click on the symbol canvas and select Properties. 
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The Properties dialog displays. 

 

2. Click the [...] button in the Doc.CatalogPlacement field to open the Catalog Placement dialog. 

To Define Catalog Placement: 

Use the following syntax: 

t/x/x/x/x/d  

  

Each Component of the syntax has the following meaning: 

Â t  ï The tab name. The tab order displayed in the Component Catalog is alphabetical and case insensitive. 

Â x ï A node in the tree under the tab. You must have at least one node. 

Â d ï The display name for the symbol (optional). 

If you do not specify the display name, the symbol name will be used instead; however, you must use the t/x/  

syntax. 

If you do not define the Doc.CatalogPlacement property for a given symbol, it will display by default under the 
Default tab. 

If you want to show the symbol in multiple catalog trees, enter separate syntax strings in different rows of the 
dialog. 

See Also: 

Â Component Author Guide 

Â Library Component Project 

Â Component Catalog 

Â Properties dialog 
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Creating Symbol Parameters 

When you create a Component, you can create one or more parameter collections for your symbol using the 
Parameters Definition dialog. 

 
 

The dialog presents the parameters in the same order (tabs, categories, and parameters) that they will be 
presented to the user when editing the instance, with a few minor exceptions related to visibility. All parameters are 
visible in this dialog no matter what the visibility is set to.  

Â If a parameter is set to not be visible in the instance Configure dialog, it will not be displayed to the user when 
configuring the instance. 

Â If there are no visible parameters in a tab or category, that tab or category will not be displayed. 

Â If there is only a single visible category on a tab, the category will not be displayed; instead the parameters will 
be displayed without hierarchy. 

The process of creating Components can be complex. This topic is provided as a help if you press [F1] for this 
dialog. For more in depth discussion regarding creating Components, refer to the Component Author Guide. 

To Open the Dialog: 

Right-click on the symbol canvas and select the Symbol Parameters icon . 
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To Create Parameters: 

For each symbol, you can create any number of parameters. 

1. Click the Add button   to create a new parameter definition. 

 
 

2. For each parameter, define the properties on the right side of the dialog.  

Note Multiple parameters can have their properties edited at once by using [Ctrl] or [Shift] while clicking in the 
table to select multiple rows at once. 

3. To add another parameter, repeat the process or use the Copy/Paste buttons. 

To Create Enumerated Types: 

Click the Types... button to open the Enumeration Types dialog. 

 
 

See Enumeration Types for more information. 



Using Design Entry Tools 

PSoC Creator User Guide, Document Number: 001-93417 Rev *N 279 

See Also: 

Â Component Author Guide 

Â Symbol Editor 

Â Enumeration Types 

Creating Parameter Validators 

When you create a Component, you can create one or more parameter validators using the Parameter Validators 
dialog. 

 
 

The process of creating Components can be complex. This topic is provided as a help if you press [F1] for this 
dialog. For more in depth discussion regarding creating Components, refer to the Component Author Guide. 

To Open the Parameter Validators Dialog: 

1. On the Parameters Definition dialog, select the parameter for which to add a validator. 
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2. Then select the Validators field under the Validation section, and click the ellipsis [...] button. 

 
 

To Add a Validator: 

1. Select the message type from the drop down in the first row, either Error, Warning, or Info. 

2. Type an expression in the Expression field. Refer to the Component Author Guide. 

3. In the Message field, type in the message to display if the validation check is not met. 

4. To add another validator, select the message type from the drop down in the next row, and repeat the process. 

5. Click OK to close the dialog. 

See Also: 

Â Component Author Guide 

Â Symbol Editor 

Â Creating Symbol Parameters 

Exporting a Component 

After you have finished developing one or more Components, you can export them without providing the entire 
project or library. This allows for a library-free distribution method of Components and allows you to more easily 
control your own libraries and dependencies. 

If you prefer to include the Component as part of a project/library, see Archiving a Workspace/Project. 
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To Export a Component: 

1. In the Workspace Explorer, under the Components tab, right-click on the Component to view the context 
menu, and select Export Component. 

 
 

2. Select Create New Archive... to export it as a new Component archive. 

Ǐ This option opens the Save As dialog to save the Component with a default .cycomp file name of 
comp_archiveXX, where XX is a number that will increment each time you export a Component. 

Ǐ Rename the file as appropriate and select a desired location. 

Ǐ Click Save. 

3. Select Add to Existing Archive... to update an existing exported Component archive. This option allows you to 
update an existing Component, and it allows you to add additional Components to an existing .cycomp file. 

Ǐ This option opens the Save As dialog. 

Ǐ Navigate to the location of the existing .cycomp file to be updated. 

Ǐ Select the .cycomp file and click Save. 

The .cycomp file contains all of the files included with the selected Components, and it is used by PSoC Creator 
during the Import Component process. 

See Also: 

Â Archiving a Workspace/Project 

Â Workspace Explorer 

Â Import Component 
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UDB Editor 

The Universal Digital Block (UDB) Editor is a graphic tool to create PSoC Components. This simple-to-use editor 
provides an approachable way to implement and configure UDB resources. 

 
 

Note The UDB Editor is not intended to enable 100% of UDB functionality or to make the most optimal designs 
possible. Rather, its purpose is to increase your ability to use UDB resources. This editor does not replace the 
Datapath Config Tool, which is more of an expert-level tool for working with UDBs. Refer to the Component Author 
Guide for more information about the Datapath Config Tool and UDB resources. Refer to the UDB Editor Guide for 
more information about the UDB Editor.  

The main Components of the UDB Editor include: 

Â Design Canvas ï the canvas on which you draw designs 

Â Verilog ï Displays Verilog code generated from the design canvas. The UDB Editor currently supports Verilog; 
additional languages may be added in the future. All expressions must confirm to Verilog syntax. 

Â UDB Design Elements Palette 

Â UDB Properties 

Â Common Design Entry Toolbars ï commands common to the design entry tools 

Â Context Menus ï commands available by right-clicking 

  

The UDB Editor provides the following UDB features as editable blocks: 

Â Datapath (DP) 

Â Control Register 
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Â Status Register 

Â Status Interrupt Register 

Â Count7 

Â State Machines 

See Also: 

Â Component Author Guide  

UDB Design Elements Palette 

This vertical toolbar is the same as the Design Elements Palette used for other design entry tools. The main 
difference is that this toolbar contains the UDB resources to place on the UDB Editor. The buttons are as follows: 

Â ï UDB Datapath  

Â ï UDB Control Register 

Â ï UDB Status Register 

Â ï UDB Status Register Interrupt 

Â ï UDB Count7 

Â ï UDB State Machine 
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UDB Properties 

On the right side of the UDB Editor, there are several sections for properties. 

 

Â Inputs ï This is a list of inputs to the Component (equivalent to 
schematic input terminals). The clock input is always present and 
cannot be modified. All other inputs may be added, removed, or 
renamed as needed. 

Â Outputs ï This is a list of outputs to connect to the Component 
(equivalent schematic output terminals). They operate exactly like 
inputs, except there are no fixed / unchangeable defaults. 

Â Variables ï These allow you to create named and reusable 
combinatorial and registered logic. Separate icons are used to 
indicate whether the variable is combinatorial or registered.  

Â Datapath Properties ï These apply specifically to the datapath as 
a whole (and not to a particular instruction). These properties 
include: 

Ǐ Misc 

Ǐ Shift common configuration 

Ǐ Shift configurationA / configurationB  

Ǐ Configurable comparator inputs 

Ǐ Masks 

Ǐ FIFOs 

Toolbar: 

The toolbar contains the following commands: 

Â Delete Row ï Deletes the selected row in one of the properties tables. 

Â Move Up/Down ï Moves the selected row up or down in the table. 

To Add an Input/Output/Variable: 

Click in the cell showing "Enter Name", type a name and press [Enter]. 

To Delete an Input/Output/Variable: 

Click on a row and press the [Delete] key or click the [Delete Row] button. 
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To Edit Datapath Properties: 

1. You must have a datapath resource placed on the canvas. Select it to enable the properties. 

2. Click in a cell for a particular property, and either select a value from the pull-down menu or enter a value in the 
field. 

See Also: 

Â Component Author Guide  

Â UDB Editor 

Â UDB Datapath 

Â Working with Schematic Terminals 

UDB Datapath 

The UDB datapath element is used to configure datapath resources in the PSoC device. This element contains 
several tables to edit Inputs, Registers, Outputs, and Instructions. 

 
 

For more information about UDB datapaths, refer to the Component Author Guide. 

To Place a Datapath: 

Click on the Datapath icon   in the UDB Design Elements Palette, and drag the instance to the canvas. 














































































































































































































































































































































































































































































































































































































